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ANOTACE 

V diplomové práci jsou navrženy objektivní algoritmy pro odhad kvantitativních 

charakteristik nanovlákenných vrstev. Účinnost algoritmů byla testována na sadě 

monochromatických snímků polykaprolaktonových nanovlákenných struktur vytvořených 

elektrostatickým zvlákňováním lišících se koncentrací zvlákňovaného polymeru. Snímky 

nanovlákenných vrstev byly pořízeny skenovací elektronovou mikroskopií. Základními 

zjišťovanými kvantitativními charakteristikami vytvořených nanovlákenných vrstev byly 

parametry nanovlákenných pórů, charakteristiky vyskytujících se defektů, orientace 

a průměry nanovláken.  Pro detekci těchto základních parametrů nanovlákenných struktur 

byly navrženy algoritmy v programu MATLAB a stanovena posloupnost kroků 

v programu ImageJ.  

 

K L Í Č O V Á  S L O V A : nanovlákna, obrazová analýza, MATLAB, ImageJ, póry, 

defekty v nanovrstvách, orientace nanovláken, průměr nanovláken. 

ANNOTATION 

In this diploma thesis have been proposed  objective algorithms to estimate 

the quantitative characteristics of nanofiber layers. The effectiveness of algorithms were 

tested on a set of grayscale images of polycaprolactons nanofiber structures formed 

by electrospinning with different concentrations of polymer. Images of nanofiber layers 

were taken by scanning electron microscopy. The basic characteristics extracted 

of nanofiber layers were parameters of nanofiber pores, characteristics occurring defects, 

orientation, and nanofiber diameters. To detect these basic parameters of nanofiber 

structures were created algorithms in MATLAB and determined the sequence of steps 

in the program ImageJ. 

 

K E Y  W O R D S :  nanofibers, image analysis, MATLAB, ImageJ, pores, defects 

in nanostructures, nanofibers orientation, nanofibers diameter. 
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Seznam použitých symbolů a zkratek 

f (x,y) Obrazová funkce dvou proměnných x,y 

x,y Souřadnice pixelu 

Pixel Obrazový prvek 

M Počet řádků matice 

N Počet sloupců matice 

r Souřadnice řádku matice – row 

c Souřadnice sloupku matice – column 

dpi Dots per Inch 

RGB R – red, G – green, B – blue  

PCL Polymer polykaprolakton 

PLLA Kyselina poly-L-laktidová 

Mw Molární hmotnost [g.mol
-1

] 

SEM Skenovací elektronová mikroskopie 

TEM  Transmisní elektronová mikroskopie 

AFM Mikroskopie atomárních sil 

μv Objemová interpretace zaplnění [-] 

V Objem vláken [m
3
] 

Vc Celkový objem výřezu vláken [m
3
] 

µs Plošná interpretace zaplnění [-] 

S Plocha vláken [m
2
] 

Sc Celková plocha výřezu [m
2
] 

ψ Porózita [-] 

Vp Objem pórů [m
3
] 

μ Obecná interpretace zaplnění [-] 

g(x y) Vstupní hodnota pixelu o souřadnicích x,y 

T Prahová hodnota 

f(α) Texturní funkce 

α1… αn Směrové úhly  

w(x,y) Obrazová funkce dvou proměnných x,y reprezentující 

vyhledávací šablonu 

u,v Frekvenční proměnné 
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F(u,v) Fourierovy koeficienty rozvoje 

P(u,v) Výkonové spektrum 

Q(u,v) Logaritmické transformace výkonového spektra 

mpq Dvojdimenzionální obecný moment řádu (p+q) 

Std Směrodatná odchylka 

atd. A tak dále 

tzn. To znamená 

tj. To jest 

např.  Na příklad 

ITP Image Processing Toolbox  
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Úvod 

Nanovlákna jsou vlákna v rozsahu desítek až stovek nanometrů, jejich zanedbatelná 

struktura je nositelem unikátních vlastností, které jsou určující pro struktury, v kterých jsou 

obsaženy. Preferovanou vlastností nanovlákenných struktur je malý průměr, vysoký měrný 

povrch, velká porózita a malá velikost pórů. Právě tyto parametry nanovláken jsou výchozí 

pro různé průmyslové aplikace, kterým dodávají nové, modifikované vlastnosti. Mezi 

oblasti, v nichž má aplikace nanovláken velký potenciál patří zdravotnictví, kosmetika, 

strojírenství, stavebnictví, elektronika, automobilový průmysl, kosmický průmysl, 

chemický, vojenský a v neposlední řadě textilní průmysl.  

 

Vlastnosti struktury nanovláken přímo ovlivňují vlastnosti výchozího produktu.   

Pro maximální využití jedinečných vlastností nanovláken v aplikacích je nutné 

identifikovat jejich strukturní parametry. Monitorování parametrů vlákenných vrstev 

je však náročné vzhledem k jejich zanedbatelným nanorozměrům. Problémem 

charakterizace parametrů nanovláken se v dnešní době zabývá hned několik studií.  

 

 Právě z důvodu malých rozměrů nanovláken je k detekci ve většině případů 

využíváno výpočetní techniky.  Princip zjišťování základních parametrů nanovlákenné 

vrstvy vychází z obrazové analýzy. Pomocí posloupnosti kroků vytvořených s využitím 

nástrojů obrazové analýzy se z o obrazu nanovlákenné vrstvy stanoví parametry jakými 

je průměr vláken, porózita a orientace vláken. Podkladem pro obrazovou analýzu je snímek 

nanovlákenné vrstvy pořízený převážně elektronovou mikroskopií.   

 

Cílem práce je navrhnout algoritmy pro objektivní odhad kvantitativních charakteristik 

ze snímků nanovlákenných vrstev pomocí nástrojů obrazové analýzy. Mezi základní 

parametry, které budou předmětem obrazové analýzy, patří klasifikace mezivlákenných 

pórů, charakteristika defektů vyskytujících se v nanaovlákenných vrstvách, stanovení 

orientace a průměrů nanovláken. Výsledkem práce je vytvořit algoritmus navrženého 

postupu v MATLABU a popsat sled kroků v programu ImageJ. Pro experiment budou 

použity čtyři vzorky nanovlákenných vrstev lišící se koncentrací, zvlákňovaným 

polymerem je zvolen biodegradabilní polymer polykaprolakton. Na základě zvolené 

koncentrace zvlákňovaného roztoku budou sledovány změny parametrů konečné struktury. 
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1 Souhrn současného stavu 

Nanovlákenné materiály se poslední dobou těší značné pozornosti veřejnosti. 

Pro maximální využití těchto vláken v rozličných aplikacích je důležité určit jejich 

strukturní parametry. Vzhledem k zanedbatelným rozměrům vláken je zjišťování jejich 

parametrů komplikovaný proces, který je realizován především s použitím nástrojů 

obrazové analýzy. Východiskem pro obrazovou analýzu nanovlákenných materiálů 

jsou především snímky získané elektronovou mikroskopií.  Morfologie polymerních 

nanostruktur je nejčastěji monitorována pomocí skenovací elektronové mikroskopie 

(SEM), transmisní elektronové mikroskopie (TEM) a mikroskopie atomárních sil (AFM) 

[1]. V níže uvedeném přehledu studií jsou představeny metody obrazové analýzy, 

které jsou nejčastěji používány pro odhad kvantitativních charakteristik nanovlákenných 

struktur. 

 

Za základní kvantitativní charakteristikou určující hlavní vlastnost nanovláken, kterou 

je jejich zanedbatelný rozměr můžeme považovat jejich průměr. Stanovením průměrů 

nanovláken se zabývá mnoho studií.  

První studií zabývající se aplikací nástrojů obrazové analýzy k určení průměru 

nanovláken je práce Ziabariho [2]. Princip metody stanovení průměrů nanovláken je 

založen na manuálním měření počtu pixelů vzdálenosti dvou hran nanovlákna kolmo k ose 

vlákna. V dalším kroku se počet pixelů přepočítá pomocí kalibrační rovnice na počet 

nanometrů a výsledná hodnota je zaznamenaná. Je nutné provést zhruba 100 jednotlivých 

měření, průměr nanovláken je průměrem z naměřených hodnot.  Manuální metoda vedoucí 

k určení průměrů je časově náročná, nepříliš přesná a špatně reprodukovatelná.  

Z důvodu velkých nedostatků použití manuální metody navrhuje Pourdeyhimi 

ve studii [3] stanovení průměrů vláken automatickým měřením na základě obrazové 

analýzy. Vstupní snímek nanovlákenné vrstvy pořízený pomocí SEM je nejprve převeden 

na binární obraz, dále je provedena skeletonizace čímž vznikne pomyslná „kostra“ 

vlákenné struktury. Pomocí zadaného algoritmu využívajícího kostru a vzdálenostní 

transformaci obrazu se automaticky naměří průměry vláken, které mohou být na rozdíl 

od první, výše uvedené metody změřeny v každém pixelu. Toto měření je jednodušší, není 

časově náročné, má však jeden nedostatek. Naměřené hodnoty neuvádějí reálnou informaci 
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o průměru nanovláken, poněvadž do výsledných hodnot jsou zahrnuty i průměry v místech 

vzájemného překřížení vláken.  

Ve studii [2] řeší Ziabari nedostatky předchozí studie zabývající se stanovením 

průměrů vláken. Cílem navržené metody je řešení problému s překříženými úseky 

nanovláken, jejichž velikost neodpovídá skutečnému průměru vláken a tím jsou zkresleny 

následné výpočty parametrů, které mají vypovídat o reálných vlastnostech měřených 

vláken. Jako vstup je použit binární obraz, základem analýzy je skeletonizace vstupního 

obrazu. K odstranění místa křížení vláken je nutné toto místo detekovat, v detekovaném 

průsečíku je následně vykreslen objekt, který je tvořen pixely nesoucími stejnou informaci 

jako pozadí, tím dojde k odstranění překřížených úseků z binárního obrazu.  Průměr vláken 

je vypočten na základě vzdálenosti jednotlivých pixelů vlákna s jejich nejbližším pixelem 

reprezentujícím pozadí. Údaje, které jsou získány v pixelech, je možné převést kalibrací 

na délkové jednotky a dále s nimi pracovat.   

Zcela novou metodou zabývající se automatizací měření průměrů nanovláken přináší 

práce [9]. Metoda stanovení průměrů vláken je založená na integraci obdélníků do profilu 

vláken. Jako vstupní obraz byly v řešení práce použity SEM snímky melt blow textilie, 

které se vyznačují vysokou ostrostí obrazu. Segmentace obrazu se skládá ze tří kroků, 

prvním krokem je odstranění šumu pomocí Gaussova filtru, následuje transformace 

monochromatického obrazu na binární za použití globálního prahování, posledním krokem 

je ztenčení a prořezání obrazové hranice, tj. vytvoření hranic vláken. Vzhledem k tomu, 

že jsou získané hranice vláken téměř rovné, lze je aproximovat přímkami. Koncové body 

přímek reprezentujících hranice stejného vlákna jsou spojeny, tím vznikají obdélníky. 

Obdélníky představují vlákna, průměr vláken je tedy roven šířce vkresleného obdélníku.  

Tato metoda klasifikace průměrů vláken má několik výhod, mezi které paří dobrá 

reprodukovatelnost, opakovatelnost a účinnost.  

 

Další důležitou charakteristikou nanovlákenných struktur je jejich porózita, porózita 

například ovlivňuje prodyšnost, prostupnost medií materiálem a v oblasti tkáňového 

je důležitým parametrem ovlivňujícím rychlost růstu buněk. Stanovení parametrů pórů je 

důležité z hlediska funkčnosti konečné aplikace obsahující ve své struktuře nanovlákenný 

materiál. Chrakteristika nanovlákenných pórů je předmětem několika studií.  

 Autorem první studie [4], která se zabývá se klasifikací pórů nanovlákenné vrstvy 

je Hanghi. Jeho metoda vychází z transformace vstupního monochromatického snímku 
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nanovlákenné vrstvy na binární obraz. Nejprve jsou v obraze identifikována a odstraněna 

ta vlákna, která se dotýkají obrazových hranic. Měřené póry jsou posuzovány jako objekty, 

mohou jím být přiřazena jednotlivá čísla. V dalším kroku dochází ke změření počtu pixelů 

v jednotlivých objektech, čímž jsou získány velikosti jednotlivých pórů.  

Další metodiku, jak získat parametry pórů netkaných textilií představil kolektiv autorů 

studie [5]. Pro aplikaci metody byly SEM snímky netkaných nanovlákenných vrstev 

převedeny použitím prahování na binární obraz. Metodika spočívá v analýze pórů pomocí 

aplikace kruhových útvarů několika charakterizovaných velikostí, které by mohly 

proniknout nasnímanou nanovlákennou vrstvou do obrázku. V dalším kroku dochází 

k sečtení a normalizování množství kruhů pro každý vzorek. Póry jsou vypočítány 

na základě derivace distribuční křivky, k přesnějšímu určení byla ve studii použita 

kombinace dvou exponenciálních funkcí.  

Ghasemi-Mobarakeh a kolektiv se ve své práci [6] zabývají měřením pórovitosti 

různých vrstev nanovlákenných struktur. Základem pro analýzu obrazu byly naskenované 

SEM fotografie nanovlákenných materiálů o rozlišení 600dpi a o 256 úrovních šedi.  

Snímky SEM elektronové mikroskopie lze považovat za analogii světelného mikroskopu, 

SEM snímky jsou však tvořeny zpracováním odražených nebo sekundárních elektronů. 

Podstatou metodiky zjištění pórovitosti jednotlivých vrstev nanovlákenné struktury 

je převedení vstupního obrazu na binární obraz pomocí několika zvolených prahů. V této 

studii bylo zjištěno, že pomocí vhodně zvoleného prahu lze zobrazit různé vrstvy 

nanomateriálu.  Jednotlivé prahy byly zvoleny na základě intenzity úrovně šedi pixelů 

jednotlivých nanovlákenných vrstev vstupního monochromatického obrazu. Horní 

nanovlákenné vrstvy se vyznačují vyšší intenzitou úrovně šedi, což bylo způsobeno větším 

počtem odražených elektronů. Spodní vrstvy vykazují nižší úroveň šedi, vzhledem k tomu, 

že k nim na základě charakteru vlákenné struktury proniklo malé množství elektronů. 

 

Mezi sledované parametry nanovlákenných struktur patří také orientace vláken. 

Uspořádání vláken v kompozitních materiálech má přímý vliv na jejich konečné vlastnosti, 

jakými je například pevnost, filtrační schopnost a zvuková izolace.  

Orientací vlákenných systémů se zabývá například studie [7]. Autoři studie detekují 

orientaci vláken na základě Fourierovy transformace. Na rozdíl od jiných studií např. 

studie [8], není orientace vláken stanovena globálně z celého snímku vlákenné vrstvy. 

Ke stanovení orientace vláken je přistupováno detailněji, celková orientace vláken 
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zobrazených na snímku vlákenné struktury je stanovena na základě mnoha jednotlivých 

měření. Princip metody je založen na rozdělení vstupního obrazu na mnoho malých 

podobrazů, pro které jsou převedeny prostřednictvím Fourierovy transformace 

do frekvenční oblasti. Dalším krokem je prahování, kterým dojde k vyčlenění objektu 

zájmu z frekvenčního spektra – elipsy. Orientace vláken je následně popsána pomocí 

centrálních momentů mezi hlavní osou elipsy a x-ovou osou. Výstupem stanovení 

orientace vláken je dle autorů studie histogram, jádrový odhad distribuce směrů a polární 

diagram. Mezi výhody této metody stanovení orientace vláken ve strukturách patří přesnost 

a dobrá reprodukovatelnost. 

 

Vzhledem k náročnosti uvedených metodik získávání jednotlivých parametrů 

nanovlákených struktur je snaha o vytvoření algoritmu, který by byl schopen klasifikovat 

více parametrů najednou.  Příkladem je studie [9], v níž skupina vědců zveřejnila metodu, 

která navrhuje algoritmus pro získávání orientace, poloměru a průměrů vláken ze SEM 

snímků vlákenných vrstev. Podstatou metody je konstrukce trojrozměrného tvaru vláken. 

Původní dvojrozměrný obraz je aproximován pomocí koulí tzv. „metaballs“, ty jsou 

vytvořeny postupnou analýzou obrazu. Pro zjednodušení algoritmu bylo uvažováno, 

že jsou průměry nanovláken kruhové. Podstata algoritmu spočívá v detekci kostry vláken 

a následném vytvoření „metaballs“ pro každý pixel tohoto skeletu. Poloměr jednotlivých 

koulí byl získán ze vzdáleností hranic vláken v binárním obraze.   Statistické údaje, jako je 

orientace vláken, poloměr vláken a průměr pórů jsou přímo známé z parametrů 

„metaballs“. Metoda je jednoduchá, rychlá a automatická, je daleko výhodnější než ruční 

měření. Další výhodou je identifikace jednotlivých vláken, což je zásadním krokem 

pro výpočet dalších statistických informací. 

Dalším trendem v zjišťování základních charakteristik nanovlákenných struktur je 

vývoj automatických systémů. Vývojem se zabývá například firma FAI [10], která patří 

mezi přední výrobce elektronových mikroskopů a analytických systémů. Firma uvedla 

na trh systém Fibermetric propojený s elektronovým mikroskopem. Tento systém je 

schopen během několika vteřin změřit a vyhodnotit základní parametry nanovláken jakými 

jsou průměr vláken a velikost mezivlákenných pórů. Systém automaticky nasbírá stovky 

měření, pomocí Gaussovy fitovací funkce automaticky změří průměry vláken a velikost 

pórů. Tento systém slouží jako nástroj pro kontrolu kvality a pro určení vlastností 

nanovlákenné struktury, jakými je například filtrační účinnost. 
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2 Nanovlákna 

Nanovlákna jsou velmi originální vlákenné útvary vyznačující se především svými 

zanedbatelnými rozměry. Předpona nano pochází z řeckého slova trpaslík „νανος“, pokud 

dosahuje nějaké struktura nanorozměrů znamená to, že se jedná o miliardtinu základní 

jednotky. Vlákno je definováno jako délkový útvar, jehož délka je mnohonásobně větší 

než průměr. Nanovlákna jsou tedy taková vlákna, která mají alespoň jeden z rozměrů 

v řádech nanometrů. Nanovlákna se jen zřídka vyskytují samostatně, většinou jsou 

z nanovláken tvořeny struktury, nebo prostorové celky, se kterými lze nějakým způsobem 

manipulovat a plně využít jejich vlastnosti.  Jedinečné vlastnosti nanovlákenných struktur 

jsou dány vlastnostmi jednotlivých vláken mezi které patří 

 velký měrný povrch, 

 zanedbatelný průměr vláken, 

 vysoká porozita, 

 malé rozměry pórů.  

Vzhledem ke svým vlastnostem jsou nanovlákna úspěšně aplikována v různých 

průmyslových oborech. Aplikace nanovláken dodává stávajícím materiálům lepší pevnost, 

pružnost, odolnost, propustnost, tepelnou a zvukovou izolaci, životnost, lepší elektrické 

a optické vlatnosti a další.  Nanovlákna mají velký potenciál využití v oblastech kapalinové 

a vzduchové filtrace, ochraně životního prostředí, energetickém průmyslu, zdravotnictví, 

strojírenství, kosmetice a tkáňovém inženýrství, vněmž je vidět velký potenciál využití 

těchto struktur. Jednotlivé aplikace nanovláken v různých průmyslových odvětvích jsou 

podrobněji uvedeny níže v podkapitole 2.2.2. Aplikace nanovláken.  

2.1  Možnosti výroby polymerních nanovláken 

Způsobů výroby polymerních nanovláken je hned několik. Mezi nejznámější patří 

tažení, syntéza šablonou, fázová separace, samosestavování, meltblown a nejpoužívanější 

elektrostatické zvlákňování („electrospinning“). Jednotlivé způsoby výroby se od sebe 

vzájemně liší například efektivitou výroby, náročností procesu, možností řídit parametry 

konečných vláken a možností zavedení hromadné výroby vláken jednotlivými 

technologiemi. Dle zvoleného způsobu výroby se dá předpokládat konečný průměr, délka 

vláken a orientace vláken. Princip výroby nanovláken dle jednotlivých metodik, jejich 
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výhody, nevýhody, efektivita a možnost aplikace do průmyslové výroby jsou uvedeny níže 

v následujícím textu.  

2.1.1 Tažení 

Princip technologie výroby nanovláken tažením můžeme považovat 

za nejjednodušší způsob. Princip metody je založen na vytahování nanovlákna z kapky 

polymeru pomocí mikromanipulátorem ovládané pipety, která má průměr o velikosti 

několika mikrometrů. Rychlost tažení vlákna se musí pohybovat okolo 10
-4

m.s
-1 

[11]. 

Nevýhodou této metody je, že nedovoluje řídit průměr vláken, ten se pohybuje v rozpětí 

od 2 nm do 100 nm, délka vláken je okolo 10 mikrometrů. Výhodou metody výroby 

nanovláken tažením jsou minimální požadavky na technické vybavení. Tento způsob 

výroby slouží pouze pro laboratorní účely [1]. Princip metody tažení je graficky znázorněn 

na obr. 1(a)-(c).  

   

(a) (b) (c) 

Obr. 1 Princip výroby nanovláken tažením, (a) pipeta a kapka polymeru, (b) zachycení 

vlákna pipetou, (c) tažení vlákna [1]. 

2.1.2 Syntéza šablonou 

Výroba nanovláken metodou nazývající se syntéza šablonou vyžaduje použití 

membrán nebo jiných struktur, kdy je za pomoci tlaku zvlákňovaný polymer vytlačován 

přes tuto perforovanou šablonu do srážecí lázně, kde dochází k tuhnutí vytvořených 

vláken. Nejčastěji používanými materiály k výrobě šablon jsou oxidy kovů – například 

oxid hlinitý. Princip metody je graficky znázorněn na obr. 2(a),(b). Průměr takto 

vytvořených vláken je závislý na průměru pórů membrány. Tato metoda je určena pouze 

pro laboratorní účely, velkou výhodou je, že je dobře reprodukovatelná a lze definovat 

průměr vláken. Velikost průměrů vláken je zhruba 100 nm, délka vláken je 

10 mikrometrů [1]. 
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(a) (b) 

Obr. 2 Výroba nanovláken syntézou pomocí šablony (a), (b) [1]. 

2.1.3 Fázová separace 

Dalším způsobem výroby nanovláken je fázová separace. Mechanismus 

této metodiky výroby nanovláken je založen na separaci fází na základě fyzické 

neslučitelnosti. Polymer je nejprve smíchán s rozpouštědlem a je vytvořen homogenní 

roztok, schéma je zobrazeno na obr. 3(a). Malé množství roztoku je nalito do teflonové 

nádoby, zde je pomocí vhodné teploty dosaženo gelace polymeru, znázorněno na obr. 3(b). 

Teplota gelace se pohybuje od -18°C do 45°C a je závislá na koncentraci polymeru. 

Po procesu gelace dochází k odstranění původního rozpouštědla jiným rozpouštědlem, 

které musí být na jiné bázi (takovým rozpouštědlem je např. voda), během odstraňování 

rozpouštědla se vytváří nanovlákenná struktura uvnitř gelu. V další fázi je materiál vysušen 

na teplotu tuhnutí druhého rozpouštědla, toto rozpouštědlo za sníženého tlaku sublimuje. 

Výsledkem metody fázové separace je nanovlákenný útvar, zobrazený na obr. 3(c). 

Nevýhodou je, že není možné řídit průměry vláken, průměry se pohybují v rozmezí 

od 50 nm do 500 nm. Další nevýhodou je časová náročnost metody a určení pouze 

pro specifické polymery, jako je poly-L-laktid kyselina (PLLA) a polykaprolakton (PCL) 

[1], [14]. 
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(a) (b) (c) 

Obr. 3 Fázová separace, (a) tvorba homogenního roztoku, (b) gelace, (c) výsledný 

nanovlákenný útvar [1]. 

2.1.4 Samosestavování 

Metodika výroby nanovláken samosestavováním je založena na skládání 

nanovláken pomocí malých molekul, které plní funkci pomyslných stavebních bloků. 

Hlavním mechanismem montáže jsou mezimolekulární síly, které shlukují malé jednotky 

dohromady a tvoří z nich makromolekulární útvary – nanovlákna. Výhodou je schopnost 

vytvořit vlákna s malým průměrem, který se pohybuje od 7 nm do 100 nm v závislosti 

na použitém polymeru. Nevýhodou je neschopnost řídit velikost průměrů vláken 

a vhodnost metody pouze pro laboratorní účely [14]. Na obrázku obr. 4(a) a (b) je graficky 

znázorněna metoda výroby nanovláken metodou samosestavováním. 

 

  

(a) (b) 

Obr. 4 Metoda výroby nanovláken samosestavováním (a), (b) [1]. 

2.1.5 Melt Blown 

Způsob tvorby nanovláken použitím metody melt blow spočívá v protlačování 

taveniny polymeru tryskou a jeho následném zvlákňování pomocí proudu horkého 

vzduchu, který má z pravidla stejnou teplotu, jako roztavený polymer. Výhodou je 
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možnost průmyslové výroby, průměry vyrobených nanovláken se pohybují okolo 250 nm, 

vlákna jsou v podstatě nekonečná [14].  

2.1.6 Elektrostatické zvlákňování 

V současné době patří elektrostatické zvlákňování mezi nejrozšířenější způsoby výroby 

nanovláken. Na rozdíl od předešlých metod je možné aplikovat elektrostatické zvlákňování 

na průmyslovou výrobu.  

První zmínky o elektrostatickém zvlákňování pochází z roku 1934, kdy Anthon 

Formhals  zveřejnil několik patentů na výrobu polymerních vláken [1]. V součastnosti je 

převratným objevem průmyslové výroby nanovláken elektrostatickým zvlákňováním 

technologie Nanospider 
TM

, kterou v roce 2003 vynalezl profesor Oldřich Jirsák na Katedře 

netkaných textilií TUL. Na rozdíl od předešlých technologií nejsou ke zvláknění roztoku 

zapotřebí trysky, zvlákňování probíhá z otáčejícího se válce částečně ponořeného 

do polymerního roztoku, tím je dosaženo vysoké výrobní efektivity.  

Metodika elektrostatického zvlákňování je založena na využití účinku elektrostatického 

pole na kapalinu – polymerní roztok, působením kterého dochází k vytvoření velmi 

tenkých vláken. Schéma elektrostatického zvlákňování je uvedeno na obr. 5(a). Vlákna 

jsou tvořena mezi dvěma opačně nabitými elektrodami, jedna elektroda je napojena 

na trysku se zvlákňovanou kapalinou, to vede k vytvoření náboje na povrchu kapaliny.  

Takto nabitá kapalina je přitahována elektrostatickými silami druhé elektrody 

tzv. kolektorem, ten je většině případů uzemněn.  Se zvýšením intenzity elektrického pole 

se plocha kapaliny na špičce trysky začíná prodlužovat, je překonáváno povrchové napětí 

kapaliny a tvoří se kónický tvar známý jako Taylorův kužel, Taylorův kužel je zobrazen 

na obr. 5(b). Při dalším zvýšení intenzity elektrického pole dojde k překonání povrchového 

napětí a dochází k dloužení vláken [1]. Zjednodušeně, lze říci, že se zvlákňovací zařízení 

dle [13] skládá ze tří základních složek, kterými je 

 zdroj vysokého napětí, 

 kapilární trubice s jehlou nebo pipetou malého průměru, 

 sběrné zařízení. 

Výhodou tohoto způsobu zvlákňování je vysoká efektivita a možnost vytvořit 

nekonečná vlákna. Mezi nevýhody metody výroby nanovláken prostřednictvím 

elektrostatického zvlákňování patří nestabilita proudu.  
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(a) (b) 

Obr. 5 (a) elektrospining [1], (b) Taylorův kužel [11]. 

2.2 Parametry zvlákňování ovlivňující vlastnosti 

nanovlákenné vrstvy 

Parametry procesu zvlákňování mohou výrazně ovlivnit konečný vzhled i vlastnosti 

nanovláken. Průběh elektrostatického zvlákňování je dle [1], [13] a [14] ovlivněn několika 

parametry. Mezi parametry ovlivňující elektrostatické zvlákňování patří vlastnosti 

polymerního roztoku, polymerní roztok ovlivňuje konečný výsledek zvlákňování 

především 

 charakterem struktury a typu zvlákňovaného polymeru, 

 viskozitou,  

 typem použitého rozpouštědla, 

 vodivostí, 

 povrchovým napětím. 

Dalším parametrem ovlivňujícím elektrostatické zvlákňování je samotný proces 

zvlákňování, proces zvlákňování je charakterizován 

 velikostí aplikovaného napětí, 

 průměrem trysky, 

 rychlostí průtoku polymerního roztoku tryskou (zvlákňovací jehlou), 

 hydrostatickým tlakem, 
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 elektrickým potenciálem na elektrodě, 

 vzdáleností elektrod. 

V neposlední řadě je proces zvlákňování ovlivněn okolním prostředím zvlákňovacího 

zařízení tzv. spinneru. Za okolní prostředí spinneru považujeme 

 teplotu vzduchu,  

 vlhkost vzduchu.  

V následujícím textu jsou blíže popsány některé parametry elektrostatického zvlákňování.  

 

Koncentrace polymeru v roztoku  

Polymerní roztoky se skládají z polymeru a zvoleného rozpouštědla. V literatuře 

[1] se uvádí, že je možné vytvořit nanovlákna až z 50 různých polymerů. Mezi často 

používaná rozpouštědla patří voda, etanol, metanol, chloroform, aceton. Poměr a volba 

polymeru s rozpouštědlem ovlivňuje průběh zvlákňování tím, že změnou koncentrace 

a složení zvlákňovaného roztoku dochází ke změně viskozity. Důsledkem nevhodné 

koncentrace je tvorba kulovitých defektů ve výsledné zvlákněné nanovlákenné struktuře 

(kulovité defekty jsou v  literatuře [11] označovány jako perličky). 

 

Viskozita polymerního roztoku  

Velikosti průměrů konečných vláken jsou ovlivněny především viskozitou 

polymerního roztoku. Vyšší viskozita má dle [1] za následek větší průměr vláken – 

viskozita je přímo úměrná průměru vláken. 

 

Povrchové napětí  

Napětí, které je tvořeno soudržností molekul na povrchu kapaliny nazýváme 

povrchové napětí. Jak již bylo zmíněno dříve, překonání povrchového napětí polymerního 

roztoku je jedním ze základních požadavků k tvorbě vláken. K překonání povrchového 

napětí slouží elektrostatické síly mezi dvěma kolektory. Napětí, které je dodáváno 

se nazývá dle [12] aplikované napětí. Obecně platí, že vyšší aplikované napětí vysune více 

zvlákňovaného roztoku, což má za následek větší průměr vlákna [11].  Snížení 

povrchového napětí roztoku je možné pomocí volby vhodného rozpouštědla.  
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Průměr trysek 

Velikost průměrů zvlákňovacích trysek přímo ovlivňuje konečný průměr vláken. 

 

Vzdálenost mezi elektrodami 

V práci [11] a [13] bylo zjištěno, že vzdálenost elektrod ovlivňuje konečný vzhled 

vláken, ale je také závislá na jiném parametru zvlákňování – na volbě rozpouštědla. 

Roztoky na vodní bázi při malé vzdálenosti elektrod vykazují mokrá vlákna (nedostatečný 

čas pro odpaření rozpouštědla), jejichž průměry nejsou ve všech místech vlákna stabilní. 

Ve struktuře vláken vznikají malé defekty elipsového tvaru, taková vlákna 

jsou označována jako vlákna s perličkovou strukturou. U roztoků vykazujících tvorbu dříve 

definovaných defektů je nutné zvýšit vzdálenost mezi elektrodami. Pro polymerní roztoky, 

které obsahují těkavá rozpouštědla, může být vzdálenost mezi elektrodami menší – 

odpařují se rychleji. 

2.2.1 Vlastnosti nanovláken 

Vlastnosti nanovláken můžeme dle [13] dělit na geometrické, chemické, fyzikální 

a mechanické. Geometrickými vlastnosti nanovláken jsou 

 porózita,  

 průměr vláken,  

 tvar průřezu, 

 měrný povrch.  

Důležitými fyzikálními vlastnostmi nanovláken, které ovlivňují konečné vlastnosti 

hotového výrobku, jsou především  

 transportní vlastnosti vzduchu a páry, 

 elektrické transportní vlastnosti (vodivost). 

Mezi chemické vlastnosti nanovláken řadíme například molekulární strukturu zvlákněného 

polymeru. Poslední mechanická vlastnost, která je plně využívána v rozličných aplikacích 

je vysoká pevnost v tahu.  

2.2.2 Aplikace nanovláken 

Aplikace nanovláken je stále otevřenou oblastí a jsou nalézány stále nové možnosti 

jejich co nejlepšího uplatnění a maximálního využití jejich dříve zmíněných vlastností. 
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Využití nanovláken v běžném životě je velmi rozsáhlé, prakticky jsou vlákna aplikována 

ve všech průmyslových odvětvích. Některé způsoby použití těchto ojedinělých struktur 

jsou popsány v následujícím textu.  

 

Kompozitní materiály 

Použití nanovláken jako kompozitního materiálu zvyšuje konečnou pevnost 

výsledných aplikací. Nanovlákna mají vysokou pevnost a malou váhu, to je jeden 

z hlavních důvodů, proč jsou vhodná na výrobu vysoce funkčních kompozitních materiálů. 

Dříve byla do kompozitních materiálů používána mikrovlákna, ta mají ale horší 

mechanické vlastnosti a nejsou transparentní. Mezi populární kompozitní nanomateriály 

patří karbonová vlákna a karbonové nanotrubice [12].  

 

Tkáňové inženýrství  

Lidskou tkáň je možné z konstrukčního hlediska považovat za formu nanovlákenné 

struktury, této podoby se snaží moderní tkáňové inženýrství využít a hledá nové směry 

použití nanovláken v medicínských aplikacích. Biokompatibilními nanovlákny lze nahradit 

řadu měkkých tkání, kterými jsou například cévy, vytvořit umělé orgány, nanovlákna 

lze také použít jako oporou pro regeneraci tkání, orgánů, chrupavek, kostí a nervů [1]. 

Podrobné informace o využití nanovláken v oblasti tkáňového inženýrství jsou uvedeny 

v práci [28]. 

 

Dodávání léčiv 

Aplikace nanovláken v řízeném dodávání léčiv je jedním z nejvíce šetrných 

a efektivních způsobů, jakým lze léčivo pacientovi dodat. Dle [13] platí, že čím jsou 

rozměry použitého léčiva a materiálu menší, tím se lék lépe vstřebává – zapouzdřuje přímo 

do vláken. 

 

Obvazový materiál  

Nanovlákna mohou být použita jako obvazový materiál k usnadnění léčby ran 

nebo popálenin. Za pomoci speciální pistole, která pracuje na bázi elektrického pole je 

možné nanovlákna nastříkat přímo na postižené místo a tím vytvořit ochrannou vrstvu, 

která zabrání kontaminaci rány bakteriemi, podpoří růst kůže a eliminuje zjizvení tkáně.  
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Ochranné dýchací masky 

Díky použití nanovláken v ochranných maskách je možné zaručit větší bezpečnost 

jejího uživatele, poněvadž tato struktura eliminuje vdechování mikročástic prachu, 

chemikálií i nebezpečných bakterií. 

 

Kosmetika 

Nanovlákna jsou přidávána do kosmetických přípravků jakými jsou krémy 

z několika důvodů – zamezují migraci krému do citlivých míst, jakými jsou třeba oči, také 

pomáhají léčbě ran, čištění pleti a urychlují přenos hojících nebo jiných aktivních látek 

na kůži. 

 

Filtry 

Použití nanovlákenných vrstev ve filtračních materiálech má za následek zvýšení 

filtrační účinnosti, snížení hmotnosti, potřebné energie a objemu filtrů. Díky malým 

průměrům nanovláken jsou filtrem zachyceny i mikročástice. Filtry se používají v mnoha 

odvětvích – například čištění odpadních a pitných vod, vzduchové filtry, filtry výfukových 

plynů, průmyslové filtry. 

 

Ochranné oděvy  

Hlavní funkcí ochranných oděvů je bezesporu schopnost maximalizovat bezpečí 

jejich uživatele. Jedná se například o ochranu před extrémními přírodními podmínkami, 

biologickými a chemickými hrozbami. Díky specifickým povrchovým vlastnostem jsou 

oděvy obsahující nanovlákna schopné zachytit nebezpečné látky nebo ochránit 

před větrem, ale zároveň jsou dostatečně prodyšné a tím zabezpečují komfortní pocit 

uživateli. 

 

Ostatní aplikace 

Použití vodivých nanovláken při výrobě malých elektronických zařízení a strojů, 

použití vodivých membrán pro aplikace fotovoltaických zařízení, elektromagnetického 

rušení, ochraně proti korozi, optické senzory [12]. 

 

V práci byly nastíněny základní způsoby a parametry výroby nanovláken, definovány 

hlavní vlastnosti těchto struktur a uvedeny některé oblasti využití nanovláken v různých 
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průmyslových odvětvích. Historie, výroba, vlastnosti a rozličné aplikace nanovláken jsou 

velmi širokou oblastí. Předmětem práce však není teoretický souhrn faktů, ale analýza 

obrazu, jejímž cílem je identifikace parametrů nanovlákenných vrstev. Pro rozšíření 

teoretických informací o nanovláknech doporučiji práce [1], [12], [14] a [28]. Následující 

část této diplomové práce je zaměřena na analýzu obrazu. 

3 ANALÝZA OBRAZU 

Analýza obrazu je složitý proces, jehož cílem je za použití několika posloupných kroků 

co nejlépe identifikovat a klasifikovat hledané objekty zobrazené na snímku, tzn. převést 

informace obsažené v obraze do číselné podoby. Pojmem objekty rozumíme v textilním 

odvětví ty oblasti, které nás zajímají vzhledem ke svým vlastnostem (např. vlákna, řezy 

vláken, defekty, atd.). Obrazová analýza zabývající se charakterizací objektů v textilní 

oblasti vnímá jako objektové systémy délkové, plošné a prostorové textilie.  

Objektem neboli regionem může být například v binárním obraze označena množina 

spojených pixelů o hodnotě 1 (bílá barva), za hrany objektů považujeme ty jednotkové 

pixely, které mají ve svém sousedství aspoň jeden nulový pixel reprezentující pozadí 

(černá barva). Příklad bílého objektu vyskytujícího se na černém pozadí je uveden 

na obr. 6(a),(b). 

 

  

(a) (b) 

Obr. 6 Binární snímek se zobrazeným objektem (a), numerický zápis zobrazeného objektu 

na pozadí (b). 

 

Definování objektů záleží též na vzájemném vztahu množiny pixelů, kterou je 

objekt tvořen. Množinu pixelů lze jednomu objektu přiřadit na základě dvou přístupů 

definujících vzájemný vztah objektových pixelů, prvním přístupem je 4-sousedství, 

druhým 8-sousedství. V případě 4-sousedství obrazových pixelů zobrazených na 
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obr. 7(a1), jsou za součást jednoho objektu považovány pixely nacházející se 

ve vertikálním a horizontálním směru od bodu zájmu o souřadnicích r, c. Schéma 4-

sousednosti je uvedeno na obr. 7(a2). Na základě 4-sousedství byly ve vstupním binárním 

snímku nalezeny dva samostané objekty, tyto objekty jsou uvedeny na obr. 7(a3).  

V případě 8-sousedství zobrazeného na obr. 7(b2), jsou za jeden objekt považovány 

všechny pixely dotýkající se pixelu zájmu se souřadnicemi r, c tzn.  za součást jednoho 

objektu jsou považovány pixely nacházející se na obou diagonálách. Aplikací 8-sousedství 

na vstupním binárním obraze obr. 7(b1), je v obraze detekován pouze jeden objekt, 

zobrazený na obr. 7(b3). 

 

  

(a1) (b1) 

 (r-1, c)  

(r, c-1) (r, c) (r, c+1) 

 (r+1, c)  
 

(r-1, c-1) (r-1, c) (r-1, c+1) 

(r, c-1) (r, c) (r, c+1) 

(r+1, c-1) (r+1, c) (r+1, c+1) 
 

(a2) (b2) 

  

(a3) (b3) 

Obr. 7 Binární obraz (a1), schéma 4-sousedství (a2), dva objekty nalezené na základě 4-

sousedství (a3), binární snímek (b1), schéma 8-sousedství (b2), jeden objekt nalezený 

na základě 8-sousedství (b3).  
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Určení parametrů objektů vyskytujících se v textilních systémech má význam 

z hlediska zpracovatelských i užitných vlastností koncového výrobku.   Mezi základní 

kroky zpracování obrazu umožňující klasifikaci objektů patří 

 snímání obrazu, 

 digitalizace obrazu, 

 předzpracování obrazu, 

 segmentace obrazu, 

 popis nalezených objektů, 

 porozumění obsahu obrazu.  

Prvním krokem vedoucím k detekci parametrů nanovlákenných vrstev je pořízení 

digitálního obrazu této vrstvy. Snímání nanovlákenných struktur je realizováno především 

elektronovou mikroskopií. Následujcím krokem kterým se obrazová analýza zabývá, 

je předzpracování obrazu, v této fázi dochází k úpravě vstupního snímku, mezi úpravy 

patří například redukce šumu a jasové transformace. Vzhledem k tomu že byly pořízené 

SEM snímky v dobré kvalitě, fáze předzpracování obrazu nebyla vždy potřebná, popřípadě 

postačila redukce šumu mediánovou filtrací. Dále následuje nejdůležitější část 

tzv. segmentace obrazu, jejímž cílem je definovat oblasti zájmu, ze kterých je možné 

v dalších fázích stanovit parametry nanovlákenných struktur. 

Jednotlivé kroky tvořící obrazovou analýzu jsou popsány v následujících 

podkapitolách.  

3.1 Způsoby snímání obrazu 

Jak již bylo řečeno, prvním krokem předcházejícím obrazové analýze zaměřené 

 klasifikaci parametrů nanovlákenných struktur jako je průměr vláken, orientace vláken 

a velikost mezivlákenných pórů je snímání obrazu. Cílem snímání obrazu je získat vhodný 

vstupní obraz nanovlákenné vrstvy určený k dalšímu zpracování. Vzhledem 

k zanedbatelným rozměrům nanovláken není možné snímky vrstev pořídit použitím 

světelného mikroskopu. K pořízení vhodného vstupního obrazu nanovlákenných vrstev 

slouží elektronové mikroskopy. Mezi elektronové mikroskopy řadíme skenovací 

elektronový mikroskop (SEM) a transmisní elektronový mikroskop (TEM) a mikroskopii 

atomárních sil (AFM) [1].  
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3.1.1 Transmisní elektronový mikroskop 

Transmisní elektronový mikroskop (TEM) umožňuje pozorování vzorků 

do tloušťky 100 nm při velkém rozlišení, lze jej považovat za analogii světelného 

mikroskopu v procházejícím světle. Princip TEM je založen na průchodu elektronového 

svazku preparátem, který má za následek únik elektronů. Elektrický proud je vyvíjen 

na preparát pomocí trysek obsahujících wolframové vlákno. Ke zviditelnění elektronů, 

které prošly preparátem, a zobrazovacím systémem je třeba převést informace – velikost 

energie a množství elektronů na obraz. Obraz je vyprodukován objektivovou čočkou a dále 

je zvětšován pomocí projektivů a intermediálních čoček. K tomu se používá stínítko 

pokryté síranem zinečnatým. Tato mikroskopie je prováděna ve vakuu, vzorky je nutné 

obarvit solemi těžkých kovů, což má negativní vliv na výsledný obraz, dochází ke snížení 

rozlišení [15], [16]. Ukázka snímku TEM nanovlákenné vrstvy je na obr. 8(a). 

3.1.2 Skenovací elektronový mikroskop 

Skenovací elektronový mikroskop (SEM) je určen k pozorování povrchů různých 

objektů, v české literatuře je SEM nazýván též jako rastrovací nebo řádkovací elektronový 

mikroskop. SEM mikroskopii je možné považovat za analogii světelného mikroskopu. 

Rozdíl spočívá v získávání výsledného obrazu, výsledný obraz je u SEM získán detekcí 

signálu odražených nebo sekundárních elektronů, které jsou uvolněny na povrchu 

zkoumaného preparátu. 

 Produkce odražených elektronů je závislá na středním atomovém čísle vzorku. 

Čím je atomové číslo vzorku vyšší tzn., jedná se o těžší prvek, tím je zobrazená oblast 

světlejší. Pokud je zobrazovaná oblast tmavá, jedná se o oblast tvořenou lehkým prvkem. 

Obraz získaný pomocí odražených elektronů barevně odlišuje oblasti s různým prvkovým 

složením. K zobrazení povrchu preparátu slouží v SEM sekundární elektrony. Sekundární 

elektrony mají nízkou energii, do detektoru se proto dostanou hlavně sekundární elektrony 

ležící na povrchu preparátu, což má za následek zobrazení vrchní vrstvy preparátu s vyšší 

intenzitou úrovně šedi, u spodních vrstev je tomu naopak [16]. 

Před samotnou mikroskopií se musí vzorky potáhnout tenkou vrstvou vodivého 

kovu – například zlatem nebo platinou.  Tento způsob mikroskopie se vyznačuje velkou 

hloubkou ostrosti. Rozlišovací schopnost těchto přístrojů se pohybuje kolem 10 – 15 nm. 

Získání jednoho obrazu může trvat až několik minut [15]. SEM snímek 18% PCL  je 

k nahlédnutí na obr. 8(b). 
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3.1.3 Mikroskopie atomárních sil 

Mikroskopie atomárních sil (AFM) umožňuje atomární zobrazení zkoumaného 

preparátu. Princip mikroskopie - velmi tenký hrot, který je umístněn na pružném raménku 

detekuje zkoumaný preparát, jeho pohyb (vibrace a ohyb raménka) jsou zaznamenávány 

pomocí laseru, který předává informaci fotodetektoru. Skenování je založeno na načítání 

výškového profilu preparátu řádek po řádku [15]. Obraz elektrostaticky zvlákněných 

nanovláken pořízený pomocí AFM je uveden na obr. 8(c). 

 

 

(a) (b) (c) 

Obr. 8 Ukázka snímků nanovlákenné vrstvy získané pomocí (a) TEM [17], (b) SEM a AFM 

(c) [18].  

3.2 Programy používané k analýze obrazu 

V dnešní době slouží k analýze obrazu velké množství grafických, či programovacích 

prostředí. V této práci byla analýza obrazu realizována ve dvou prostředích, v prostředí 

interaktivního programu MATLAB a grafického programu ImageJ. Podrobný popis těchto 

dvou programů je uveden v následujícím textu.  

3.2.1 MATLAB 

MATLAB ® je interaktivní prostředí pro numerické výpočty, vizualizaci 

a programování. Použitím programu MATLAB je možné analyzovat data, vyvíjet 

algoritmy, vytvářet modely a aplikace. V programu MATLAB jsou uživateli k dispozici 

nástroje a vestavěné matematické funkce, které umožňují prozkoumat více přístupů 

a dospět k řešení rychleji než je tomu pomocí jiných programovacích jazyků, jakým je 

například Java ™.  Program MATLAB je možné použít pro řadu aplikací, mezi které patří 

i analýza obrazu.  
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Pro realizaci analýzy obrazu je v programu určen Image Processing Toolbox ™ 

(IPT), který poskytuje sadu algoritmů, funkcí a aplikací pro zpracování obrazu, analýzy, 

vizualizace a vývoje algoritmů. Mezi operace, které lze díky IPT realizovat patří úpravy 

obrazu,  redukce šumu, detekce, segmentace obrazu, vytváření obrysů, tvorba histogramů 

atd.  Image Processing Toolbox podporuje rozmanitou sadu obrazových typů [19]. 

Nevýhodou analýzy obrazu v prostředí MATLAB je složitá tvorba algoritmů 

a nutnost uživatelských znalostí práce v prostředí tohoto programu. Další nevýhodou je 

špatná dostupnost programu, na rozdíl od ImageJ není program MATLAB volně přístupný, 

uživatel si musí koupit licenci. Mezi výhody patří snadná reprodukovatelnost vytvořeného 

algoritmu obrazové analýzy pro různé snímky [19]. 

3.2.2 ImageJ  

ImageJ je program určený ke zpracování a analýze obrazu vyvinutý společností 

National Institutes of Health. ImageJ se vyskytuje ve dvou podobách, první verze je 

pro uživatele dostupná online, druhá verze je volně stahovatelná. Program vychází 

z programovacího jazyka Java. Je dostupný pro Windows, Mac OS a Linux. Architektura 

programu není uzavřená, díky tomu je možné program rozšířit pomocí Java zásuvných 

modulů. Program nabízí uživateli vytvoření vlastního doplňkového modulu pomocí 

editoru. Program pracuje s formáty TIFF, GIFF, JPEG, RAW, BMP, DICOM, FITS. Obraz 

je možné analyzovat, zpracovávat, ukládat a tisknout v 8-bit, 16-bit a 32-bitové kvalitě. 

Program podporuje standardní funkce zpracování obrazu, jakými jsou kontrastní 

manipulace, ostření, vyhlazování, detekce hran a filtrování. Pomocí programu ImageJ je 

možné vypočítat plochu a statistické hodnoty pixelů pomocí uživatelsky definovaných 

výběrů. Dále je možné provádět geometrické transformace měřítka, změřit úhly, tvořit 

histogramy a grafy [20]. 

Mezi hlavní výhody analýzy obrazu prostřednictvím programu ImageJ patří především 

jeho volná dostupnost. Dále je velkou výhodou absence tvorby složitých algoritmů, 

analýza obrazu je realizována na základě zabudovaných nástrojů, tím se stává program 

uživatelsky přístupnější. Nevýhodou zpracování obrazu v prostředí programu ImageJ je 

absence reprodukovatelnosti analýzy, navržený postup je nutné opakovat. 
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3.3  Digitalizace obrazu 

Hlavním předpokladem pro realizaci obrazové analýzy je převedení snímku 

nanovlákenné vrstvy do digitální podoby. Digitalizaci si můžeme představit jako proces, 

ve kterém je obraz rozdělen pravidelnou sítí na přesně definované čtvercové nebo 

obdélníkové oblasti [16].   

Digitální obraz je možné vnímat jako funkci f  dvou proměnných (x,y), kde x, y jsou 

prostorové souřadnice a amplituda f je intenzita stupně šedi v určitém bodě daného 

obrazu [21]. Aby bylo možné obraz zpracovat v počítači, musí být funce f digitalizovaná. 

Digitální obraz je v počítači nejčastěji reprezentován maticí o M řádcích a N sloupcích. 

Prvky matice se nazývají obrazové elementy - pixely a jejich hodnota je závislá 

na množství světelné energie [16].  Jak bylo uvedeno dříve u snímků pořízených 

na základě SEM mikroskopie, je hodnota jednotlivých obrazových elementů závislá 

na množství odražených a sekundárních elektronů. Od vláken ležících na povrchu vrstvy 

se odrazí více sekundárních elektronů, vrchní vlákna vykazují vyšší úroveň jasu než vlákna 

spodní vrstvy. 

Digitalizace souřadnic se nazývá vzorkování, digitalizace intenzity jasu se nazývá 

kvantování. Podstatou vzorkování je uspořádání jednotlivých obrazových elementů 

do rastru (většinou pravidelné mřížky) a určení jejich vzdáleností. Kvantování jasové 

úrovně každého vzorku do k intervalů způsobí, že jasová funkce nabývá v digitalizovaných 

obrazech celočíselných hodnot. Počet kvantovacích intervalů musí být dostatečně velký, 

aby byly v následném obrazu zachyceny i detaily a nedocházelo k jeho zkreslování, 

například ke vzniku falešných obrysů. Počet kvantovacích úrovní jasu je vyjádřen vztahem 

k=2
b
, (1)

 

kde k je počet úrovní jasu a b počet bitů na jeden obrazový element. 

 

Na velikosti vzorkování a kvantování závisí konečná podoba digitalizovaného 

obrazu a jeho podobnost s obrazem původním. Čím jemnější tyto dva procesy jsou, tím 

lépe je původní obrazový signál aproximován [22].  

Jak bylo zmíněno dříve, výstupem kvantování a vzorkování je matice reálných 

čísel. Přepokládáme, že výsledný obraz f(x,y) je matice o rozměru M řádků a N sloupců, 

na základě toho můžeme říci, že obraz má velikost M x N. Ve většině případů je počátek 

matice obrazu definován v bodech (x,y) = (0,0). Příklad takovéto matice je na obr. 9(a). 
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V programu MATLAB  je počátek obrazu definován v bodech (r,c) = (1,1), kde r značí 

řádek (row) a c sloupec (column) v obrazové matici. Obrazová matice pro zpracování 

obrazu v programu MATLAB je zobrazena na obr. 9(b).  

Pixel je základní obrazový prvek, je nejmenší složkou digitálního obrazu, který je 

charakterizován intenzitou. Jednotlivé pixely tvoří čtvercovou sít, poloha jednotlivých 

pixelů je definována souřadnicemi. Nespojitá řada samostatných pixelů tvoří digitální 

obraz.    

  

(a) (b) 

Obr. 9 Pozice pixelů v obecné obrazové matici (a) [21], (b) v obrazové matici používané 

programem MATLAB [21]. 

3.3.1 Druhy digitálního obrazu 

Jak bylo řečeno výše, základní složkou digitálního obrazu je pixel. Jednotlivé pixely 

jsou uspořádány do souřadného systému, tzv. rastru. Každý pixel je nositelem vlastní 

barevné informace, která je zaznamenána pomocí bitů. Podle barevné informace kterou 

pixely nesou, rozlišujeme, o jaký typ obrazu se jedná. Obraz dělíme na binární, 

monochromatický a barevný, ukázka jednotlivých obrazů je uvedena na obr. 10(a)-(c). 

V případě této diplomové práce byly jako vstupní obrazy použity monochromatické 

snímky nanovlákenných vrstev získaný skenovací elektronovou mikroskopií.  

Binární obraz je nejjednodušším obrazem. Základní jednotkou tohoto obrazu je jeden 

bit, který nabývá pouze dvou hodnot – nul a jedniček. Nula reprezentuje černou barvu, 

která označuje pozadí, jednička reprezentuje barvu bílou, která tvoří oblast objektů. 

Binární obraz vzniká transformací obrazu monochromatického, používanou transformací je 

například prahování.  

Monochromatický obraz, též nazývaný šedotónový obraz, je založen na intenzitě 

odstínů jedné barvy. Jeden pixel obrazu se skládá z 8 bitů. 8-bitový obraz má od 0 do 255 
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odstínů šedé, kde je 0 reprezentována černou barvou a 255 je barva bílá. Monochromatický 

obraz je výstupem dříve zmíněné elektronové mikroskopie, světlou barvou jsou 

prezentovány buď části zkoumaného preparátu složené z těžkých prvků, nebo vrchní vrstva 

zkoumaného preparátu v závislosti na množství odražených elektronů.  

Barevný obraz RGB se kládá ze tří základních barev – červené (Red), zelené (Green) 

a modré (Blue). Jakoukoliv barvu ze spektra lze složit pomocí kombinací těchto barev. 

Hodnoty pixelů pro každou složku jsou od 0 do 255, vzhledem k tomu, že každý pixel 

může obsahovat všechny tři složky, je možné jednomu pixelu určit až 16 miliónů barev 

(256 
3
). 

 

   

(a) (b) (c) 

Obr. 10 Ukázka základních typů obrazu (a) binární obraz, (b) šedotónový obraz a barevný 

obraz (c) [23]. 

3.4  Předzpracování obrazu 

Cílem předzpracování obrazu je upravit nasnímaný digitalizovaný obraz do takové 

podoby, aby bylo možné co nejsnadněji a nejpřesněji získat z obrazu kvantitativní nebo 

kvalitativní charakteristiky týkající se hledaných objektů. Předzpracování obrazu je 

důležitým krokem předcházející segmentaci. Mezi základní nástroje předzpracování 

obrazu patří  

 kontrastní a jasové transformace,  

 operace vedoucí k potlačení šumu a zkreslení obrazu, 

 zostření obrazu, 

 úprava histogramu úrovní šedi.  
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V této diplomové práci byla ve fázi předzpracování obrazu použita vzhledem ke kvalitě 

SEM snímků pouze operace vedoucí k potlačení šumu v obraze. Šum byl ze vstupních 

snímků PCL nanovlákenných vrstev potlačen použitím mediánového filtru. Mediánový 

filtr byl aplikován v prostředí programu MATLAB i v prostředí programu ImageJ. Způsob 

aplikace a princip mediánového filtru je uveden v další části práce.  Předzpracovaný obraz 

je vhodným vstupem pro nejdůležitější část obrazové analýzy tzv. segmentaci obrazu, která 

je popsána v následující podkapitole. 

3.5 Segmentace obrazu 

Segmentace obrazu je jedním z nejvíce důležitých kroků ve zpracování obrazu, cílem 

segmentace obrazu je získat obraz, který je co nejvíce vhodný k identifikaci hledaných 

objektů. Za objekty v obraze považujeme ty části obrazu, které se nějakým způsobem liší 

od svého okolí - pozadí. Objekty je od pozadí možné rozeznat na základě různých 

indikátorů, mezi indikátory patří např. barva, intenzita šedi, geometrické vlastnosti 

a struktura objektů.   

Díky segmentaci obrazu je možné oddělit zkoumané objekty snímku od pozadí, 

zjednodušit obraz a získat vstup pro kvalifikaci číselných informací o objektech. Výstupem 

segmentace obrazu je zpravidla binární obraz. V práci byla pro realizaci segmentace 

použita metoda prahování, princip metody je popsán v následujícím textu.  

3.5.1 Prahování 

Prahování je základním a nejčastěji používaným nástrojem segmentace obrazu. 

Díky prahování je možné oddělit objekty od pozadí. Základním předpokladem 

pro prahování je poznatek, říkající, že objekt se od pozadí odlišuje jinými vlastnostmi 

(barvou, jasem, tvarem).  

Prahováním nazýváme transformaci vstupního monochromatického obrazu f(x, y) 

na výstupní obraz g(x, y), za aplikace prahové hodnoty o úrovni jasu T. Výsledkem 

této transformace je, že obrazové elementy s hodnotou jasu větší než zvolený práh T, 

nabudou hodnoty 1 (bílá barva) a charakterizují objekty, obrazové elementy s hodnotou 

jasu menší než zvolený práh T, nabudou hodnotu 0 (černá barva) a je jimi reprezentováno 

pozadí. Prahování s použitím jedné prahové hodnoty T lze dle [21] definovat pomocí 

vztahu 
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. 

(2) 

 

Další možnost transformace vstupního obrazu na binární je pomocí víceúrovňového 

prahování. Zvolený práh víceúrovňového prahování na rozdíl od prahování s jedním 

prahem nenabývá pouze jedné hodnoty, ale určitého intervalu od Tmin do Tmax. Obrazové 

elementy vstupního obrazu f(x,y), které nabývají hodnot ležících ve zvoleném intervalu, 

nabudou transformací na výstupní obraz g(x,y) hodnoty 1, ostatní pixely ponesou informaci 

0. Vztah platící pro víceúrovňové prahování je uveden v následující rovnici  

 

. 

(3) 

 

3.5.2 Základní způsoby prahování 

Jedním ze způsobů jakým lze v prostředí programu MATLAB převést  šedotónový 

obraz na binární je použití zaimplementované funkce im2bw.m. Pomocí této funkce 

lze specifikovat práh pohybující se v intervalu od 0 do 1.  Velikost prahu byla volena 

experimentálně, pouze odhadem. K demonstraci vlivu hodnoty prahu na vstupní obraz byl 

použit monochromatický snímek 16% PCL o velikosti 1024x1024 pixelů znázorněný 

na obr. 11(a1)-(a3).  

Nejprve byl k transformaci vstupního obrazu na binární použit práh o velikost 0.25. 

Prahová hodnota je znázorněna na histogramu obr. 11(b1). Všechny oblasti vstupního 

obrazu vykazující úroveň šedi větší než zadaný práh nabyly po transformaci hodnoty 

1 (bílá barva). Důsledkem této transformace je, že ve výsledném obraze obr. 11(c1) bylo 

ponecháno příliš mnoho objektů, objekty vzájemně splývají a nedošlo k odstranění 

spodních vrstev nanovlákenné struktury.  

Zvýšením hodnoty prahu na 0.5 graficky znázorněné na histogramu uvedeném 

na obr. 11(b2), nabyly po transformaci na binární obraz všechny pixely vykazující úroveň 

šedi menší než 127.5 hodnotu 0 (černá barva).  Tím došlo k odstranění spodních vrstev 

struktury ve výstupním binárním obraze. Ve výsledném obr. 11(c2) je méně ponechaných 

vláken, výsledný binární obraz je čitelnější.  

Pokud byla hodnota zvoleného prahu příliš vysoká 0.75 (prahová hodnota je zobrazena 

na histogramu úrovní šedi uvedeném na obr. 11(b3)), v binárním obraze byla zobrazena 



Fakulta textilní Technické univerzity v Liberci 

Monitorování vnitřní struktury nanovlákenných vrstev pomocí obrazové analýzy 37 

pouze místa vykazující vysokou úroveň šedi. Důsledkem takto zvoleného prahu bylo, 

že v transformovaném binárním obraze bylo ponecháno malé množství vláken a vlákna 

nejsou celistvá, takto transformovaný binární snímek je uveden na obr. 11(c3). 
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Obr. 11 Vstupní monochromatický snímek vrstvy nanovláken16% PCL (a1),(a2),(a3), 

histogram úrovně šedi s vyznačeným prahem 0.25 (b1), 0.5 (b2), 0.75 (b3), výsledný 

binární obraz za užití příslušné prahové hodnoty (c1), (c2) a (c3).  
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Volba prahu pomocí histogramu úrovní šedi 

Volba prahu je založena na histogramu četnosti výskytu jednotlivých úrovní šedi 

ve vstupním monochromatickém snímku, (jasových úrovních obrazu). Tento způsob 

prahování je vhodný především pro obraz, jehož histogram úrovní šedi je bimodální, 

tj. histogram má dvě maxima. Bimodálnost histogramu může být způsobena například 

převažujícím výskytem šedi o dvou intenzitách. 

 Práh je z bimodálního histogramu určen například jako 

 polovina vzdálenosti mezi dvěma maximy, 

 lokální minimum mezi dvěma maximy. 

Převod monochromatického obrazu na binární byl realizován také pomocí prahu 

odvozeného na základě histogramu úrovně šedi vstupního obrazu. Prahování proběhlo 

prostřednictvím zabudované funkce im2bw.m. Touto funkcí byly nalezeny všechny 

pixely vstupního obrazu, mající hodnotu úrovně šedi menší než zadaný práh a byla jim 

přiřazena hodna 0 znázorňující pozadí obrazu (černá barva), ostatní pixely jsou nositeli 

informace 1 (bílá barva) a reprezentují objekty. 

Jako objekty chápeme v prostředí programů umožňující obrazovou analýzu regiony 

neboli oblasti zájmu, které jsou nositelem informací vypovídajících o parametrech 

např. nanovlákenné struktury. Za objekt můžeme považovat například vlákno, pór, 

ale i celou vlákennou strukturu. V ukázkovém příkladě byly za objekty považovány vlákna 

tvořící vrchní vrstvu nanovlákenné struktury.  

V prostředí programu MATLAB slouží k vyvolání histogramu popisujícího zastoupení 

urovně šedi v obraze zaimplementovaná funkce imhist.m. Jednotlivé histogramy 

četnosti úrovní šedi pro zvolené monochromatické snímky nanovlákenných vrstev lišících 

se koncentrací zvlákněného polymeru PCL, znázorněných na obr. 12(a1)-(a4), jsou 

uvedeny na obr. 12(b1)-(b4). U všech histogramů je graficky zaznačena hodnota prahu. 

Na histogramech úrovně šedi uvedených na obr. 12(b1),(b2),(b4) byla zvolena hodnota 

prahu 130, pro histogram na obr. 12(b3) hodnota prahu 110.   

Použitím prahování s jedním prahem lze například oddělit vrchní vrstvu obrazu 

od spodní a tím získat binární obraz struktury, který má vypovídající informace například 

o velikosti pórů mezi vlákny a je vhodný pro další zpracování. Příklad oddělení vrchní 

vrstvy vláken od vstupního monochromatického obrazu je uveden na následující straně 

pomocí binárních snímků zobrazených na obr. 12(c1)-(c4).  
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Obr. 12 Šedotónový snímek nanovlákenné vrstvy (a1)-(a4) o koncentraci 14%, 16%, 18% 

a 20% PCL, histogram odpovídající úrovně šedi (b1)-(b4), výsledný binární snímek (c1)-

(c4). 
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Příklad použití víceúrovňového prahování  

Jak bylo řečeno dříve, víceúrovňové prahování spočívá v definování prahu jako 

intervalu. Použitím víceúrovňového prahování je možné selektovat z obrazu objekty, které 

jsou nositeli stejné nebo blízké jasové informace. V práci bylo toto prahování použito pro 

segmentaci kulovitých defektů vyskytujících se v nanovlákenné vrstvě.  Kulovité defekty 

jsou viditelné na snímku nanovlákenné vrstvy 16% PCL zobrazeném na obr. 13(a). Práh 

byl zvolen na základě informace o intenzitě šedi objektu zájmu, která byla zjištěna 

manuálně ze zkoumaného obrazu.  

Pro realizaci víceúrovňového prahování byl v prostředí programu MATLAB použit 

jednoduchý algoritmus založený na dříve definovaném vztahu (3). Algoritmus použitý 

pro realizaci víceúrovňového prahování je uveden níže. 

 Zjisti rozsah intenzity úrovně šedi hledaných objektů (imtool.m). 

 Definuj prahovací interval. 

 Vytvoř binární obraz, pixely s úrovní šedi nespadající do zadaného intervalu jsou 

po transformaci nositelem informace 0 (Ibw = I>Tmin & I<Tmax).  

Intenzita kulovitých defektů zobrazených na vstupním snímku 16% PCL o velikosti 

1024x1024 pixelů se pohybuje v intervalu od 150 do 190. Pomocí takto zvoleného prahu 

došlo k oddělení defektů od nanovlákenné struktury obr. 13(b).   

 

  

(a) (b) 

Obr. 13 Vstupní monochromatický obraz 16% PCL (a), (b) binární obraz 16% PCL za 

použití prahu ležícího v intervalu (150,190). 
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3.6 Popis nalezených objektů a interpretace výsledků 

Popis nalezených objektů je chápána jako popis kvantitativních číselných 

charakteristik, mezi které se řadí například plocha, obvod a popis kvalitativních 

charakteristik objektů, tzn. relace mezi objekty. Za interpretaci výsledků je považováno 

porozumění obsahu obrazu. 

V prostředí programu MATLAB slouží k získání kvantitativních charakteristik 

jednotlivých objektů obrazu funkce regionprops.m. Vstupem pro získání informací 

o objektech je například matice vzniklá z binárního obrazu vyvoláním zaimplementované 

funkce bwlabel.m. Výstupem této funkce je matice L (label matrix) o stejné 

velikosti jako vstupní obraz, která obsahuje indexy jednotlivých objektů vyskytujících se 

ve vstupním obraze. Díky volitelné proměnné, která může mít hodnotu 4 nebo 8, je 

stanoveno buď 4-sousedství nebo 8-sousedství množin pixelů. Pokud je argument 

proměnné vynechán, objekty jsou definovány na základě 8-sousedství. Prvky matice L jsou 

celočíselné hodnoty větší nebo rovno 0. Pixely označené 0 reprezentují pozadí. Obrazové 

pixely označené indexem 1 tvoří jeden objekt, pixely označené indexem 2 tvoří druhý 

objekt a tak dále. Ukázka značení objektů v matici je uvedena na obr. 14(a),(b). 

Na základě vytvořené matice jsou získány vlastnosti pro každý objekt binárního 

obrazu, jejich výsledné hodnoty jsou uvedeny v pixelech. Vlastnosti, které byly 

vyhodnoceny v rámci řešení této práce, jsou uvedeny níže. 

 Area – Skalární, skutečný počet pixelů v jednotlivých regionech.  

 Perimeter – Skalární vzdálenost (počet pixelů) kolem hranice regionu. Obvod 

je vypočítán jako vzdálenost mezi jednotlivými přilehlými páry pixelů kolem 

hranice regionu.   

 

  

(a) (b) 

Obr. 14 Binární obraz obsahující objekty (a), značení objektů v matici L (b). 
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4 Experiment 

Cílem experimentální části práce bylo navržení metod a algoritmů pro odhad 

kvantitativních charakteristik nanovlákenných vrstev za použití obrazové analýzy, vytvořit 

algoritmus navrženého postupu v programu MATLAB a popsat sled kroků v programu 

ImageJ.  

Prvním krokem experimentální části bylo vytvoření vzorků nanovlákenných vrstev 

získaných pomocí elektrostatického zvlákňováním. Tvorba nanovlákenných vrstev byla 

realizována v laboratoři KNT metodou elektrostatického zvlákňování polymeru 

polykaprolaktonu. Po vytvoření vzorků o rozdílné koncentraci zvlákňovaného roztoku 

následovalo snímání obrazu nanovlákenných struktur použitím skenovací elektronové 

mikroskopie. Pořízené snímky byly použity jako vstupní obrazy pro realizaci obrazových 

analýz vedoucích k vytvoření algoritmů v programu MATLAB a navržení sledu kroků 

v programu ImageJ, které mají za cíl definovat parametry nanovlákenných struktur. 

Klasifikovanými parametry nanovlákenných struktur byla charakteristika 

mezivlákenných pórů, určení parametrů defektů vyskytujících se v nanovlákenných 

vrstvách, orientace a průměry nanovláken. Podrobný popis výroby nanovlákenných 

vzorků, parametrů zvlákňování a charakterizace hledaných parametrů vytvořených 

nanovlákenných vrstev je uveden v následujících podkapitolách. 

4.1 Testovaná sada vzorků nanovlákenných vrstev 

Ke zvlákňování byl zvolen polymer polykaprolakton (dále jen PCL). PCL 

je biodegradabilní ester, který má široké uplatnění v biomedicínských aplikacích jakými 

jsou například cílené dodávky léčiv a materiál pro šití. Po uzdravení tkáně je PCL 

vstřebáno do organismu – dochází k hydrolýze esterové vazby [24], [28].  

Pro experiment byl použit PCL o molekulové hmotnosti Mw = 45 000 g.mol
-1

, polymer 

byl následovně rozpuštěn v roztoku chloroformu a etanolu. Tyto dvě složky rozpouštědla 

byly v poměru 9 : 1 (chloroform: etanol). Celkem došlo k zvláknění čtyř různých roztoků 

lišících se koncentrací PCL a rozpouštědla.  

Vlákna byla vytvořena použitím technologie elektrostatického zvlákňování, které bylo 

realizováno z jehly. Vlákna byla zvlákňována na podkladovou textilii vytvořenou 

technologií spunbond. U všech vzorků rozdílných koncentrací PCL byly zachovány stejné 
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parametry zvlákňování polymerních roztoků PCL. Parametry zvlákňování polymerních 

roztoků PCL o různých koncentracích jsou uvedeny v tab. 1.  

 

Tab. 1 Parametry zvlákňování roztoků PCL. 

Stanovené parametry elektrostatického zvlákňování 

Průměr jehly 0,9 mm 

Vzdálenost hrotu jehly od kolektoru 15 cm 

Vlhkost vzduchu okolí spinneru 36% 

Teplota vzduchu okolí spinneru 20°C 

Rychlost posunu zvlákňovaného polymeru v dávkovači 4 mm/hod 

Napětí  15 kV 

Koncentrace zvlákňovaného polymeru PCL 14%, 16%, 18%, 20% 

 

Z nanovlákenných vrstev PCL o rozdílných koncentracích byly připraveny preparáty 

určené pro skenovací elektronovou mikroskopii (SEM). Pořízené monochromatické 

snímky nanovlákenných vrstev byly použity jako vstupní obraz pro následující obrazovou 

analýzu zaměřenou na identifikaci základních kvantitativních charakteristik 

nanovlákenných struktur. Některé charakteristiky byly stanoveny například pomocí snímku 

nanovlákenné vrstvy 14% PCL pořízeném při zvětšení 500x obr. 15(a1) a zvětšení 15000x 

obr. 15(b1), snímku 16% PCL pořzeném za zvětšení 200x obr. 15(a2) nebo zvětšení 

15000x obr. 15(b2). Mezi další zkoumané snímky patřil například snímek 18% PCL 

pořízený při zvětšení 500x obr. 15(a3) a zvětšení 15000x obr. (b3) dále snímek 20% PCL 

pořízený při zvětšení 500x obr. (a4) a 10000x obr. (b4). Všechny uvedené obrázky jsou 

zobrazeny na následující straně. Celá sada pořízených SEM snímků nanovlákenných vrstev 

je k nahlédnutí na přiloženém CD. 

Mezi důležité sledované parametry nanovlákenných struktur patří 

 porózita, 

 charakteristika defektů vyskytujících se v nanovlákenných strukturách, 

 orientace vláken, 

 průměr vláken. 

V následujících podkapitolách jsou přiblíženy jednotlivé parametry nanovlákenných 

vrstev, které byly předmětem zkoumání. 
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(a1) (b1) 

  

(a2) (b2) 

  

(a3) (b3) 

  

(a4) (b4) 

Obr. 15 Snímek nanovlákenné vrstvy při zvětšení 500x (a1),(a3), (a4) 14%, 18%, 20% 

PCL, 16% PCL při zvětšení 200x (a2), (b1)-(b3) snímky o odpovídajících koncentracích 

při zvětšení 15000x, (b4) pořízený za zvětšení 10000x. 
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4.1.1 Porózita 

Nanovlákennou vrstvu lze i přes její zanedbatelné rozměry považovat za porézní 

materiál. Porózita je vlastnost nanovlákenných vrstev, která ovlivňuje například prodyšnost 

a prostupnost jiných medií materiálem. Například v  tkáňovém inženýrství je porózita 

důležitým parametrem ovlivňujícím rychlost růstu buněk a má vliv na enkapsulaci 

implantátů [28].  

Pro určení porózity je nutné definovat, jakou část struktury zabírají vlákna a jakou 

část zaujímá prázdný prostor, který označujeme jako póry. Poměr těchto dvou složek 

nazýváme zaplnění [25]. Objemovou definici zaplnění μv tedy definujeme dle vztahu  

μv = V/ Vc ,   (4) 

kde V je objem vláken a  Vc celkový objem výřezu. Zaplnění je bezrozměrné číslo ležící 

v intervalu μv ϵ <0,1>. 

Vzhledem k tomu, že jsou snímky nanovlákenných vrstev pořízeny v 2D podobě, 

budeme pro určení zaplnění uvažovat plošnou definici zaplnění. Plošné zaplnění μs je 

pak definováno dle rovnice  

µs = S /  Sc, (5) 

kde S je suma ploch jednotlivých elementů tj. vláken a Sc je celková plocha výřezu. Plošné 

zaplnění je bezrozměrné číslo ležící v intervalu µs ϵ <0,1>. 

Porózita ψ je dle [25] vyjádřena vztahem  

ψ = Vp/ Vc, (6) 

kde Vp je objem pórů a Vc je celkový objem. 

Porózita je chápána jako doplněk k zaplnění. Obecným zaplněním 

μ charakterizujeme zaplněný prostor, naopak prázdný prostor charakterizujeme porózitou 

ψ [25]. Vztah mezi porózitou a zaplněním je uveden v rovnici  

4.1.2 Charakteristika defektů  

Na některých snímcích nanovlákenných vrstev PCL o různých koncentracích byly 

na první pohled patrné defekty kulovitého tvaru (v literatuře [11] jsou kulovité defekty 

nanovlákenných vrstev označovány jako perličky). Tyto kulovité defekty vyskytující se 

v nanovlákenných vrstvách jsou nežádoucí. Vznik defektů je dle práce [1], [11] zapříčiněn 

nízkou koncentrací polymeru ve zvlákňovaném roztoku, zvýšením koncentrace zpravidla 

ψ = 1- μ. (7) 
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dochází k zamezení jejich tvorby. Mezi charakteristiky, které byly u defektů vyskytujících 

se v nanovlákenných strukturách v rámci následující obrazové analýzy sledovány patří 

 obsah defektů, 

 obvod defektů. 

Výskyt defektů kulovitého tvaru je možné vidět na monochromatickém snímku 

14% PCL pořízeného SEM mikroskopií při zvětšení 500x, snímek je uveden na 

obr. 16(a1), snímek 14% PCL při zvětšení 15000x je uveden na obr. 16(a2). Na obr. 16(b1) 

je monochromatický snímek 16% PCL pořízený za zvětšení 200x a na obr. 16(b2) 

za zvětšení 15000x. Na monochromatických snímcích 18% PCL obr. 16(c1) pořízeného při 

zvětšení 500x a na obr. 16(c2) pořízeného při zvětšení 15000x, je na prvních pohled velmi 

málo kulovitých defektů.    

 

   

(a1) (b1) (c1) 

   

(a2) (b2) (c2) 

Obr. 16 Defekty PCL vláken v závislosti na koncentraci, (a1), (a2) koncentrace 14% PCL, 

(b1), (b2) koncentrace 16% PCL, koncentrace 18% PCL c1), (c2). 



Fakulta textilní Technické univerzity v Liberci 

Monitorování vnitřní struktury nanovlákenných vrstev pomocí obrazové analýzy 47 

4.1.3 Orientace vláken 

Orientace vláken je velmi důležitým parametrem, který ovlivňuje výsledné vlastnosti 

výchozích struktur. Na orientaci vláken závisí především mechanické vlastnosti, tzn., 

pokud jsou vlákna plošné či délkové textilie orientovaná v jenom směru, textilie vykazuje 

v tomto směru vyšší pevnost.  Dále orientace vláken ovlivňuje prodyšnost, propustnost 

a absorpci kapalin vlákenných porézních materiálů.   

V práci Rataje a Saxla [26] je uvedena grafická metoda pro odhad směrového 

uspořádání vláken. Podstatou metody je sestrojení texturní funce, tj. směrové růžice f(α) na 

základě sítě úhlů α1, až αn umístněných na povrchu sledovaného systému vláken. Průsečíky 

sítě úhlů se sledovaným vlákenným útvarem jsou znázorněny na obr. 17(a). Dle autorů 

práce je metoda stabilní pokud je počet úhlů α menší než 18. Výsledkem metody je 

zachycení směrového uspořádání vláken pomocí směrové růžice zkonstruované na základě 

grafické interpretace Steinerova kompaktu (konvexní, středově symetrický mnohoúhelník). 

Směrová růžice je znázorněna na obr. 17(b). 

 

 

 

(a) (b) 

Obr. 17 Průsečíky sítě úhlů se sledovaným vlákenným útvarem (a) [27], směrová růžice (b) 

[27]. 

4.1.4 Průměr vláken 

Nanovlákna se od všech jiných vláken liší především svou velikostí, která dosahuje 

řádu nanometrů. Průměr vláken je jedním ze základních strukturních parametrů, od kterého 

se odvíjí vlastnosti celé vlákenné struktury. Charakteristika průměru nanovláken je 

převážně stanovována na základě použití obrazové analýzy, která umožňuje měření i velmi 

malých struktur. Průměr nanovláken je v procesu zvlákňování dle [11] ovlivněn například 

velikostí napětí mezi elektrodami, čím je napětí mezi elektrodami vyšší, tím je z jehly 

uvolněno více polymeru a vlákna vykazují vyšší průměr.  
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4.2 Extrakce parametrů pórů z nanovlákenných vrstev 

Nanovlákennou vrstvu lze i přes její zanedbatelné rozměry považovat za porézní 

materiál. Porózita je vlastnost nanovlákenných vrstev, která ovlivňuje například prodyšnost 

a prostupnost jiných medií materiálem.  

Parametry pórů byly zjišťovány v prostředí programu MATLAB a prostředí 

programu ImageJ na základě monochromatických snímků PCL nanovlákenných vrstev 

lišících se koncentrací pořízených skenovací elektronovou mikroskopií. Mezi zkoumané 

snímky patří obraz 14% PCL o velikosti  1024x1024 pixelů obr. 18(a), obraz 16% PCL 

o velikosti  1024x1024 pixelů obr. 18(b), obraz 18% PCL obr. 18(c) o rozměrech 

1024x1024 pixelů a obraz 20% PCL o velikosti 512x512 pixelů obr. 18(d).  

 

  

(a) (b) 

  

(c) (d) 

Obr. 18 Vstupní monochromatický snímek nanovlákenné vrstvy 14% PCL (a), 16% PCL 

(b), 18% PCL (c) a 20% PCL (d).  
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4.2.1 Metodika stanovení parametrů pórů v programu MATLAB 

V prostředí programu MATLAB bylo stanovení parametrů nanovlákenných pórů 

realizováno na základě navrženého algoritmu, vycházejícího především ze segmentace 

obrazu. Pomocí vhodného zpracování vstupních monochromatických snímků bylo možné 

segmentovat objekty, které prezentují póry a stanovit jejich základní charakteristiky. 

Posloupnost jednotlivých kroků vedoucích k zjištění základních charakteristik pórů 

je uvedena níže.  

Jak bylo uvedeno dříve, důležitou částí obrazové analýzy je předzpracování obrazu, 

jehož cílem je upravit vstupní obraz pro následující kroky vedoucí k získání kvantitativních 

informací o hledaných objektech. Jako vstupní obraz byl pro demonstrování metody 

stanovení porózity zvolen snímek 14% PCL o velikosti 1024x1024 pixelů, uvedený 

na obr. 19(a). Úprava obrazu spočívala v odstranění šumu vstupního obrazu. Šum byl 

z obrazu odstraněn aplikací prostorového mediánového filtru o rozměrech masky 3x3 

pixely. Obraz, na který byl aplikován mediánový filtr je znázorněn na obr. 19(b). 

 

  

(a) (b) 

Obr. 19 Vstupní obraz nanovlákenné vrstvy 14% PCL (a), obraz po odstranění šumu (b). 

 

V části segmentace byl vstupní obraz převeden na binární za použití prahování. 

Prahováním došlo k oddělení vrchní vrstvy nanovláken od pozadí a spodních vrstev 

vláken. Pro ukázkový i ostatní zkoumané obrazy byla zvolena jednotná hodnota prahu 130, 

vzniklý binární obraz je k nahlédnutí na obr. 20(a).  

Dalším krokem bylo odstranění malých objektů z obrazu, které je možné chápat 

jako šum. Tyto útvary nemají vypovídající hodnotu o hledaných parametrech, pokud 

bychom je v obrázku ponechali a dále analyzovali, vedlo by to ke zkresleným výsledkům. 



Fakulta textilní Technické univerzity v Liberci 

Monitorování vnitřní struktury nanovlákenných vrstev pomocí obrazové analýzy 50 

Použitím implementované morfologické funkce určené k odstranění definovaných objektů 

z obrazu je možné z binárního snímku nanovlákenné vrstvy odstranit všechny objekty, 

které se neskládají z minimálního argumentovaného počtu pixelů. Ze všech snímků byly 

odstraněny objekty, které se skládají z méně než 30 pixelů, obr. 20(b). 

 

  

(a) (b) 

Obr. 20 Binární obraz 14% PCL (a), obraz po odstranění malých objektů (b). 

 

Jak již bylo zmíněno, bílá barva reprezentuje objekty tj. vlákna a barva černá 

pozadí tj. mezivlákenné póry. Mezivlákenné póry je pro stanovení jejich parametrů 

nutné transformovat na objekty. Toho je možné docílit pomocí převodu 

na tzv. „negativ“, který je zobrazen na obr. 21(a).  

Pro získání objektivních informací z obrazu nanovlákenných struktur bylo nutné 

potlačit nekompletní objekty spojené s hranicí obrazu, obr. 21(b). Tímto krokem bylo 

zamezeno získání zkreslených kvantitativních charakteristik.  

V dříve morfologicky upraveném binárním obraze byly stále viditelné malé 

objekty, které byly použitím zaimplementované funkce opětovně odstraněny. Ponechány 

byly všechny objekty větší než 30 pixelů. Takto upravený binární obraz nanovlákenné 

vrstvy uvedený na obr. 15(c) byl použit pro získání základních informací o pórech.  
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(a) (b) 

 

(c) 

Obr. 21 Obraz převedený na negativ (a), potlačení struktur dotýkajících se hranic obrazu 

(b), obraz po odstranění malých objektů (c). 

 

Informace o počtu a velikosti pórů bylo možné získat prostřednictvím vytvořené 

matice o stejných rozměrech jako vstupní obraz, ve kterém jsou pomocí indexů 1 až n 

označeny jednotlivé objekty (oblasti zájmu). Pixely označené číslem 1 značí jeden region, 

pixely označené číslem 2 region druhý atd. V prostředí programu MATLAB je možné 

graficky znázornit jednotlivé regiony přiřazením barvy z RGB spektra, obr. 22(a) a (b).  

 Vykreslení obvodů pórů v původním monochromatickém obraze je uvedeno 

na obr. 22(c),(d). 
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(a) (b) 

  

(c) (d) 

Obr. 22 Vykreslené objekty v RGB (a), (b), grafické znázornění hranic pórů v původním 

obraze (c) a (d).  

 

Uvedený postup stanovení základních parametrů pórů se dá snadno interpretovat 

pomocí algoritmu skládajícího se z několika kroků. Sled jednotlivých kroků navrženého 

algoritmu spolu s uvedenými zaimplementovanými funkcemi využitými v prostředí 

programu MATLAB je uveden v následujícím textu. Použité zaimplementované funkce 

jsou a jejich výklad je uveden v příloze 1. Skript určený k vyhodnocení parametrů 

mezivlákenných pórů je přiložen v příloze 2.   

 Odstraň šum vstupního obrazu použitím mediánového filtru (medfilt2.m). 

 Převeď vstupní obraz na binární, použij operaci prahování, hodnotu prahu T nalezni 

experimentálně (im2bw.m). 

 Odstraň malé objekty z obrazu (bwareaopen.m). 
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 Potlač struktury dotýkající se hranic obrazu (imclearborder.m). 

 Převeď pixely nesoucí informaci 1 na 0 a naopak, (vytvoř negativ obrazu). 

 Detekuj jednotlivé regiony, vytvoř vstupní matici pro získání informací 

o objektech(bwlabel.m).  

 Detekuj hranice pórů, vykresli je do vstupního obrazu (imerode.m).   

 Proveď kalibraci, převeď pixely jednotlivých regionů na mikrometry. 

 Vypočítej parametry jednotlivých regionů, vyhodnoť parametry pórů celého obrazu 

(regionprops.m). 

4.2.2 Výsledky metodiky stanovení parametrů pórů v MATLABU 

Pomocí zaimplementované funkce je možné určit sadu vlastností pro jednotlivé 

objekty, jejichž velikost byla získána vytvořením matice, ve které jsou jednotlivé objekty 

reprezentovány pomocí příslušných indexů. K zjištění parametrů pórů byla použita 

vlastnost Area a Perimeter. Pomocí Area byl určen skutečný počet pixelů 

v jednotlivých regionech. Použitím Perimeter byl získán obvod jednotlivých pórů 

v pixelech. Velikosti jednotlivých parametrů v pixelech nemají reálnou vypovídající 

hodnotu o vlastnostech pórů, z tohoto důvodu bylo nutné provést kalibraci výsledků 

měření. Pro jednotlivé snímky byly určeny kalibrační vztahy. Kalibrační vztahy byly 

stanoveny jako poměr přímky měřítka uvedeného v obraze a skutečného počtu pixelů, 

tvořících přímku měřítka. Kalibrační vztahy pro převod pixelů na mikrometry 

u jednotlivých zkoumaných monochromatických snímků PCL v závislosti na koncentraci 

jsou uvedeny v tabulce tab. 2. 

 

Tab. 2 Kalibrační vztahy pro jednotlivé snímky v závislosti na koncentraci. 

Koncentrace Kalibrační vztah 

14% PCL 1 pixel = 0.0195µm 

16% PCL 1 pixel = 0.0195 µm 

18% PCL 1 pixel = 0.0195 µm 

20% PCL 1 pixel = 0.588 µm 

 

Průměrná plocha a obvody pórů získaných obrazovou analýzou 

monochromatických snímků PCL nanovlákenných vrstev pořízených v závislosti 
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na koncentraci polymerních roztoků, jsou uvedeny v tab. 3. Histogramy četností velikostí 

ploch pórů v závislosti na jednotlivých koncentracích PCL jsou uvedeny na obr. 23(a)-(d), 

na obr. 24(a)-d), jsou uvedeny histogramy četnosti obvodů pórů v závislosti na koncentraci 

PCL. 

 

Tab. 3 Průměrná plocha a obvod pórů v závislosti na koncentraci PCL. 

Koncentrace  Počet 

pórů 

Celková 

plocha [µm
2
] 

Průměrná 

plocha [µm
2
] 

Std 

[µm
2
] 

Porózita 

[%] 

Průměrný 

obvod [µm] 

Std 

[µm] 

14 PCL [%] 266 180.78 0.67 1.09 45 3.25 3.13 

16 PCL [%] 248 238.88 0.96 1.58 59 3.99 3.85 

18 PCL [%] 116 160.07 1.37 2.79 40 4.95 5.55 

20 PCL [%] 124 31757 256.11 331.79 35 85.11 84.98 
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(c) (d) 

Obr. 23 Histogram četnosti velikosti ploch pórů 14% PCL (a), 16% PCL (b), 18% PCL 

(c) a 20% PCL (d). 
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(c) (d) 

Obr. 24 Histogram četnosti obvodů pórů 14% PCL (a), 16% PCL (b), 18% PCL (c) a 20% 

PCL (d). 

 

Porózita nanovlákenných vrstev byla stanovena na základě plošné interpretace 

dříve uvedeného vztahu (6). Dle tohoto vztahu byla porózita jednotlivých snímků 

nanovlákenných vrstev stanovena jako podíl sumy všech bílých pixelů obrazu 

reprezentujících plochy pórů a celkového obsahu obrazu. Ze získaných výsledků porózity 

uvedených v tabulce 3 lze usoudit, že koncentrace má vliv na porózitu nanovlákenných 

vrstev, porózita zkoumaných nanovlákenných vrstev se v závislosti na koncentraci 

zvlákněného polymeru lišila.   

Stanovení parametrů pórů na základě obrazové analýzy provedené v prostředí 

programu MATLAB je snadný proces založený na segmentaci obrazu.  Na základě 

zjištěných výsledků nelze jednoznačně říci, že koncentrace 14%, 16%, a 18% PCL 

zvlákňovaného roztoku ovlivňuje velikost mezivlákenných pórů. Výsledky zjištěné 

aplikací metody se lišily pouze v případě mezivlákenných pórů 20% PCL, které byly 

na rozdíl od ostatních výsledků zhruba 200x větší. Velikosti pórů zkoumaných snímků 
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nanovlákenných vrstev je velmi různorodá, průměrné velikosti pórů vykazují vysoké 

směrodatné odchylky.  

4.2.3 Metodika stanovení parametrů pórů v programu ImageJ 

Stejně jako tomu bylo při stanovení parametrů pórů v prostředí programu 

MATLAB, tak i v prostředí programu ImageJ byl proces analýzy demonstrován 

na vstupním monochromatickém snímku 14% PCL o rozměrech 1024x1024 pixelů 

zobrazeném dříve na obr. 18(a). V následujícím textu jsou popsány jednotlivé kroky 

analýzy obrazu v prostředí programu ImageJ. 

 

Analyze → Set Scale  

Prvním krokem, který následoval po načtení snímku 14%PCL do pracovního 

prostředí programu ImageJ byla kalibrace, jejímž cílem je převést pixely obrazu 

do reálných jednotek. Ke kalibraci slouží v nabídce Analyze příkaz Set Scale. 

Před použitím příkazu Set Scale bylo nutné zjistit délku kalibrační přímky nacházející 

se na snímku. Délka kalibrační přímky byla stanovena použitím Straight Line Selection – 

nástroje přímky uvedeného na obr. 25(a), nacházejícího se v nabídce nástrojů Toolbaru. 

Délka kalibrační přímky v pixelech (Distance in Pixels) byla pomocí vytvořené přímky 

po vyvolání příkazu Set Scale automaticky zapsána do tabulky uvedené na obr. 25(b), 

délka v reálných jednotkách (Know Distance) byly zapsána manuálně. Dále je možné 

nastavit například jednotku (Unit of Length).  

 

 

 

 

 

 

 

 

 

(a) 

  

 

(b) 

Obr. 25 Vytvořená kalibrační přímka v obraze (a), kalibrační dialogové okno (b). 
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Image → Crop  

Pomocí příkazu Crop v nabídce Image je možné vstupní obraz manuálně ořezat 

na velikost 1024x1024 pixelů. Výběr obrazu, který měl být ponechán, byl označen 

nástrojem Rectangular selections nacházejícím se na hlavním Toolbaru.  

  

Process → Noise → Despeckle  

Použitím příkazu Despeckle nacházejícím se v kategorii Noise nabídky Process 

došlo k odstranění šumu ze vstupního obrazu uvedeného na obr. 26(a). K odstranění šumu 

byla použita lineární filtrace využívající metodu mediánového filtru. Princip mediánové 

filtrace obrazu spočívá v nahrazení každého pixelu obrazové funkce mediánem z jeho okolí 

o rozměrech 3x3 pixelů. Filtrovaný obraz je uveden na obr. 26(b).   

 

  

(a) (b) 

Obr. 26 Vstupní monochromatický obraz nanovlákenné vrstvy 14% PCL (a), filtrovaný 

obraz (b).  

 

Image → Adjust → Treshold 

Program ImageJ má opačné chápání objektů a pozadí než jak je tomu v prostředí 

programu MATLAB. ImageJ považuje za objekty oblasti charakterizované černou barvou, 

bílou barvou je reprezentováno pozadí. Pomocí příkazu Treshold došlo k převodu 

šedotónového obrazu znázorněného na obr. 27(a), na binární obraz, za použití prahové 

hodnoty o úrovni šedi 130.  Výsledný binární obraz je zobrazen na obr. 27(c). Prahová 

hodnota byla nastavena v dialogovém okně Treshold  zobrazeném na obr. 27(b) pomocí 

histogramu úrovně šedi vstupního obrazu.  
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Process → Binary →Fill Holes 

Použitím příkazu  Fill Holes došlo k morfologické změně objektů v obraze, kterou 

je zaplnění vyskytujících se děr, obraz po vyplnění děr je uveden na obr. 27(d). Princip 

vyplnění děr v objektech je založen na převodu bílých pixelů pozadí v černých objektech 

na černé pixely objektů.  

 

  

(a) (b) 

  

(c) (d) 

Obr. 27 Vstupní obraz (a), dialogové okno Treshold(b), binární obraz (c), obraz 

s vyplněnými dírami (d). 

 

Analyze → Set Measurements 

Pomocí dialogového okna Set Measurements uvedeného na obr. 28(a) je možné určit, 

která měření budou na binárním obraze realizována. V našem případě mezi hodnocené 

vlastnosti patří 

 Area - plocha objektů,  

 Perimeter - délka vnější hranice objektů, 

 Area Fraction - procento nenulových pixelů. 
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Analyze → Analyze Particles 

Příkaz Analyze Particles v nabídce Analyze  slouží k měření velikostí objektů 

v binárním obraze. Princip tohoto příkazu spočívá v procházení obrazu pixel po pixelu 

za účelem nalezení objektů, až je objekt nalezen, jsou vyznačeny jeho hranice, a je mu 

přidělen pořadový index od 1 do n. V dialogovém okně tohoto příkazu obr. 28(b) je možné 

nastavit nevyhodnocení údajů o nekompletních objektech, které se dotýkají obrazové 

hranice zatržením řádku Exclude on Edges. Další nabídkou dialogového okna je potlačení 

vyhodnocení oblastí o libovolně definovatelné velikosti pixelů (Size pixel^2), v našem 

případě nebyly vyhodnoceny všechny objekty menší než 30 pixelů.  

 

  

(a) (b) 

Obr. 28 Dialogové okno Set Measurments (a), dialogové okno Analyze particles (b). 

 

Pro lepší orientaci v detekovaných pórech nanovlákenných struktur je možné 

vykreslit obvody objektů (Show Outlines), znázorněno na obr. 29(a) nebo nahradit objekty 

nejvhodnějšími elipsami popisujícími tvar pórů (Show Ellipses), elipsa má stejnou plochu, 

orientaci a těžiště jako pór, který reprezentuje. Ukázka takovéto interpretace pórů 

prostřednictvím elipsy je uvedena na obr. 29(b). 

 

 

 

(a) (b) 

 Obr. 29 Vykreslené hranice objektů (a), znázornění objektů elipsami (b). 
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Analyze → Summarize 

Příkaz Summarize v nabídce Analyze spočítá průměr, směrodatnou odchylku, 

minimální a maximální hodnotu provedených měření zadaných parametrů nastavených 

v dialogovém okně Set Measurements. Výsledky vyhodnocení základních charakteristik 

nanovlákenných pórů v prostředí programu ImageJ jsou uvedeny v tabulce 4. 

 

Tab. 4 Výsledky vyhodnocení parametrů nanovlákenných vrstev v ImageJ. 

Koncentrace  Počet 

pórů 

Celková plocha  

[µm
2
] 

Průměrná plocha 

[µm
2
] 

Std 

[µm
2
] 

Porózita 

[%] 

Obvod 

[µm] 

Std 

[µm] 

14 PCL [%] 253 175.60 0.69 1.10 45 3.35 3.08 

16 PCL [%] 238 237.23 1.00 1.61 60 4.10 3.81 

18 PCL [%] 110 159.01 1.45 2.84 40 5.18 5.53 

20 PCL [%] 117 31008.18 265.03 325.24 35 89.06 82.74 

 

Results → Distribution 

 Z důvodu lepší orientace ve zjištěných výsledcích je možné, stejně jako v programu 

MATLAB zobrazit histogram četností naměřených veličin. Histogram četností je vyvolán 

v nabídce Results dialogového okna Results, které je zobrazené na obr. 30(a), 

v dialogovém okně jsou zaznamenány jednotlivé naměřené hodnoty parametrů, které byly 

dříve určeny k vyhodnocení. Histogram je vytvořen prostřednictvím rozhraní Distribution 

uvedeném na obr. 30(b). V tomto rozhraní je možné nastavit parametr, který má být 

histogramem interpretován a také počet intervalů histogramu, do kterých mají být 

naměřené hodnoty daného parametru rozděleny.  

 

 
 

(a) (b) 

Obr. Dialogové okno Results (a), Dialogovéokno Distribution (b).  
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Na následujícím obr. 31(a)-(d) jsou zobrazeny histogramy naměřených ploch pórů a 

na obr. 32(a)-(d) jsou zobrazeny histogramy obvodů pórů jednotlivých nanovlákenných 

vrstev v závislosti na koncentraci zvlákňovaného PCL roztoku. 

 

  

(a) (b) 

  

(c) (d) 

Obr. 31 Histogram ploch pórů snímku nanovlákenné vrstvy 14% PCL (a), 16% PCL (b), 

18% PCL (c), 20% PCL (d). 

 

  

(a) (b) 

  

(c) (d) 

Obr. 32 Histogram obvodů pórů snímku nanovlákenné vrstvy 14% PCL, 16% PCL, 18% 

PCL a 20% PCL.  

 



Fakulta textilní Technické univerzity v Liberci 

Monitorování vnitřní struktury nanovlákenných vrstev pomocí obrazové analýzy 62 

Klasifikace mezivlákenných pórů v prostředí programu ImageJ je jednoduchým, 

uživatelsky snadným způsobem stanovení tohoto parametru nanovlákenné vrstvy. Stručné 

shrnutí jednotlivých posloupných kroků použitých v prostředí programu ImageJ k určení 

parametrů pórů je uvedeno v příloze 7.  

4.3 Zhodnocení extrakce parametrů pórů z nanovlákenných 

vrstev 

Na základě uvedených výsledků měření základních charakteristik pórů, jakými je 

jejich plocha, obvod a porózita můžeme říci, že se zjištěné parametry nanovlákenných 

vrstev vyhodnocené v programu MATLAB a programu ImageJ shodují.  

Vyhodnocení parametrů pórů je v programu MATLAB stejně tak jako vyhodnocení 

v prostředí programu ImageJ založeno na segmentaci obrazu. Stanovení výsledků v ImageJ 

je pro uživatele snadnější, v programu MATLAB je uživatel nucen vytvořit algoritmus. 

Výhodou programu MATLAB je dobrá reprodukovatelnost a možnost relativně snadné 

a přehledné interpretace výsledků pomocí více statistických nástrojů než pouze za použití 

histogramu.  

4.4 Detekce parametrů defektů nanovlákenných vrstev 

Jak bylo řečeno dříve, na pořízených snímcích nanovlákenných vrstev jsou 

viditelné nežádoucí kulovité útvary – defekty, způsobené nízkou koncentrací PCL 

ve zvlákňovaném roztoku. Parametry těchto defektů byly v prostředí programu MATLAB  

a v prostředí programu ImageJ zjišťovány dvěma rozdílnými způsoby. První způsob 

vyhledává defekty za použití korelační metody. Druhý způsob je založen 

na víceúrovňovém prahování. Aplikace a výsledky jednotlivých metod jsou uvedeny níže.  

Obě metody stanovení základních parametrů defektů byly aplikovány na čtyřech 

snímcích PCL nanovlákenných vrstev o jednotné velikosti 512x512 pixelů. Zkoumané 

vrstvy se lišily koncentrací PCL ve zvlákňovacím roztoku. V experimentu byly zkoumány 

snímky nanovlákenných vrstev o koncentracích 14% PCL obr. 33(a), 16% PCL obr. 33(b) 

a 18% PCL obr. 33(c). Jak uvedeno dříve, výskyt defektů v nanovlákenné vrstvě je závislý 

na koncentraci zvlákňovaného roztoku. Ve snímku nanovlákenné vrstvy o koncentraci 

20% PCL obr. 33(d), nejsou na první pohled přítomny žádné defekty. 
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(a) (b) 

  

(c) (d) 

Obr. 33 Monochromatický snímek nanovlákenné vrstvy 14% PCL (a), 16% PCL (b) 18% 

PCL (c) 20% PCL (d).  

 

4.4.1 Metodika stanovení parametrů defektů korelační metodou v 

MATLABU  

Podstatou metody detekce objektů pomocí korelace je najít všechna místa v obraze 

f(x,y), která se shodují s podobrazem tzv. šablonou w(x,y). V našem případě byly pomocí 

této metody hledány ve vstupním obraze defekty kulovitého tvaru. Jako vyhledávací 

šablona byl nejdříve zvolen výřez defektu ze vstupního obrazu, pro snadnější interpretaci 

na více snímcích byla následně vytvořena univerzální šablona, ve které byl vykreslen 

kruhový objekt o průměru shodujícím se s průměrem defektů. Typická šablona w(x,y) je 

mnohem menší než zkoumaný obraz f(x,y). Princip metody spočívá v použití šablony 

w jako prostorového filtru, kterým je pixel po pixelu procházen a korelován celý vstupní 

obraz. Na základě zjištěné korelace mezi vstupním obrazem a šablonou lze detekovat 
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hledané defekty jako místa s největší shodou w a f. Místa ve kterých byly nalezeny defekty 

se vyznačují nejsvětlejšími odstíny šedi v korelovaném obraze [21].  

 

V práci byla metoda srovnání korelovaného obrazu se vzorem použita 

pro vyhledávání defektů v nanovlákenné vrstvě. Zkoumaný ilustrativní obraz 14% PCL 

o velikosti 500x500 pixelů je uveden na obr. 34(a).  

Prvním krokem bylo vytvoření šablony, na základě které došlo k vyhledání tvarově 

podobných objektů. Defekty jsou charakteristické jejich kulovitým tvarem, z tohoto 

důvodu byla univerzální šablona vytvořena jako strukturní prvek ve tvaru kruhu 

o poloměru 6 pixelů. Vzniklému strukturnímu prvku byly přidány na začátku a na konci 

všech řádků a sloupků 3 pixely tvořící pozadí. Na základě informace o intenzitě šedi 

hledaných defektů, která se pohybuje v intervalu od 155 do 185, byla vytvořená šablona 

převedena z binární podoby do šedotónové, všechny objektové pixely nesoucí informaci 1 

se staly pixely o intenzitě šedi rovné 170. Vytvořená šablona je uvedena na obr. 34(b).  

 

 

 

(a) (b) 

Obr. 34 Vstupní monochromatický obraz 14% PCL nanovlákenné vrstvy (a), vytvořená 

vyhledávací šablona (b). 

 

V následujícím kroku došlo pomocí nadefinované funkce k výpočtu míry 

podobnosti vyhledávací šablony a vstupního obrazu v každém obrazovém pixelu. 

Výstupem této operace je matice korelací. Korelovaný obraz je uveden na obr. 35(a). Místa 

ve zkoumaném obraze, která se vyznačují vysokou korelací jsou nejsvětlejší a odpovídají 

vysoké shodě šablony a obrazu. Pomocí prahování korelovaného obrazu při volbě prahu 
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o velikosti 0.6 bylo dosaženo binárního obrazu, který zobrazuje objekty shodné 

se šablonou. Detekované objekty jsou znázorněny na obr. 35(b).   

 

  

(a) (b) 

Obr. 35 Korelovaný obraz (a), binární obraz (b). 

 

Na takto upraveném binárním obraze je viditelné velké množství malých objektů, 

které nereprezentují hledané defekty, z tohoto důvodu byly z binárního obrazu odstraněny 

všechny objekty menší než 30 pixelů, obraz po odstranění malých objektů je zobrazen 

na obr. 36(a). Dále byly v obraze potlačeny nekompletní objekty ležící na obrazových 

hranicích. Na obr. 36(b) je uveden obraz bez objektů dotýkajících se obrazových hranic.  

 

  

(a) (b) 

Obr. 36 Binární obraz po odstranění malých objektů (a), obraz s potlačenými 

nekompletními objekty ležícími na obrazové hranici (b). 
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Takto získaný binární obraz je vhodnou předlohou pro získání informací 

o objektech. Vstupem pro statistické vyhodnocení číselných informací získaných z obrazu 

byla stejně jako u stanovení parametrů pórů matice, ve které jsou jednotlivé objekty 

značeny indexy. Grafické znázornění vstupní matice detekující jednotlivé objekty je 

uvedeno na obr. 37(a),(b).  

 

(a) (b) 

Obr. 37 Znázornění nalezených objektů v RGB barvách (a), (b).  

 

Na obrázcích obr. 38(a),(b) byly znázorněny obvody nalezených defektů v původním 

šedotónovém obraze. Z obrázků je patrné, že na základě korelační metody byly 

v nanovlákenné vrstvě 14% PCL nalezeny téměř všechny vyskatujcí se kulovité defekty. 

 

  

(a) (b) 

Obr. 38 Grafické znázornění obvodů nalezených objektů ve vstupním obraze (c) a (d).  
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Uvedený postup detekce defektů pomocí korelační metody v prostředí programu 

MATLAB lze snadno shrnout pomocí několika kroků tvořících níže uvedený algoritmus. 

V algoritmu jsou u každého kroku uvedeny základní použité zaimplementované funkce. 

Odpovídající skript je uveden v příloze 3.  

 Vytvoř vzorovou šablonu pro detekci defektů (strel.m, padarray.m). 

 Proveď korelaci mezi šablonou a obrazem (dftcorr.m). 

 Proveď prahování korelovaného obrazu (im2bw.m). 

 Uprav obraz použitím morfologických operací, odstraň malé objekty a potlač 

objekty ležící na hranici obrazu. (bwareaopen.m, imclearborder.m,). 

 Vytvoř vstupní matici, ve které jsou jednotlivým objektům přiřazeny indexy, jenž 

slouží pro získání informací o jednotlivých defektech (bwlabel.m). 

 Proveď kalibraci, převeď pixely jednotlivých regionů na mikrometry. 

 Vypočítej parametry jednotlivých regionů, vyhodnoť parametry defektů celého 

obrazu (regionprops.m). 

 Vykresli obvody nalezených defektů ve vstupním obraze (bwmorph.m,  

remove.m). 

4.4.2 Výsledky detekce defektů korelační metodou v MATLABU 

Pomocí zaimplementované funkce bylo možné určit sadu vlastností pro jednotlivé 

nalezené defekty zapsané pomocí matice. K zjištění parametrů defektů byla použita 

vlastnost určující plochu Area a vlastnost udávající obvod Perimeter. Pro získání 

velikosti parametrů v mikrometrech bylo nutné provést kalibraci výsledků měření. 

Kalibrační vztahy použité pro vyhodnocení jednotlivých snímků jsou uvedeny v tab. 5.  

 

Tab. 5 Kalibrační vztahy jednotlivých snímků v závislosti na koncentraci. 

Koncentrace Kalibrační vztah 

14% PCL 1 pixel = 0.588 μm 

16% PCL 1 pixel = 1.48 μm 

18% PCL 1 pixel = 0.588 μm 

 

Počet nalezených defektů n, průměrné plochy a obvody defektů PCL vlákenných 

vrstev v závislosti na koncentraci, jsou uvedeny v tab. 6. Histogramy četnosti velikostí 
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ploch defektů v závislosti na jednotlivých koncentracích PCL jsou uvedeny na obr. 39(a)-

(c), na obr. 40(a)-(c) jsou uvedeny histogramy četností obvodů defektů v závislosti 

na koncentraci PCL. V případě nanovlákenné vrstvy o koncentraci 20% PCL nebyly touto 

metodou nalezeny žádné defekty. 

 

Tab. 6 Průměrná plocha a obvod defektů v závislosti na koncentraci PCL. 

Koncentrace  n Celková plocha  

[µm
2
] 

Průměrná 

plocha [µm
2
] 

Std 

[µm
2
] 

Celkový 

obvod [µm] 

Průměrný 

obvod [µm] 

Std 

[µm] 

14 PCL [%] 96 8558.20 89.15 95.91 3749.40 39.06 32.02 

16 PCL [%] 98 94976.00 969.14 1525.20 13970.0 142.55 169.44 

18 PCL [%] 16  3626.50 226.66   247.59 945.83 59.11 28.06 
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(c) 

Obr. 39 Histogram četnosti velikostí ploch defektů na snímku (a) 14% PCL, (b) 16% PCL, 

(c) 18% PCL. 
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(c) 

Obr. 40 Histogram četnosti obvodů defektů ne snímku (a) 14% PCL, (b) 16% PCL, 

(c) 18% PCL. 

 

Ze zjištěných výsledků detekce defektů vyskytujících se v nanovlákenných 

vrstvách pomocí metody založené na korelaci vstupního obrazu a vytvořené šablony 

reprezentující tvar hledaných defektů lze říci, že je tato metoda vhodnější a přesnější než 

metoda detekce defektů založená na segmentaci defektů z obrazu uvedená v následující 

části práce. Na obr. 38(a) je jasně vidět, že byly nalezeny téměř všechny defekty 

vyskytující se v nanovlákenné vrstvě 14% PCL. Nevýhodou metody stanovení parametrů 

defektů pomocí korelační metody v programu MATLAB je nutnost přizpůsobení 

vyhledávacího vzoru obrazu velikosti defektů v obraze, při vyhledávání defektů 

nanovlákenné vrstvy 18% PCL musel být změněn poloměr kruhu reprezentující defekt 

na 25 pixelů, výsledky jsou však nepřesné, jako defekty byla detekována místa křížení 

vláken.  

Na základě provedené obrazové analýzy realizované v prostředí programu 

MATLAB vedoucí ke stanovení základních charakteristik defektů vyskytujících 

se v nanovlákenných strukturách PCL vrstev, můžeme tvrdit, že koncentrace polymerního 

roztoku souvisí s jejich výskytem. Ve vrstvě 14% PCL bylo pomocí korelační metody 
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srovnání se vzorem zjištěno 96 defektů, ve vrstvě 16% PCL se vyskytovalo 98 defektů, 

ve vrstvě 18% PCL pouze 16 defektů a ve vrstvě 20% PCL nebyly nalezeny žádné defekty.   

4.4.3 Detekce defektů korelační metodou v ImageJ 

V prostředí programu ImageJ je stejně jako prostředí programu MATLAB velmi 

kreativní. Uživatel není omezen pouze základní nabídkou programu, ale je mu poskytnuta 

možnost rozšíření programu ImageJ pomocí online dostupných pluginů. Stanovení 

parametrů defektů nanovlákenných vrstev bylo realizováno použitím volně dostupného 

rozšíření Create Template, které je možné stáhnout na oficiálním webu ImageJ.  

V prostředí programu ImageJ byl proces stanovení parametrů defektů vyskytujících 

se v nanovlákenných vrstvách demonstrován na vstupním monochromatickém snímku 

14% PCL o rozměrech 500x500 pixelů. V následujícím textu jsou popsány jednotlivé 

kroky analýzy obrazu vedoucí k detekci defektů v prostředí programu ImageJ. 

 

Image → Crop  

Prvním krokem, který následoval po načtení monochromatického snímku 14% PCL 

do prostředí programu ImageJ byl výřez obrazu pomocí nástroje Rectangular selections 

použitím příkazu Crop v nabídce Image, ořezaný snímek je uveden na obr. 41(a).  

  

Plugins → Create Template 

Vyhledání defektů v obraze bylo realizováno pomocí nainstalovaného pluginu 

Create Template. Metoda detekce objektů použitím tohoto pluginu vychází z hledání shody 

mezi vytvořenou předlohou a vstupním obrazem. Pro každý pixel vstupního obrazu je 

vypočten normalizovaný korelační koeficient mezi šablonou a obrazovými body 

ve zkoumaném obraze. Spuštěním pluginu Create Template dojde k zobrazení dialogového 

okna Create Kernel and do Correlation, dialogové okno je zobrazeno na obr. 41(b). 

 



Fakulta textilní Technické univerzity v Liberci 

Monitorování vnitřní struktury nanovlákenných vrstev pomocí obrazové analýzy 71 

  

(a) (b) 

Obr. 41 Vstupní monochromatický snímek 14% PCL nanovlákenné vrstvy (a), dialogové 

okno Create Kernel and do Correlation (b). 

 

Nabídka dialogového okna Create Kernel and do Correlation se skládá z posloupných 

kroků vedoucích k detekci objektů na základě vytvořené předlohy. Mezi nabídku tohoto 

dialogového okna patří  

 Create Disk Template button, 

 Inverty template button, 

 Crop Template from Image button, 

 Load Template from File button,  

 Perform Statistical Correlation,  

 Set threshold and get particle analyzer results. 

Plugins → Create Template → Create Disk Template button  

Použitím nástroje Create Template button je možné vytvořit kruhovou šablonu 

představující hledané objekty o  libovolném poloměru. Vytvořená šablona je uvedeny 

na obr. 42(a). Použitím nástroje Inverty template button je vytvořená 

šablona transformována na „negativ“. Negativní obraz šablony je uveden na obr. 42(b).  

 

 

 

(a) (b) 

Obr. 42 Vytvořená vyhledávací šablona (a), negativní obraz šablony (b). 

 

Tento způsob tvorby šablony nebyl v práci použit vzhledem k absenci možnosti 

nastavení intenzity šedi vyhledávací šablony dle defektů vyskytujících 
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se v nanovlákenných vrstvách. Tvorbu šablony pomocí nástroje Create Template button je 

možné doporučit pro detekci kruhových objektů z binárních obrazů. 

 

Plugins → Create Template → Crop Template from Image button 

Způsob tvorby šablony, který byl v práci použit je vytvoření šablony 

prostřednictvím nabídky Crop Template from Image button, kdy je šablona vyřezána přímo 

ze vstupního monochromatického obrazu. Prvním krokem je označení místa – defektu ve 

vstupním monochromatickém obraze, který má být považován za srovnávací šablonu 

pomocí nástroje Rectangular nacházejícího se v hlavní nabídce. Označený defekt, který 

byl považován za srovnávací šablonu v případě detekce defektů nanovlákenné vrstvy 14% 

PCL je uveden na obr. 43(a). Kliknutím na nástroj Crop Template from Image button dojde 

k vyřezání šablony ze vstupního obrazu, vyřezaná šablona je uvedena na obr. 43(b). 

Defekt, na základě kterého byla vytvořena šablona pro detekci defektů ve vrstvě 16% PCL 

je vyznačen žlutě na obr. 43(c), defekt ze kterého vychází šablona pro detekci objektů ve 

vrstvě 18% PCL je vyznačen na obr. 43(d). 

 

 

 

(a) (b) 

  

(c) (d) 

Obr. 43 Označený defekt ve vstupním monochromatickém snímku 14% PCL, na základě 

kterého došlo k vytvoření šablony (a) a odpovídající vytvořená šablona (b), vyznačený 

defekt ve vrstvě 16% PCL a 18% PCL na základě kterého byla vytvořena šablona (c), (d). 
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Plugins → Create Template → Perform Statistical Correlation  

Příkazem Perform Statistical Correlation byla spočtena korelace obrazu 

s  vytvořenou šablonou, korelovaný obraz je uveden na obr. 44(a). Intenzita šedi každého 

pixelu představuje korelaci obrazu a šablony, místa s nejvyšší korelací jsou nejsvětlejší.  

 

Plugins → Create Template → Set threshold and get particle analyzer results 

V posledním kroku došlo k transformaci korelovaného obrazu na binární 

a k detekci objektů v korelovaném obraze. V dialogovém okně Create Kernel and do 

Correlation je možné nastavit prahovou hodnotu v intervalu od 0 do 1, používanou 

k převodu korelovaného obrazu na binární. Pokud byla prahová hodnota nastavena stejně 

jako v prostředí programu MATLAB na 0.6, v korelovaném obraze byl po potlačení 

vyhodnocení objektů menších než 30 pixelů nalezen pouze jeden defekt, který je 

na obr. 44(b) ohraničen zeleným rámečkem.  

 

  

 (a) (b) 

Obr. 44 Korelovaný obraz (a), ohraničený detekovaných defekt (b). 

 

Z tohoto důvodu bylo nutné na základě subjektivního hodnocení upravit prahovou 

hodnotu, prahová hodnota byla nastavena na 0.2. Nalezené defekty po upravení prahové 

hodnoty jsou znázorněny na obr. 45(a),(b).  
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(a) (b) 

Obr. 45 Nalezené objekty v korelovaném obraze připravené k vyhodnocení parametrů 

defektů (a) a (b). 

 

Vyznačení nalezených defektů ve vstupním monochromatickém snímku 14% PCL 

nanovlákenné vrstvy pomocí zelených čtverců je zobrazeno na obr. 46(a),(b). Z těchto 

obrázků je patrné, že byly nalezeny téměř všechny defekty vyskytující se v nanovlákenné 

vrstvě.  

 

  

(a) (b) 

Obr. 46 Vyznačené nalazené defekty ve vstupním monochromatickém snímku 14% PCL 

nanovlákenné vrstvy (a), (b). 

 

Analyze → Set Scale  

Kalibrace musela být v tomto případě realizována až po aplikaci pluginu Create 

Template, pokud byla kalibrace provedena před aplikací pluginu, přídavný modul 

vykazoval chybu. Podrobný popis kalibrace je uveden v předešlé části práce zabývající 

se  určením parametrů mezivlákenných pórů.   
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Analyze→ Analyze Particles 

Analýza výsledků, která je pluginem nabízena je nedostačující, pomocí pluginu je 

možné vyhodnotit pouze vlastnost Area. Z tohoto důvodu budeme parametry nalezených 

defektů určovat pomocí nabídky Analyze → Analyze Particles.  

Vstupním obrazem pro stanovení základních parametrů je korelovaný obraz 

s červeně vyznačenými plochami defektů zobrazený na obr. 45(a). Mezi vlastnosti které 

byly vyhodnoceny, patří Area a Perimeter. Stejně jako v prostředí programu 

MATLAB bylo potlačeno vyhodnocení nekompletních objektů ležících na obrazové 

hranici a vyhodnocení parametrů objektů skládajících se z méně než 30 pixelů.  

Počet nalezených defektů n a výsledky stanovení parametrů defektů 

nanovlákenných vrstev jsou uvedeny v tabulce tab. 7. Na obr. 47(a)-(c), jsou zobrazeny 

histogramy ploch nalezených defektů v závislosti na koncentraci zvlákněného polymerního 

roztoku. Na obr. 48(a)-(c) jsou uvedeny histogramy obvodů nalezených defektů 

v závislosti na koncentraci zvlákňovaného roztoku.  

 

Tab. 7 Parametry defektů nanovlákenných vrstev.  

Koncentrace  n Průměrná plocha 

[µm
2
] 

Std 

[µm
2
] 

Průměrný obvod 

[µm] 

Std 

[µm] 

14 PCL [%] 98 45.09 24.44 27.07 8.95 

16 PCL [%] 111 612.98 602.54 127.99 91.54 

18 PCL [%] 10 45.38 44.08 29.34 17.66 
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(a) (b) 

 

(c) 

 

Obr. 47 Histogram ploch defektů nanovlákenné vrstvy 14% PCL (a), 16% PCL (b), 18% 

PCL (c). 

 

 

  

(a) (b) 

 

(c) 

Obr. 48 Histogram obvodů defektů nanovlákenné vrstvy 14% PCL (a), 16% PCL (b), 18% 

PCL (c). 
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Stanovení parametrů defektů v prostředí programu ImageJ pomocí korelační 

metody založené na srovnání se vzorem na základě pluginu Create Template je poměrně 

zdlouhavým procesem, který vykazuje odlišné výsledky stanovených charakteristik 

defektů, než tomu bylo při použití metody vyhledávání defektů pomocí korelace 

v programu MATLAB. (Shrnutí jednotlivých kroků je uvedeno v příloze 7). Z důvodu 

výrazně se lišících výsledků než jakých bylo dosaženo v prostředí programu MATLAB 

musely být při aplikaci metody vyhledávání defektů v programu ImageJ učiněny 

tyto rozdíly. 

 Při vyhodnocení snímku 14% PCL a 18% PCL byla provedena změna prahu 

při převodu korelovaného obrazu na binární, hodnota 0.6 byla nahrazena 

hodnotou 0.2. Při vyhodnocení snímku 16% PCL byla prahová hodnota 

rovna 0.1. 

 Srovnávací šablony byly vytvořeny výřezem defektu ze vstupního obrazu. 

Ze zjištěných výsledků je i tak patrné, že se výskyt defektů s rostoucí koncentrací 

roztoku PCL snižuje. Stejně jako v prostředí programu MATLAB nebyly ve vrstvě 

20% PCL detekovány žádné defekty. 

4.4.4 Detekce defektů založená na segmentaci v programu MATLAB 

Detekci objektů je v prostředí programu MATLAB možné realizovat i jednodušším 

způsobem, než korelační metodou. Pomocí vhodně zvoleného prahu aplikovaného 

na vstupní monochromatický je možné získat binární obraz, ve kterém budou ponechány 

především objekty zájmu, v našem případě defekty kulovitého tvaru.  

Postup získání informací o objektech ze vstupního obrazu je demonstrován 

na snímku 14% PCL v rozlišení 512x512 pixelů. Vstupní obraz obr. 49(a) byl pomocí 

víceúrovňového prahování převeden na binární. Práh byl zvolen jako interval, rozsah 

intervalu byl určen na základě informací o hodnotě úrovně šedi defektů tj. od 155 do 185. 

Ukázka výsledného binárního obrazu je na obr. 49(b). Ve vzniklém binárním obraze 

nebyly po prahování viditelné pouze defekty, ale byly zobrazeny i zbytky vláken, které 

tvořily nový nežádaný šum. Vlákna v binárním obraze se jeví jako objekty o malém počtu 

pixelů. Z obrazu byly odstraněny všechny objekty menší než 100 pixelů obr. 49(c). Dále 

došlo k potlačení objektů, které leží na okraji obrazu, ukázka obrazu je uvedena na 

obr. 49(d).  
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(a) (b) 

  

(c) (d) 

Obr. 49 Vstupní monochromatický obraz 14% PCL (a), binární obraz (b), obraz 

po odstranění malých objektů (c), obraz s potlačenými objekty ležící na hranici obrazu (d).  

 

Takto připravený obraz není dostačující k získání vypovídajících informací 

o objektech, objekty nejsou kompaktní, v jejich struktuře se nacházejí černé pixely - díry. 

Z tohoto důvodu je nutné zahrnout do postupu i některé morfologické operace. První 

operací bylo vyplnění děr (černých míst) objektů obr. 49(a). V dalším kroku došlo 

k morfologickému uzavření objektů, za použití vytvořeného strukturního prvku 

zobrazeného na obr. 49(b), kterým je matice o velikosti 3x3. Tímto krokem došlo 

k vyplnění zbývajících mezer objektů a k vyhlazení jejich vnějších hran, takto upravený 

obraz je uveden na obr. 49(c).  
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(a) (b) (c) 

Obr. 49 Obraz před vyplněním děr (a), strukturní prvek (b), obraz po vyplnění děr 

strukturním prvkem (c). 

 

Grafické znázornění nalezených objektů je uvedeno na obr. 50(a),(b), každému 

objektu je přiřazena jiná barva. Z tohoto obrazu je možné získat číselné charakteristiky 

o nalezených objektech představujících defekty. 

 

 

 

 

 

 

 

 

 

(a) 

 

 

 

 

 

 

 

 

(b) 

Obr. 50 Zobrazení nalezených objektů v RGB (a), (b).  

 

Pro lepší orientaci a vyhodnocení přesnosti hledání defektů bylo použito grafického 

znázornění obvodů defektů v původním šedotónovém obraze, vyznačené nalezené objekty 

v původním obraze jsou zobrazeny na obr. 51(a),(b).  
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(a) (b) 

Obr. 51 Grafické znázornění obvodů defektů v původním šedotónovém obraze (a), (b). 

 

Uvedený způsob detekce defektů v prostředí programu MATLAB založený 

na segmentaci obrazu lze zjednodušeně zapsat dle níže uvedeného algoritmu skládajícího 

se z několika kroků. K jednotlivým krokům algoritmu jsou přiřazeny zaimplementované 

funkce (přesně definované v příloze 1), které je možné aplikovat v prostředí programu 

MATLAB. Vytvořený skript je přiložen k nahlédnutí v příloze 4. 

 Převeď vstupní obraz na binární, použij operaci prahování, hodnotu prahu nalezni 

experimentálně jako interval. Velikost intervalu odvoď od hodnot šedi defektů 

v obraze.  

 Uprav obraz použitím morfologických operací, odstraň malé objekty, vyplň díry 

v objektech, uzavři a vyhlaď hranice objektů, potlač objekty ležící na hranici 

obrazu (bwareaopen.m, imclearborder.m, imfill.m, imclose.m). 

 Vytvoř vstupní matici pro získání informací o jednotlivých regionech 

(bwlabel.m). 

 Proveď kalibraci, převeď pixely jednotlivých regionů na mikrometry. 

 Vypočítej parametry jednotlivých regionů, vyhodnoť parametry defektů celého 

obrazu (regionprops.m).  

 Vykresli obvody nalezených defektů do vstupního obrazu (bwmorph.m). 

4.4.5 Vyhodnocení výsledků detekce defektů segmentací v MATLABU 

Vlastnosti pro jednotlivé objekty byly opět určeny použitím zaimplementované 

funkce regionprops.m aplikované na vstupní matici popisující velikost jednotlivých 

objektů. K zjištění parametrů defektů byla opět použita vlastnost určující plochu Area 
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a vlastnost udávající obvod Perimeter. Kalibrace výsledků měření byla provedena dle 

dříve uvedené tab. 5. Počet nalezených defektů n, průměrné plochy a obvody defektů 

v závislosti na koncentraci zvlákněného PCL, jsou uvedeny v tab. 8.  Histogramy četností 

velikostí ploch defektů v závislosti na jednotlivých koncentracích PCL jsou uvedeny 

na obr. 52(a)-(c). 

 

Tab. 8 průměrné plochy a obvody defektů v závislosti na koncentraci PCL. 

Koncentrace n Celková plocha  

[µm
2
] 

Průměrná 

plocha [µm
2
] 

Std 

[µm
2
] 

Celkový 

obvod [µm] 

Průměrný 

obvod [µm] 

Std 

[µm] 

14 PCL [%] 33 2868.20 86.91 38.37 1600.7 48.51 9.89 

16 PCL [%] 20 1201.20 600.61 306.39 2687.6 134.38 43.67 

18 PCL [%] 7 1504.50 214.93 168.60 751.42 107.35 39.27 
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(c) 

Obr. 52 Histogram ploch nalezených defektů ve vrstvě 14% PCL (a), 16% PCL (b), 18% 

PCL (c). 

 

Na obr. 53(a)-(c), jsou uvedeny histogramy četností obvodů defektů v závislosti 

na koncentraci PCL. 
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(c) 

Obr. 53 Histogram obvodů nalezených defektů ve vrstvě14% PCL (a), 16% PCL (b), 18% 

PCL (c). 

 

Detekce defektů nanovlákenných vrstev založená na segmentaci obrazu je snadným 

a efektivním způsobem stanovení jejich parametrů v programu MATLAB. Na rozdíl 

od detekce založené na korelaci obrazu se vzorem bylo touto metodou nalezeno podstatně 

méně defektů. Tato navržená metoda je méně přesná, nebyly detekovány malé objekty. 

Nevýhodou je nutnost změny parametrů segmentace v obraze vzhledem k úrovni šedi 

hledaných defektů.  

4.4.6 Detekce defektů založená na segmentaci v programu ImageJ  

Stejně jako je tomu v programu MATLAB, i v programu ImageJ je možné 

identifikovat defekty nalézající se ve vytvořených nanovlákenných vrstvách několika 

způsoby. První způsob, který byl v této práci demonstrován, vychází z hledání shody 

obrazu s definovanou šablonou pomocí korelace. Tento způsob je však složitý, časově 

náročnější a k jeho realizaci je zapotřebí instalace rozšíření - pluginu.  

Snadnou alternativou k dříve uvedenému způsobu detekce defektů je metoda 

založená na segmentaci obrazu. Podstatou této metody je co nejlépe vyčlenit z obrazu 

objekty zájmu – defekty a stanovit jejich parametry. V následujícím textu je uveden postup 
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stanovení základních strukturních parametrů defektů nanovlákenných vrstev na základě 

segmentace obrazu v prostředí programu ImageJ. Některé nástroje, které byly v prostředí 

ImageJ použity byly v práci podrobně popsány dříve, v následujícím textu bude tedy 

uveden jen jejich stručný popis.   

 

Analyze → Set Scale  

V prvním kroku byl do pracovního prostředí programu ImageJ načten 

monochromatický snímek 14% PCL. Pomocí nástroje Set Scale nabídky Analyze byla 

provedena kalibrace. Vyhodnocení výsledků bude tedy vygenerováno v reálných 

jednotkách, ne v pixelech.  

 

Image → Crop  

Dalším krokem, který následoval, byl výřez obrazu. Vstupní snímek byl pomocí 

nástroje Rectangular selections označen a příkazem Crop v nabídce Image manuálně 

oříznut na velikost 512x512 pixelů, ořezaný monochromatický snímek je uveden 

na obr. 54(a).  

  

Image → Adjust → Treshold 

Transformace vstupního monochromatického obrazu na binární byla realizována 

prostřednictvím víceúrovňového prahování, prahový interval byl zvolen stejně jako 

v prostředí programu MATLAB v rozsahu od 155 do 185. K prahování došlo použitím 

příkazu Treshold, prahovací interval byl nastaven ručně v dialogovém okně Treshold 

na základě histogramu úrovně šedi. Jako objekty jsou chápany nulové (černé) pixely. 

Vzniklý binární obraz je uveden na obr. 54(b).   

 

Process → Binary → Fill Holes 

Pomocí příkazu Fill Holes nacházejícího se v nabídce Binary došlo k morfologické 

operaci vedoucí ke změně objektů, takzvanému zaplnění děr obr. 54(c).  

 

Process → Binary → Open 

Pomocí nástroje Open v nabídce Process → Binary došlo k odstranění malých pixelů 

z obrazu a vyhlazení objektů. Princip odstranění objektů složen ze dvou kroků, prvním 

krokem je eroze, druhým dilatace. Eroze odstraňuje pixely z hran objektů, dilatace naopak 
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k hranám objektů pixely přidává.   Obraz se po odstranění malých objektů pomocí otevření 

je znázorněn na obr. 54(d). 

 

  

(a) (b) 

 

 

(c) (d) 

Obr. 54 Vstupní obraz nanovlákenné vrstvy 14% PCL (a), binární obraz (b), obraz po 

vyplnění děr (c), otevřený obraz (d).  

 

Analyze → Analyze Particles 

Pomocí příkazu Analyze Particles v nabídce Analyze  byly vyhodnoceny parametry 

objektů v binárním obraze. V dialogovém okně tohoto příkazu bylo nastaveno potlačení 

nekompletních objektů, dotýkajících se obrazové hranice. Dále bylo, jako v prostředí 

programu MATLAB potlačeno vyhodnocení objektů menších než 100 pixelů. Mezi 

vlastnosti, které byly vybrány v nabídce Analyze → Set Measurements a určeny 

k vyhodnocení patří Area a Perimeter. V tabulce tab. 9 jsou uvedeny výsledné hodnoty 

naměřených parametrů defektů nanovlákenných vrstev lišících se koncentrací.  
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Tab. 9 Výsledky stanovení parametrů defektů. 

Koncentrace n Celková plocha  

[µm
2
] 

Průměrná 

plocha [µm
2
] 

Std 

[µm
2
] 

Obvod 

[µm] 

STD 

[µm] 

14 PCL [%] 34 2755.28 81.04 40.03 36.95 9.26 

16 PCL [%] 21 12471.63 593.89 331.73 105.5 41.85 

18 PCL [%] 9 1669.56 185.51 180.30 69.74 37.76 

 

Na následujícím obrázku 55(a)-(c), jsou zobrazeny histogramy ploch nalezených 

defektů v závislosti na koncentraci zvlákněného roztoku PCL, na obr. 56(a)-(b) jsou 

zobrazeny histogramy četností obvodů defektů nalezených na monochromatických 

snímcích PCL nanovlákenných vrstev o různých koncentracích.  

 

 

  

(a) (b) 

 

(c) 

Obr. 55 Histogram četnosti ploch defektů nalezených na snímku 14% PCL (a), 16% PCL 

(b), 18% PCL (c). 
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(a) (b) 

 

(c) 

Obr. 56 Histogram četnosti obvodů defektů nalezených na snímku 14% PCL (a), 16% PCL 

(b), 18% PCL (c). 

 

Analýza obrazu vedoucí ke klasifikaci defektů v programu ImageJ založená 

na segmentaci obrazu je snadná a vykazuje podobné výsledky, jako tomu bylo u metody 

založené na stejném principu realizované v prostředí programu MATLAB. U této metody 

musela být učiněna jedna odchylka od postupu uvedeného v prostředí programu 

MATLAB, při vyhodnocení snímku nanovlákenné vrstvy o koncentraci 18% PCL byly 

potlačeny všechny objekty skládající se z méně než 150 pixelů, důvodem byla 

nedostatečná segmentace obrazu. 

4.5 Zhodnocení stanovení parametrů defektů  

Stanovení parametrů defektů vyskytujících se v nanovlákenných vrstvách bylo 

realizováno prostřednictvím dvou metod aplikovaných v různých programech, v programu 

MATLAB a programu ImageJ.  

První testovaná metoda byla založena na hledání shody obrazu a vytvořené šablony 

reprezentující vzorový tvar defektu vycházející ze vzájemné korelace, výsledné 

charakteristiky zjištěné v prostředí programu MATLAB byly podobné s charakteristikami 

určenými v prostředí programu ImageJ. Pomocí této metody byly v prostředí obou 

programů detekovány téměř všechny defekty vyskytující se ve zkoumaných 

nanovlákenných vrstvách. Druhá metoda vycházela ze segmentace obrazu, charakteristiky 
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zjištěné touto metodou byly v obou případech použitého vyhodnocovacího programu 

stejné. Metoda založená na segmentaci obrazu není příliš přesná, pomocí této metodiky 

bylo detekováno malé množství defektů obsažených v nanovlákenných vrstvách.  

Na základě stanovených výsledků obou metod aplikovaných v programu MATLAB 

i programu ImageJ lze konstatovat, že koncentrace PCL ovlivňuje výskyt defektů 

ve zkoumaných nanovlákenných vrstvách. Nejvíce defektů bylo ve všech případech 

detekováno ve vrstvě o koncentraci 14% PCL, ve vrstvě 20% PCL se již žádné defekty 

nevyskytovaly. 

Detekce defektů kulovitého tvaru byla zkoušena i na základě Houghovy 

transformace, jejímž cílem je vyhledávání definovaného množství objektů dle popsaného 

tvaru ve zkoumaném obraze. Tato metoda je nejčastěji používána ke hledání ne příliš 

složitých tvarů, tj. objektů, jejichž tvar lze popsat jednoduchými křivkami, těmi jsou 

přímky, trojúhelníky nebo kružnice. Houghova transformace je nejlépe aplikovatelná 

na binární obraz. Vstupem pro detekci defektů pomocí Houghovy transformace byly 

monochromatické snímky PCL nanovlákenných vrstev lišící se koncentrací. Binární obraz 

byl získán stejně jako u ostatních metod detekce defektů pomocí víceúrovňového 

prahování, dále následovalo několik morfologických operací majících za cíl oddělení 

objektů zájmu od pozadí. V dalších krocích byla provedena detekce hran objektů 

a použitím vytvořené funkce pro Houghovu transformaci byly nalezeny vrcholy 

jednotlivých objektů, které byly středem pro vykreslení kružnice definující velikost 

nalezeného defektu. Detekované hrany defektů jsou znázorněny na obr. 57(a), vykreslené 

kružnice reprezentující tvar defektů jsou znázorněny na obr. 57(b). Aplikace této metody 

se neosvědčila, metoda je špatně aplikovatelná, velkým nedostatkem je nutnost definování 

množství objektů, které mají být nalezeny a nutnost definice rozsahu poloměrů defektů.  

 

  

(a) (b) 

Obr. 57 Nalezené hrany defektů vyskytujících se v nanovlákenné vrstvě (a), vykreslené 

kružnice reprezentující nalezené defekty (b). 
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4.6 Extrakce orientace nanovláken   

Zjišťování orientace vláken je dle [26] experimentální grafickou metodou, jejímž 

výsledkem je sestrojená směrová růžice. Z tohoto důvodu je vhodné manuální grafickou 

metodu nahradit technikou založenou na obrazové analýze.  

Podstata určení orientace vláken vlákenné struktury vychází z vlastností Fourierova 

spektra. Směr vláken je určen na základě rozložení vysokých hodnot frekvenčních 

komponent odpovídajících převládajícím směrům prostorové oblasti. Pokud se jedná 

o náhodně orientovanou strukturu, obraz ve frekvenční oblasti má kruhovitý tvar, tzn., 

vlákna jsou orientována ve všech směrech. Frekvenční oblast snímku vlákenné vrstvy 

ve které jsou všechna vlákna orientována v jednom směru, se vyznačuje elipsovitým 

tvarem. Čím více jsou vlákna orientovaná, tím je pomyslná elipsa protáhlejší. Fourierova 

transformace dvojrozměrného monochromatického obrazu f(x,y) je v práci [7] vyjádřena 

vztahem 

 

 

(8) 

 

kde u,v jsou frekvenční proměnné, u nabývá hodnot u=0, 1, 2,… m-1 a v nabývá 

hodnot v=0, 1, 2,… n-1, a  x, y jsou prostorové souřadnice,  x nabývá hodnot x=0, 1, 2,… 

m-1, y nabývá hodnot y=0, 1, 2, …, n – 1 a f(x, y) je úroveň šedi obrazových bodů 

o rozměrech mxn. Počátek frekvenční oblasti je vyjádřen jako F(0,0). Pokud je f(x,y) reálná 

funkce, tak je její transformace komplexní. Pro analýzu vizuální transformace je vypočteno 

její spektrum |F(u,v)|, výkonové spektrum je pak vyjádřeno jako P(u,v) = | F(u,v)|
2
. 

Z důvodu vizualizace je dynamický rozsah koeficientů zredukován pomocí logaritmické 

transformace Q(u,v)=log(1 + P(u,v)). Metoda pro odhad směrového rozložení je například 

uvedena v práci [7], kde jsou koeficienty Fourierova spektra vyneseny do polárního 

diagramu.  

Další metoda používaná pro odhad směrového uspořádání je založena na 

transformaci výkonového spektra na binární obraz prostřednictvím prahování. Prahováním 

dojde k selekci významných frekvenčních komponent, jejichž rozložení odpovídá 

převažujícím směrům. Pro jejich jednoduchý popis se využívá obrazových momentů. 

Obecný moment řádu (p+q) obrazové funkce f(x,y) je dán vztahem  

 

 

(9) 
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Charakteristiky objektů v obraze jsou určeny hodnotami obecných momentů, 

například moment m00 vyjadřuje plochu objektu v binárním obraze. Centrální momenty 

prvního a druhého řádu jsou vhodné pro popis orientace objektů v obraze. Orientace 

objektu nebo oblasti zájmu mezi osou x a hlavní poloosou elipsy je dle [7] dána vztahem  

 

 

(10) 

 

 Orientace vlákenné struktury se shoduje s převládajícími směry jednotlivých 

objektů v binárním obraze. Aplikace určení orientace vláken v prostředí programu 

MATLAB a programu ImageJ je uvedena v následující části práce.   

Navržená metoda stanovení orientace vláken v nanovlákenné vrstvě použitím dvou 

programových prostředí byla aplikována na čtyřech monochromatických snímcích 

nanovlákenných vrstev. Nanovlákenné vrstvy zhotovené pro demonstraci obrazové 

analýzy vedoucí ke zjištění orientace vláken se vzájemně liší koncentrací PCL, polymer 

určený ke zvláknění byl o koncentraci 14%, 16%, 18% a 20% PCL. Jednotlivé 

monochromatické snímky určené k vyhodnocení směrovosti jsou uvedeny na obr. 58(a)-

(d).  

 

  

(a) (b) 

  

(c) (d) 

Obr. 58 Vstupní monochromatický snímek nanovlákenné vrstvy 14% PCL (a), 16% PCL 

(b), 18% PCL (c), 20% PCL (d). 
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4.6.1 Stanovení orientace vláken v programu MATLAB 

Orientace vlákenných struktur je zpravidla určena globálně, z celého snímku 

nanovlákenné struktury. Vzhledem k rozmanitosti nanovlákenné vrstvy je požadovaná 

podrobnější analýza struktury, proto byl tento způsob upraven. Vstupní obraz byl rozdělen 

do mnoha podobrazů, kterým byla stanovena vlastní orientace.  

Pro demonstraci metody stanovení orientace vláken byl zvolen monochromatický 

snímek nanovlákenné vrstvy o koncentraci 18% PCL. Vstupní snímek na obr. 59(a) má 

velikost 500x500 pixelů. Prvním krokem, který následoval po načtení snímku do prostředí 

programu MATLAB bylo zvýšení kontrastu obrazu. Na obr. 59(b) je znázorněn snímek 

18% PCL po změně kontrastu.  

 

  

(a) (b) 

Obr. 59 Vstupní obraz nanovlákenné vrstvy 18% PCL (a), obraz se zvýšeným kontrastem 

(b). 

 

Jak bylo řečeno dříve, stanovení orientace nanovlákenných vrstev nelze přesně 

kvalifikovat na základě Fourierovy transformace aplikované na obraz v celém jeho 

rozsahu. Pro přesné určení směru nanovláken bylo nutné rozdělit vstupní obraz na mnoho 

podobrazů. Rozdělení vstupního snímku bylo realizováno prostřednictvím definovaného 

okna čtvercového tvaru o rozměrech 10x10 pixelů nebo 20x20 pixelů.  V každém 

vytvořeném podokně monochromatického snímku byla provedena Fourierova 

transformace. Převládající orientace vláken v jednotlivých podoknech je graficky 

znázorněna pomocí směrového vektoru.  

Znázornění směrových vektorů je limitováno splněním podmínky, že poměr hlavní 

a vedlejší poloosy elipsy definující tvar vysokých hodnot frekvenční oblasti jednotlivých 

podobrazů je větší než 2. Pokud je poměr hlavní a vedlejší osy elipsy rovnen 1, jedná se 
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o náhodnou strukturu, vysoké hodnoty komponent frekvenční oblasti tvoří kruh, čím je 

vzájemný poměr os vyšší, tím je elipsa monitorující tvar protáhlejší.  Na obr. 60(a) jsou 

červenou barvou znázorněny směrové vektory jednotlivých podoken obrazu o velikosti 

20x20 pixelů. Znázornění směrových vektorů v původním šedotónovém obraze je uvedeno 

na obr. 60(b).  
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(a) (b) 

Obr. 60 Směrové vektory jednotlivých podoken obrazu o rozměrech 20x20 pixelů (a), 

vykreslení směrových vektorů v původním obraze (b). 

 

Na obr. 61(a),(b) jsou červeně vykresleny směrové vektory obrazu určené pomocí 

podoken o velikosti 10x10 pixelů. Orientace směrových vektorů je na obrázcích obr. 60(a) 

a 61(a) pro větší přehlednost interpretována pomocí šedotónové škály.  
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(a) (b) 

Obr. 61 Směrové vektory jednotlivých podoken obrazu o rozměrech 10x10 pixelů (a), 

vykreslení směrových vektorů v původním obraze (b). 
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Na základě nalezených směrových vektorů bylo možné sestrojit histogram 

a jádrový odhad hustoty distribuce směrů. Dále byl sestrojen polární diagram, ze kterého je 

na první pohled viditelné směrové uspořádání nanovlákenné vrstvy. Na obrázku obr. 62(a) 

je znázorněn histogram a jádrový odhad hustoty distribuce směrů, na obr. 62(b) polární 

diagram směrů vrstvy 18% PCL za použití podokna o velikosti 20x20 pixelů.  

 

-80 -60 -40 -20 0 20 40 60 80
0

0.002

0.004

0.006

0.008

0.01

0.012

0.014

0.016

0.018

Histogram a jádrový odhad hustoty distribuce směrů

úhel [deg]  

  0.5

  1

  1.5

30

210

60

240

90

270

120

300

150

330

180 0

 

(a) (b) 

Obr. 62 Histogram a jádrový odhad distribuce směrů vyhledaných oknem 20x20 pixelů (a), 

polární diagram směrů vyhledaných oknem 20x20 pixelů (b).  

 

Na obrázku obr. 63(a) je uveden histogram a jádrový odhad hustoty distribuce 

směrů ve vrstvě 18% PCL, na obr. 63(b) polární diagram směrů nanovlákenné vrstvy 18% 

PCL za použití podokna o velikosti 10x10 pixelů. Na základě uvedených obrázků lze 

stejně jako v práci [7] konstatovat, že velikost vyhledávacího okna má vliv na přesnost 

výsledků, čím je velikost podokna větší, tím se stávají výsledky nepřesnějšími.  
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(a) (b) 

Obr. 63 Histogram a jádrový odhad distribuce směrů vyhledaných oknem 10x10 pixelů (a), 

polární diagram směrů vyhledaných oknem 10x10 pixelů (b).  
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Uvedený postup stanovení orientace vláken lze zapsat dle následujícího algoritmu 

skládajícího se z několika posloupných kroků. K jednotlivým krokům jsou přiřazeny 

zaimplementované funkce prostředí programu MATLAB určené k jejich realizaci.  Skript 

vytvořený na základě algoritmu je přiložen v příloze 5. 

 Uprav kontrast vstupního snímku (imadjust.m). 

- Definuj velikost okna ohraničující oblasti, pro které má být určena orientace. 

 Pro jednotlivé podobrazy proveď  2D Fourierovu transformaci (fft2.m).  

 Přiřaď počátek oblasti frekvenčních polí do středu podobrazu (fftshift.m).   

 Zredukuj dynamický rozsah koeficientů logaritmickou transformací. 

 Najdi hlavní a vedlejší osu elipsy definující tvar frekvenční oblasti. 

 Definuj nejnižší přijatelný poměr hlavní a vedlejší osy elipsy (regionprops.m). 

 Přiřaď směrový vektor jednotlivým frekvenčním oblastem. 

 Vytvoř histogram distribuce směrů vláken a proveď jádrový odhad hustoty.  

 Vytvoř polární diagram orientace vláken. 

4.6.2 Výsledky stanovení orientace nanovláken v MATLABU 

Velikost snímků 14% PCL a 16% PCL je 1000x1000 pixelů, vzhledem ke složitosti 

aplikovaného algoritmu vedoucího ke zjištění orientace vláken nebylo možné na těchto 

snímcích aplikovat Fourierovu transformaci pro obraz rozdělený podokny o velikosti 

10x10 pixelů, zpracování velkého množství dat bylo v prostředí programu MATLAB 

výpočetně náročné. Z tohoto důvodu bylo pro snímky 14% PCL a 16% PCL zvoleno 

podokno o velikosti 20x20 pixelů.   Pro snímky 18% PCL a 20% PCL bylo možné použít 

podokno velikosti 10x10 pixelů, vzhledem k tomu, že dosahují velikosti 500x500 pixelů 

a program MATLAB byl schopen vyhodnotit informace získané obrazovou analýzou. 

 Ve všech případech bylo vykreslení směrových vektorů jednotlivých podoken 

snímků limitováno splněním podmínky, že poměr hlavní a vedlejší osy elipsy oblasti 

zájmu je větší než 2. 

Vlákna zobrazená na snímku 14% PCL vykazují na základě histogramu distribuce 

směrů a jádrovém odhadu hustoty na obr. 64(b) nejvyšší orientaci kolem 80°, na základě 

polárního diagramu obr. 64(c) lze konstatovat, že ve vrstvě převažuje horizontální směr 

vláken. Směrové vektory jednotlivých podoken zkoumaného snímku jsou zobrazeny 

na obr. 64(a). 
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(a) (b) (c) 

Obr. 64 Směrové vektoty jednotlivých podoken vstupního obrazu vláken 14% PCL (a), 

odpovídající histogram a jádrový odhad hustoty distribuce směrů (b), polární diagram (c). 

 

Na obr. 65(a) jsou zobrazeny nalezené směrové vektory odpovídající orientaci 

vláken v podoknech monochromatického snímku 16% PCL. Ze snímku 16% PCL lze 

na základě histogramu distribuce směrů a jádrového odhadu hustoty obr. 65(b) konstatovat, 

že nejvíce vláken má orientaci okolo -40° a 50°. Z polárního diagramu uvedeného na obr. 

65(c) vyplývá, že jsou vlákna orientována v horizontálním i vertikálním směru, orientace 

ve vertikálním směru lehce převažuje.  
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(a) (b) (c) 

Obr. 65 Směrové vektory jednotlivých podoken vstupního obrazu vrstvy 16% PCL (a), 

histogram a jádrový odhad hustoty distribuce směrů (b), polární diagram (c). 

 

Na základě histogramu distribuce směrů a jádrového odhadu hustoty zobrazeného 

na obr. 66(b) snímku 18% PCL lze říci, že je nejvíce vláken orientováno ve směru 40°. 

Z polárního diagramu obr. 66(c) vyplývá, že jsou vlákna orientována převážně 

ve vertikálním směru s 20° vychýlením vlevo.  Směrové vektory stanovené pro jednotlivá 

podokna vstupního obrazu jsou uvedeny na obr. 66(a). 
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(a) (b) (c) 

Obr. 66 Směrové vektory jednotlivých podoken (a), histogram a jádrový odhad hustoty 

distribuce směrů vláken 18% PCL (b), polární diagram směrů (c). 

 

 Na obr. 67(a) jsou zobrazeny nalezené směrové vektory odpovídající orientaci 

vláken v podoknech monochromatického snímku 20% PCL. Orientace vláken ve vrstvě 

20% PCL je téměř náhodná, toto tvrzení lze potvrdit na základě polárního diagramu 

uvedeného na obr. 67(c). Na obr. 67(b) je zobrazen histogram a jádrový odhad hustoty 

distribuce směrů. 
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(a) (b) (c) 

Obr. 67 Směrové vektory nalazené pro jednotlivá podokna obrazu vrstvy 20% PCL (a), 

histogram a jádrový odhad hustoty distribuce směrů (b), polární diagram (c). 

 

Na základě provedené obrazové analýzy byla identifikována orientace jednotlivých 

snímků nanovlákenných vrstev lišících se koncentrací PCL. Vzhledem k výsledkům 

obrazové analýzy lze říci, že je orientace vláken na jednotlivých zkoumaných snímcích 

rozdílná. Otázkou zůstává, jestli je orientace vláken ovlivněna koncentrací zvlákňovacího 

polymeru, nebo se jedná o náhodný jev.  
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4.6.3 Stanovení orientace nanovláken v ImageJ – OrientationJ 

Určení orientace vláken v prostředí programu ImageJ je složitý proces. Stejně jako 

tomu bylo u vyhledání defektů pomocí srovnání se vzorem i k určení orientace jsou online 

dostupné pluginy. Prvním z nalezených pluginů je OrientationJ, plugin se po instalaci 

zobrazí v Plugins → OrientationJ a uživateli nabízí čtyři funkce zabývající se směrovostí 

vláken. Mezi nabízené funkce tohoto pluginu patří 

 Analysis, 

 Distribution, 

 Corner Harris, 

 Measure. 

Analysis 

Vizuální režim Analysis zobrazí pomocí barevných map orientaci, sytost koherence 

a jas vstupního obrazu.  

 

Distribution 

Pomocí funkce Distribution je možné vyhodnotit orientaci pro každý pixel obrazu, 

výstupem je histogram distribuce směrů. 

 

Corner Harris 

Funkce Corner Harris slouží k hledání objektových rohů v obraze. 

 

Measure 

Díky této funkci je možné manuálně určit orientaci vláken pro jednotlivě vybrané 

oblasti vstupního obrazu. Na obrázku obr. 68(a) je zobrazen snímek 18% PCL, na kterém 

byly aplikována ruční metoda stanovení orientace vláken. Pomocí myši byly označeny 

jednotlivé oblasti 1 až n, pro které byla díky kliknutí na Measure v dialogovém okně 

obr. 68(b), stanovena průměrná orientace vláken v podokně, dále došlo k vykreslení tvaru 

elipsy odpovídající tvaru do vstupního obrazu. Tato metoda je zdlouhavá a náročná 

vzhledem k subjektivnímu hodnocení.  

Manuální metoda vyhodnocení směru vláken nebyla v práci použita, 

pro vyhodnocení orientace v programu ImageJ byly hledány automatické metody.  
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(a) (b) 

Obr. 68 Snímek 18% PCL s vykreslenými elipsami reprezentujícími směry vybraných 

oblastí (a), dialogové okno OrientationJ Measure s výsledky (b).  

 

Orientace vláken byla v prostředí programu ImageJ stanovena pro stejné 

monochromatické snímky jako tomu bylo v prostředí programu MATLAB. 

Mezi zkoumané snímky patří snímek 14%, 16%, 18% a 20% PCL. Jednotlivé kroky 

vedoucí k určení směrovosti v prostředí programu ImageJ jsou popsány v následujícím 

textu. Jako demonstrativní obraz byl pro realizaci navržené metodiky zvolen 

monochromatický snímek nanovlákenné vrstvy 18% PCL.  

 

Image → Crop  

Prvním krokem, který následoval po načtení monochromatického obrazu 18% PCL 

do prostředí programu ImageJ bylo ořezání snímku. Vstupní snímek byl pomocí nástroje 

Rectangular selections označen a příkazem Crop v nabídce Image manuálně oříznut 

na velikost 500x500 pixelů, ořezaný snímek je uveden na obr. 69(a).  

 

Process → Sharpen 

V následujícím kroku došlo prostřednictvím příkazu Sharpen v nabídce Process 

k automatickému zvýšení kontrastu obrazu a zvýraznění detailů v obraze. Princip filtru 

Sharpen je založen na nahrazení každého obrazového pixelu váženým průměrem z jeho 

okolí o velikosti 3x3 pixely.  Schéma filtru Sharpen je zobrazeno na obr. (b), obraz 

se zvýšeným kontrastem je uveden na obr. 69(c). 
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(a) (b) (c) 

Obr. 69 Vstupní obraz nanovlákenné vrstvy 18% PCL (a), schéma filtru Sharpen (b), obraz 

po zvýšení kontrastu (c). 

 

Plugins → OrientationJ → Distribution 

Zvolením funkce Distribution v nabídce Plugins → OrientationJ došlo k zobrazení 

dialogového okna OrientationJ Distribution. V tomto dialogovém okně je možné zvolit 

velikost podokna, pro které má být stanoven směr (Structure Tensor) a gradient, 

dle kterého dojde ke klasifikaci. V našem případě byla velikost podokna zvolena 

10x10 pixelů a vyhodnocení bylo realizováno použitím Fourierova gradientu.  

Výstupem vyhodnocení orientace pomocí Distribution je histogram distribuce 

orientace uvedený na obr. 70. Úhly jsou vykazovány ve společném matematickém 

vyjádření, 0° značí východní směr orientace, přibývání stupňů je realizováno proti směru 

hodinových ručiček.  

 

 

(a) 

Obr. 70 Histogram distribuce orientace vláken ve vrstvě 18% PCL. 

 

Místa vykazující stejnou orientaci jsou ve vstupním obraze označena pomocí RGB 

spektra uvedeného na obr. 71(a). Aplikace RGB mapy na vstupní obraz vedoucí k označení 
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oblastí vykazujících stejnou orientaci shodným odstínem ze spektra je uvedena na obr. 

71(b). 

  

(b) (c) 

Obr. 71 RGB spektrum sloužící ke grafické interpretaci orientace (a), mapa směrů vláken 

aplikovaná na vstupní obraz (b). 

 

Analýza zaměřená na orientaci vláken byla v prostředí programu ImageJ stanovena 

pro stejné snímky jako tomu bylo v prostředí programu MATLAB. Zkoumané snímky 

14% PCL, 16% PCL, 18% PCL a 20% PCL jsou uveden dříve na obr. 58(a)-(d). Postup 

stanovení orientace vláken v prostředí programu ImageJ je založen na volně dostupném 

pluginu OrientationJ. Díky aplikaci tohoto pluginu byly stanoveny následující závěry 

vyhodnocení orientace vláken jednotlivých nanovlákenných vrstev. 

 Na obrázcích obr. 72(a),(c),(e),(g), jsou uvedeny histogramy distribuce směrů 

vláken 14% PCL, 16% PCL, 18% PCL a 20% PCL. Na obrázcích obr. 72(b),(d),(f),(h), 

jsou do vstupního monochromatického snímku vykresleny RGB mapy, ve kterých jsou 

pomocí barev znázorněny plochy vrstvy vykazující stejnou orientaci. Z uvedených 

histogramů je viditelné, že se orientace vláken vzhledem ke zvolenému snímku 

nanovlákenné vrstvy liší.  

Orientace vrstvy 14% PCL se na základě obr. 72(a) jeví jako horizontální, 

z histogramu je patrné, že nejvíce vláken vykazuje směr 0°. Nanovlákenná vrstva 

16% PCL vykazuje na základě obr. 72(c) stejně jako v předešlém případě převážně 

vertikální směr, ale je zde vyšší výskyt vláken orientovaných horizontálně. Orientace 

vláken 18% PCL je na základě histogramu uvedeného na obr. 72(e) převážně vertikální. 

Na rozdíl od ostatních vrstev, ze snímku vrstvy 20% PCL je patrné, že je orientace vláken 

náhodná, vlákna jsou dle histogramu uvedeného na obr. 72(g) orientované 

ve všech směrech.  
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(a) (b) 

 

 

(c) (d) 

 

 

(e) (f) 

 

 

(g) (h) 

Obr. 72 Histogram orientace a RGB mapa směrů vláken 14% PCL (a),(b), histogram 

orientace a RGB mapa směrů vláken 16% PCL (c),(d), histogram orientace a RGB mapa 

směrů vláken 18% PCL (e),(f), histogram orientace a RGB mapa směrů 20% PCL (g),(h). 
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Stanovení orientace v prostředí programu ImageJ použitím pluginu OrientationJ je 

na rozdíl od stanovení orientace vláken v prostředí programu MATLAB jednodušší, 

uživatel není nucen vytvářet složitý algoritmus. Nevýhodou analýzy v ImageJ je absence 

znázornění výsledků pomocí jiného statistického nástroje než histogramu.  

4.6.4 Stanovení orientace nanovláken v ImageJ - Directionality 

Druhým nalezeným pluginem, který umožňuje automatizované vyhodnocení 

orientace nanovláken ve vlákenné vrstvě je volně dostupný plugin Directionality. 

Directionality je součástí online dostupného balíčku Fiji obsahujícího velké svazky 

pluginů usnadňující získání informací objektů zájmu ze zkoumaného obrazu.  

Plugin Directionality je možný vyhodnotit orientaci vláken na základě dvou 

přístupů, prvním přístupem je Fourierova analýza komponent, druhým je určení místního 

sklonu orientace. V našem případě byla směrovost zjišťována pomocí analýzy Fourierova 

spektra. Kroky vedoucí k zjištění orientace vláken na základě pluginu Directionality jsou 

uvedeny v následujícím textu.   

Stejně jako tomu bylo u demonstrace metody stanovení orientace vláken v programu 

ImageJ použitím pluginu OrientationJ i průběh následující metody byl testován na snímku 

18% PCL uvedeného na obr. 73(a).  

 

Image → Crop  

Prvním krokem, který byl proveden po načtení monochromatického snímku 

do prostředí programu ImageJ bylo ořezání obrazu na velikost 500x500 pixelů.  

 

Process → Sharpen 

V následujícím kroku byl aoutomaticky zvýšen kontrast obrazu použitím 

vestavěného filtru Sharpen. Princip filtru byl uveden v předcházející kapitole. Vstupní 

monochromatický obraz po zvýšení kontrastu je znázorněn na obr. 73(b). 
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(a) (b) 

Obr. 73 Vstupní monochromatický obraz nanovlákenné vrstvy 18% PCL (a), obraz 

po zvýšení kontrastu (b). 

 

 Analyze → Directionality 

Modul Directionality umístněný v nabídce Analyze, je určen k odvození 

preferované orientace struktur přítomných ve vstupním obraze. Dialogové okno 

Directionality analysis zobrazené na obr. 74(a), umožňuje uživateli nastavit jeden ze dvou 

dříve uvedených způsobů, na základě kterých dojde k vyhodnocení směrovosti, v případě 

práce byl zvolen Fourier components. Dále je možné nastavit počet oken, pro které má být 

směrovost vyhodnocena (Nbins), orientace zkoumaných snímků byla stanovena na základě 

200 měření.    

Výstupem analýzy směrovosti je histogram zobrazující množství struktur v dané 

orientaci obr. 74(b). Vstupní obrazy zachycující vlákna struktury uspořádané všemi směry 

vykazují plochý histogram, struktury, ve kterých jsou vlákna orientována v převládajícím 

směru, se vyznačují histogramem s jasným vrcholem.  

 

 

 

 

 

 

(a) (b) 

Obr. 74 Dialogové okno Directionality analysis (a), histogram směrovosti 18% PCL (b). 
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Dalším výstupem je RGB mapa orientace zobrazená na vstupním obraze. Pomocí 

spektra barev uvedeného na obr. 75(a), jsou znázorněny převažující směry nanovlákenné 

vrstvy. Vlákenná vrstva s uvedenými směry zobrazenými pomocí RGB mapy je 

znázorněna na obr. 75(b). Posledním výstupem je tabulka, ve které je uvedena průměrná 

orientace vlákenné vrstvy ve stupních, průměrná orientace vláken zachycených 

na demonstrativním snímku je -63°.  

 

 
 

(a) (b) 

Obr. 75 Spektrum barev (a), RGB mapa směrů znázorněná ve vstupním obraze. 

 

Analýza zaměřená na orientaci vláken realizovaná v prostředí programu ImageJ  

pomocí pluginu Directionality byla stanovena pro stejné snímky, jako tomu bylo 

při použití pluginu OrientationJ a prostředí programu MATLAB.  

Zkoumané snímky 14% PCL, 16% PCL, 18% PCL a 20% PCL jsou uvedeny dříve 

na obr. 58(a)-(d). Aplikací pluginu Directionality byly zjištěny následující informace 

týkající se orientace vláken v jednotlivých nanovlákenných strukturách. 

Vlákenná struktura 14% PCL má dle histogramu uvedeného na obr. 76(a) vlákna 

orientovaná ve všech směrech. V RGB mapě je vidět více zobrazených směrů obr. 76(b). 

Orientace vláken na snímku 16% PCL se dle histogramu obr. 76(c) dá odhadnout ve dvou 

směrech a to v -50°a v 50°, tyto směry jsou barevně vyznačeny na obr. 76(d). Orientace 

vláken 18% PCL je uvedena na obr. 76(e),(f), z obrázků je patrný převládající směr 

v rozmezí od -50° do -70°. Z histogramu směrovosti obr. 76(g) a RGB mapy orientace 

vláken 20% PCL obr. 76(h), je zřejmé, že se vlákenné struktuře vyskytují vlákna ve všech 

směrech přibližně ve stejném zastoupení.  
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(a) (b) 

 

 

(c) (d) 

 

 

(e) (f) 

 

 

(g) (h) 

Obr. 76 Histogram orientace a RGB mapa směrů vláken 14% PCL (a),(b), histogram 

orientace a RGB mapa směrů vláken 16% PCL (c),(d), histogram orientace a RGB mapa 

směrů vláken 18% PCL (e),(f), histogram orientace a RGB mapa směrů 20% PCL (g),(h). 
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Na rozdíl od pluginu OrientationJ, plugin Directionality poskytuje možnost shrnutí 

výsledků měření orientace a je schopen zobrazit průměrnou orientaci vláken ve vrstvě 

spolu s uvedením směrodatné odchylky. V tabulce tab. 10, jsou uvedeny průměrné hodnoty 

směrovosti vláken jednotlivých snímků PCL. 

 

Tab. 10 Průměrné hodnoty orientace vláken v závislosti na koncentraci PCL. 

Koncentrace Směrovost [°] Std [°] 

14 PCL [%] -90.34 0.95 

16 PCL [%] 56.24 2.41 

18 PCL [%] -63.48 1.95 

20 PCL [%] -92.78 1.84 

 

Stanovení orientace vláken v programu ImageJ použitím pluginu Directionality 

se jeví jako vhodnější metoda než stanovení použitím pluginu OrientationJ. Modul 

Directionality má srozumitelnější uživatelské rozhraní. Nevýhody stanovení orientace 

v prostředí ImageJ oproti stanovení orientace v prostředí MATLAB jsou i v tomto případě 

stejné, je to hlavně absence interpretace dat jiným nástrojem než histogramem. 

4.7 Zhodnocení extrakce orientace nanovláken 

Vyhodnocení orientace nanovláken ve vlákenné vrstvě je možné realizovat 

použitím rozličných programů, v této práci byl pro vyhodnocení orientace vláken použit 

nejprve program MATLAB, poté program ImageJ. Orientace byla stanovena 

pro monochromatické snímky nanovlákenných vrstev o koncentraci 14%, 16%, 18% 

a 20% PCL.  

V obou programech byly navrženy metodiky zpracování obrazu nesoucí podobné 

kroky a využívající stejné nástroje zpracování obrazu, jakými je například automatické 

zvýšení kontrastu snímků. Směrovost byla ve všech navržených metodikách analyzována 

pomocí Fourierova spektra. 

 V prostředí programu MATLAB byla Fourierova transformace aplikována 

na vytvořené podobrazy, ze získaných informací o orientaci vláken v jednotlivých 

podobrazech byl sestrojen histogram a jádrový odhad hustoty distribuce směrů, pro lepší 

čitelnost výsledků byla orientace vláken vyjádřena pomocí polárního diagramu.   

V prostředí programu ImageJ bylo stanovení orientace vláken realizováno použitím 

dvou volně dostupných rozšiřovacích modulů – pluginů. Mezi použité pluginy patří 
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OrientationJ a Directionality. Oba pluginy umožňují uživateli detekovat orientaci vláken 

nanovlákenné vrstvy pomocí užití Fourierova gradientu. Uživatelsky přístupnější a lépe 

ovladatelný se však jevil plugin Directionality.  

Na základě stanovených výsledků lze konstatovat, že všechny testované metodiky 

vykazují podobné výsledky o směrovosti vláken v jednotlivých zkoumaných 

nanovlákených snímcích. Výhodou zpracování obrazu v programu MATLAB je jeho dobrá 

reprodukovatelnost a široké spektrum možností reprezentace výsledků. Program ImageJ je, 

co se týká reprezentace výsledků méně vybaven, orientace vláken je srozumitelněji 

vyložena v programu MATLAB pomocí polárního diagramu, ten však nebylo v tomto 

programu možné vytvořit. Výhodou zjišťování orientace vláken v programu ImageJ je, 

že se celá analýza skládá jen z několika málo kroků, na rozdíl od programu MATLAB, 

který pracuje na základě složitého algoritmu. 

4.8 Extrakce průměrů nanovláken  

Průměr vláken je jedním ze základních strukturních parametrů, od kterého se odvíjí 

vlastnosti celé vlákenné struktury. Snímání obrazu nanovlákenných struktur je možné 

pouze pomocí elektronového mikroskopu či mikroskopie atomárních sil (způsoby snímání 

obrazu byly uvedeny dříve).  

Často používanou metodou určenou k získání informací o průměrech vláken 

ze snímků vlákenných vrstev je manuální metoda, při níž je uživatel nucen naměřit 

a zaznamenat velké množství průměrů vláken pomocí nějakého primitivního nástroje 

programu sloužícího k obrazové analýze, například digitalizovaného pravítka. 

Tato metodika je zdlouhavá, málo efektivní, obtížně reprodukovatelná a vzhledem 

k subjektivnímu hodnocení nepřesná. V následujícím textu budou popsány dvě metodiky 

zabývající se stanovením průměrů nanovláken pomocí obrazové analýzy. Metodiky se liší 

zejména programem, ve kterém byly získány informace o průměrech vláken, postup byl 

zpracován nejdříve v programu MATLAB, poté v programu ImageJ.  

Stanovení průměrů nanovláken v obou programech bylo zjištěno na základě 

monochromatických snímků PCL nanovlákenných vrstev lišících se koncentrací 

zvlákňovaného polymeru pořízených skenovací elektronovou mikroskopií. Na snímcích 

o velikosti 1024x1024 pixelů uvedených na obr. 77 je ukázka vrstev 14% PCL (a), 

16% PCL (b), 18% PCL (c) a 20 % PCL (d), určených ke stanovení průměrů nanovláken.  
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(a) (b) 

  

(c) (d) 

Obr. 77 Monochromatický snímek nanovlákenné vrstvy 14% PCL (a), 16% PCL (b), 18% 

PCL (c) a 20% PCL (d).  

4.8.1 Stanovení průměrů nanovláken v programu MATLAB 

Jak bylo zmíněno dříve, stanovení průměru nanovláken aplikací manuální metody 

není příliš efektivní. Z tohoto důvodu jsou pro stanovení průměrů vláken v prostředí 

programu MATLAB hledány jiné, automatické, či poloautomatické způsoby. V této práci 

bylo nalezení průměrů vláken inspirováno studií [3], zabývající se stanovením průměrů 

vláken v netkaných textiliích.  

V prostředí programu MATLAB byl algoritmus vedoucí ke zjištění průměrů vláken 

zkoušen na binárním obraze fiktivní nanovlákenné vrstvy. Testovaný obraz obr. 78(a) je 

o velikosti 500x500 pixelů, jsou na něm zobrazena 4 vlákna, nejširší vlákno má průměr 

78 pixelů, dále se v obraze nacházejí dvě vlákna o průměru 22 pixelů a jedno vlákno 

o průměru 10 pixelů.  Prvním krokem, který byl v prostředí programu MATLAB 

po načtení obrazu do pracovního prostředí aplikován bylo převedení na negativ obrazu. 

Negativ snímku je zobrazen na obr. 78(b). 
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(a) (b) 

Obr. 78 Vstupní binární snímek vytvořené nanovlákenné vrstvy (a), negativ vstupního 

snímku (b).  

 

V dalším kroku došlo pomocí implementované funkce v prostředí programu 

MATLAB k zaznamenání Euklidovských vzdáleností mezi všemi nulovými (obrazovými) 

pixely a jejich nejbližšími neulovými pixely (pixely nesoucí informaci 1, tvořící hranice 

vláken do matice. Grafické zobrazení matice s uvedenými vzdálenostmi je na obr. 79 (a), 

světlá místa uvnitř vláken značí nejvyšší hodnotu jasu tj. největší vzdálenost od hranice 

vlákna. Z důvodu klasifikace průměru, či poloměru vláken jsou důležité právě pixely 

vykazující nejvyšší jasové hodnoty, tyto pixely tvoří pomyslnou osu vláken, hodnota jasu 

je tedy jejich poloměrem.  Získání osy vláken bylo v prostředí programu MATLAB 

provedeno pomocí morfologické operace ztenčení. Tato morfologická operace ponechá 

ve výsledném obraze pouze objektové pixely ležící uprostřed hranic objektu, tzn., došlo 

k zachování pixelů nesoucích informaci o poloměru nanovláken. Úseky ve kterých došlo 

k překřížení vláken, byly nalezeny a vyznačeny. Ztenčený obraz s vyznačenými body 

křížení vláken je uveden na obr. 79(b). 

 

  

(a) (b) 

Obr. 79 Matice Euklidovských vzdáleností (a), ztenčený obraz s vyznačenými body křížení 

vláken (b).  
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Místa překřížení vláken mohou zkreslit konečné výsledky, naměřené Euklidovské 

vzdálenosti v těchto místech neodpovídají skutečným poloměrům nanovláken, proto budou 

v následujícím kroku tato místa odstraněna. K odstranění míst křížení vláken bylo použito 

kruhů o poloměru vláken vykreslených v detekovaných místech křížení, vytvořené kruhy 

byly odečteny od ztenčeného obrazu. Aplikace kruhů je uvedeny na obr. 80(a), obraz 

po odečtení kruhů je znázorněn na obr. 80(b).  

 

  

(a) (b) 

Obr. 80 Aplikace kruhů ve skeletizovaném obraze (a), obraz po odstranění překřížených 

míst (b).  

 

Výstupem metody je histogram distribuce průměrů vláken uvedený na obrázku 

obr. 81. Průměry vláken byly získány vynásobením získané osy vláken konstantou 

o hodnotě 2. Z histogramu je jasně patrné, že byly detekovány tři průměry vláken a to 

průměr 10 pixelů, dále průměr pohybující se mezi 20 až 25 pixely a průměr okolo 70 

pixelů. Dále byl stanoven průměr vláken v testované fiktivní vlákenné vrstvě o velikosti 

26.96 pixelů se směrodatnou odchylkou 20.03 pixelů. 

 

0 10 20 30 40 50 60 70
0

0.02

0.04

0.06

0.08

0.1

0.12

 

Obr. 81 Histogram distribuce průměrů vláken testovaného obrazu. 
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Uvedený postup vedoucí k  detekci průměrů nanovláken ve vlákenné struktuře lze 

snadno interpretovat pomocí algoritmu uvedeného v následujícím textu. Zdrojový kód 

algoritmu je k dispozici v příloze 6.  

 Převeď vstupní binární obraz na negativ.  

 Vypočti Euklidovskou vzdálenost mezi všemi nulovými pixely a jejich nejbližšími 

nenulovými pixely, vzdálenosti zapiš jako matici (bwdist.m). 

 Proveď skeletonizaci obrazu ztenčením (bwmorph.m). 

 Detekuj průsečíky skeletonizované struktury. 

 Každému průsečíku vykresli kružnici o poloměru rovném průměru daného vlákna, 

tím odstraň místa křížení (imcircle.m). 

 Sestroj histogram průměrů vláken. 

Pro aplikaci uvedeného algoritmu na reálných snímcích je nutné do navržené 

metody extrakce průměrů nanovláken zahrnout vhodné techniky předzpracování 

a segmentace obrazu. Aplikace metody na reálném monochromatickém snímku 

nanovlákenné vrstvy 14% PCL bude uvedena v následujícím textu. 

Po načtení a následném oříznutí monochromatického snímku 14% PCL obr. 82(a) 

byl z obrazu odstraněn šum použitím mediánového filtru. Obraz po redukci šumu 

mediánovým filtrem je uveden na obr. 82(b).  

 

  

(a) (b) 

Obr. 82 Vstupní snímek 14% PCL (a), snímek po redukci šumu mediánovým filtrem (b).  

 

Dalším krokem byl převod monochromatického snímku na binární za použití 

prahové hodnoty o velikosti 145. Vzniklý binární obraz je uveden na obr. 83(a). Z tohoto 
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binárního obrazu byly odstraněny všechny objekty menší než 50 pixelů. Obraz bez malých 

objektů je uveden na obr. 83(b). 

 

  

(a) (b) 

Obr. 83 Binární obraz 14% PCL (a), obraz po odstranění malých objektů (b). 

 

Upravený binární obraz byl z důvodu principu dříve uvedené funkce určené 

k výpočtu Euklidovských vzdáleností převeden na negativ. Negativ binárního obrazu je 

uveden na obr. 84(a). Na obr. 84(b) je graficky znázorněna matice nalezených 

Euklidovských vzdáleností.  

 

 

 

(a) (b) 

Obr. 84 Negativ obrazu (a), mapa Euklidovských vzdáleností (b). 

  

Následující průběh obrazové analýzy je totožný s postupem aplikovaným 

na fiktivním snímku nanovlákenné vrstvy uvedené na obr. 78(a) na začátku této 

podkapitoly.  Jediný rozdíl, který nesmíme opomenout je nutnost provést kalibraci 

výsledků vzhledem k tomu, že získané průměry jsou uváděné v pixelech.  Kalibrační vztah 
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pro jednotlivé snímky zobrazené na obr. 77(a)-(d) je u všech vyhodnocovaných snímků 

stejný a je uveden v tabulce tab. 11.  

 

Tab. 11 Kalibrační vztahy jednotlivých snímků PCL v závislosti na koncentraci. 

Koncentrace Kalibrační vztah 

14% PCL, 16% PCL, 18% PCL, 20% PCL 1 pixel = 0.0196 µm 

 

Výsledné průměry nanovlákenných vrstev v závislosti na koncentraci 

zvlákňovaného polymeru PCL jsou uvedeny v tabulce tab. 12 a graficky znázorněny 

pomocí histogramů na obr. 84(a)-(d). 

 

Tab. 12 výsledky stanovení průměrů vláken v závislosti na koncentraci polymeru. 

Koncentrace Průměr [μm] Std [μm] 

14% PCL 0.16 0.09 

16% PCL 0.22 0.15 

18% PCL 0.19 0.22 

20% PCL 0.65 0.70 
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(c) (d) 

Obr. 84 Histogram průměrů vláken 14% PCL (a), 16% PCL (b), 18% PCL (c) a 20% PCL 

(d).  
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Představená metoda řešící problematiku stanovení průměrů nanovláken je na rozdíl 

od manuální metody snadno reprodukovatelná, efektivní a relativně přesná. Na základě 

zjištěných průměrů vláken v jednotlivých nanovlákenných vrstvách lišících se koncentrací 

zvlákňovaného PCL lze říci, že v případě koncentrací 14% PCL, 16% PCL a 18% PCL 

jsou průměry vláken přibližně stejné, na první pohled rozdílných hodnot dosahoval průměr 

vláken vrstvy 20% PCL. Z tohoto zjištění můžeme usoudit, že po dosažení určité hranice 

koncentrace jsou průměry nanovláken znatelně větší.  

4.8.2 Stanovení průměrů nanovláken v programu ImageJ manuální 

metodou 

Klasifikace průměrů vláken nanovlákenných vrstev v prostředí programu ImageJ 

byla nejprve realizována prostřednictvím manuální metody. Princip manuální metody 

stanovení průměrů vláken v prostředí programu ImageJ je velmi jednoduchý, ale časově 

náročný. Posloupnost kroků vedoucí ke klasifikaci průměrů vláken je uvedena 

v následujícím textu. 

Pro demonstraci metody stanovení průměrů nanovláken v prostředí programu 

Imagej byl použit monochromatický snímek 14% PCL pořízený SEM mikroskopií. 

Vstupní snímek je uveden na obr. 85(a).  

Process → Filters → Median 

První úpravou, která byla na vstupním snímku provedena, bylo odstranění možného 

šumu pomocí mediánového filtru zvoleného v nabídce Process → Filters → Median. 

V dialogovém okně Median zobrazeném na obr. 85(b) má uživatel možnost zvolit velikost 

poloměru filtru, v našem případě byla zvolena velikost 1.5 pixelu, tzn. každý obrazový 

pixel je nahrazen mediánem úrovně šedi ze svého okolí o velikosti 3x3 pixely. Výsledný 

obraz vzniklý touto transformací je znázorněn na obr. 85(c). 

Analyze → Set Scale  

Nezbytným krokem potřebným ke stanovení výsledků měření v reálných 

jednotkách je kalibrace, která byla provedena prostřednictvím nástroje Set Scale v nabídce 

Analyze.  
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Image→ Adjust→ Treshold 

Transformace vstupního monochromatického obrazu na binární byla realizována 

prostřednictvím víceúrovňového prahování, hodnota prahu byla zvolena stejně jako 

v prostředí programu MATLAB, tj. 145 a byla nastavena ručně v dialogovém okně 

Treshold na základě histogramu úrovně šedi. Výsledný binární obraz je zobrazen 

na obr. 85(d). 

 

 

 

(a) (b) 

 

 

(c) (d) 

Obr. 85 Vstupní monochromatický snímek nanovlákenné vrstvy 14% PCL (a), dialogové 

okno Median (b), obraz po odstranění šumu (c), binární obraz (d).  

 

Pomocí nástroje lupa nacházejícím se v hlavním Toolboxu obr. 86(a), bylo 

pro přesnější provedení měření průměrů nanovláken možné libovolně zvětšovat 

analyzovaný snímek. Měření průměrů probíhalo manuálně pomocí aplikace mnoha přímek, 

které byly vedeny kolmo od jedné ke druhé hraně vlákna. Měřící přímka je v binárním 

obraze zobrazena žlutě na obr. 86(b). Zapsání naměřeného údaje do dialogového okna 

Results uvedeného na obr. 86(c) probíhá pomocí klávesové zkratky Ctrl+M. Lokace místa 

ve kterém probíhá měření je znázorněno schematicky na analyzovaném snímku uvedeném 

na obr. 86(b) vlevo nahoře. 
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(a) 

  

(b) (c) 

Obr. 86 Uživatelské rozhraní programu ImageJ (a), zvětšený binární obraz se zachyceným 

snímáním průměru vlákna (b), dialogové okno Results (c). 

 

Results → Distribution 

V dialogovém okně Results ve stejnojmenné nabídce Results je pomocí nástroje 

Distribution možné ze získaných dat sestavit histogram.  

 

Results → Summarize 

Dále je v dialogovém okně Results možné pomocí nástroje Summarize 

nacházejícího se v nabídce Results stanovit průměr a směrodatnou odchylku pro ručně 

zaznamenaná měření průměrů nanovláken. 

 

Aplikací výše uvedené metody stanovení průměrů nanovláken v prostředí programu 

ImageJ na sadě dříve zmíněných monochromatických snímků PCL nanovlákenných vrstev 

lišících se koncentrací zvlákněného roztoku uvedených na obr. 77(a)-(d), byly zjištěny 

následující průměry nanovláken zaznamenané v tab. 13. Průměry nanovláken 

v jednotlivých vlákenných vrstvách lišících se koncentrací PCL jsou graficky znázorněny 

pomocí histogramů uvedených na obr. 87(a)-(d). 
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Tab. 13 Průměr nanovláken v závislosti na koncentraci PCL  

Koncentrace Počet měření Průměr [μm] Std [μm] 

14% PCL 200 0.21 0.07 

16% PCL 200 0.23 0.04 

18% PCL 200 0.23 0.13 

20% PCL 200 0.63 0.35 

 

  

(a) (b) 

  

(c) (d) 

Obr. 87 Histogram průměrů nanovláken vrstvy (a) 14% PCL, (b) 16% PCL, (c) 18% PCL 

a 20% PCL (d).  

 

Manuální vyhodnocení průměrů nanovláken je v prostředí programu ImageJ 

zdlouhavým, časově a subjektivně náročným postupem. Nevýhodou je podstatně menší 

počet provedených měření než je tomu v prostředí programu MATLAB, kdy byl průměr 

vláken změřen pro každý objektový pixel tvořící osu vlákna. Vzhledem k absenci velkého 

počtu měření a subjektivnímu přístupu hodnocení průměrů nanovláken jsou dosažené 

výsledky v obou použitých metodikách srovnatelné. V následující kapitole je navržen 

automatizovaný postup vyhodnocení průměrů nanovláken. 
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4.8.3 Stanovení průměrů nanovláken v ImageJ  

Vzhledem k náročnosti manuální metodiky stanovení průměrů nanovláken 

vyskytujících se v nanovlákenných vrstvách je snaha o její zjednodušení. V následující 

navržené posloupnosti kroků v programu ImageJ vedoucí k vyhodnocení průměru 

nanovláken jednotlivých nanovlákenných vrstev lišícíh se koncentrací zvlákněného 

polymeru byl napodoben postup metodiky aplikované v prostředí programu MATLAB 

vycházející ze stanovení Euklidovských vzdáleností obrazových pixelů a jejich nejbližších 

pixelů reprezentující pozadí. V následujícím textu jsou popsány jednotlivé kroky této 

metodiky navržené v prostředí programu ImageJ. Způsob průběhu navržené metody je 

stejně jako v předchozích dvou testovaných metodách aplikován na vstupním 

monochromatickém snímku 14% PCL.  

 

Process → Filters → Median 

Po načtení vstupního snímku 14% PCL nanovlákenné vrstvy a jeho následném 

ořezání pomocí nástroje Crop v nabídce Image došlo pomocí mediánového filtru 

o poloměru 1.5 pixelu nacházejícího se v nabídce Filters k redukci náhodného šumu. 

Vstupní monochromatický snímek 14% PCL je zobrazen na obr. 88(a), snímek 

po odstranění šumu je zobrazen na obr. 88(b). 

 

Image → Adjust → Treshold 

 Stejně jako tomu bylo v prostředí programu MATLAB, i v programu ImageJ byl 

vstupní snímek nanovlákenné vrstvy převeden na binární za použití prahování. Prahování 

bylo realizováno pomocí nástroje Treshold, práh byl zvolen o velikosti 145. 

Transformovaný binární obraz nanovlákenné vrstvy je uveden na obr. 89(c).  

 

 

(a) 

 

(b) (c) 

Obr. 89Vstupní monochromatický snímek 14% PCL (a), snímek po odstranění šumu (b), 

transformovaný binární snímek (c).  
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Image → Duplicate 

 Pomocí nástroje Duplicate v nabídce Image byl z důvodu následujících operací 

vytvořen duplikát monochromatického snímku nanovlákenné vrstvy. 

 

Process → Binary → Distance Map 

 Pro jeden z dříve vytvořených binárních snímků byly pomocí nástroje vzdálenostní 

mapy (Distance Map) nacházející se v nabídce Binary hlavní nabídky Process stanoveny 

Euklidovské vzdálenosti. Vzdálenostní mapa zobrazuje prostřednictvím odstínů šedi 

Euklidovské vzdálenosti jednotlivých obrazových pixelů od jejich nejbližšího pixelu 

reprezentujícího pozadí tzv. hranového pixelu. Pixely zobrazené ve vzdálenostní mapě 

pomocí nejtmavší úrovně šedi považujeme za poloměr vláken. Mapa Euklidovských 

vzdáleností pro binární obraz nanovlákenné vrstvy je zobrazena na obr. 90(a). 

 

Process → Binary → Skeletonize 

U druhého binárního snímku nanovlákenné vrstvy byla provedena morfologická 

operace skeletonizace, která je obdobou morfologické operace ztenčení, provedené 

v prostředí programu MATLAB. Cílem skeletonizace je najít kostru neboli osu 

jednotlivých vláken, nalezení osy je realizováno pomocí postupného odstraňování 

objektových pixelů směrem od hranic ke středu objektu, dokud nezbude pouze jediný 

objektový pixel. Skeletonizace byla provedena pomocí příkazu Skeletonize v nabídce 

Binary. Výsledná nalezená kostra vláken je zobrazena na obr. 90(b). 

 

(a) (b) 

Obr. 90 Vzdálenostní mapa snímku 14% PCL (a), nalezená kostra vláken 14% PCL (b). 
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Process → Image Calculator → AND 

Nástoroj Image Calculator nacházející se v nabídce Process slouží 

k matematickým operacím mezi dvěma obrazy. Pomocí dialogového okna Image 

Calculator jsou vybrány ty obrazy, mezi kterými má dojít ke zvolené matematické operaci. 

Dialogové okno je uvedeno na obr. 91(a). V našem případě byl pro matematickou operaci 

zvolen obraz vzdálenostní mapy a obraz kostry vláken, dále byla zvolena operace AND 

sloužící k průniku dvou obrazů. Výstupem Image Calculator je nový obraz, ve kterém je 

ponechána pouze kostra vláken, která je tvořena pixely o intenzitě úrovně šedi získané 

ze vzdálenostní mapy. Zjednodušeně lze říci, že jsou ve vzniklém obraze zobrazeny pouze 

pixely nesoucí pomocí úrovně šedi informaci o poloměru vláken. Obraz po matematické 

operaci je zobrazen na obr. 91(b).  

 

  

(a) (b) 

Obr. 91 Dialogové okno Image Calculator (a), výsledný obraz po matematické operaci (b). 

 

Process → Math→ Multiple 

 Pro získání informace o průměru vláken byl každý obrazový pixel o určité úrovni 

šedi nesoucí informaci o poloměru vynásoben proměnnou o hodnotě 2, proměnná 2 je 

odvozena ze vztahu poloměru a průměru. Tato transformace je možná pomocí funkce 

Multiple nástroje Math dostupného v nabídce Process.  Funkce Multiple umožňuje 

vynásobení jednotlivých hodnot všech pixelů nacházejících se v obraze definovanou 

konstantou zadanou v dialogovém okně Multiply. Dialogové okno je zobrazeno na 

obr. 92(a), obraz se zdvojnásobenou hodnotou šedi jednotlivých pixelů tvořících kostru 

vláken je zobrazen na obr. 92(b). Takto připravený obraz je vhodným vstupem pro 

vyhodnocení průměrů vláken.  
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(a) (b) 

Obr. 92 Dialogové okno Multiply (a), obraz s dvojnásobnou hodnotou šedi pixelů tvořících 

kostru vláken (b).  

 

Analyze → Histogram 

 Vyhodnocení průměrů nanovláken vyskytujících se v nanovlákenných vrstvách je 

možné pomocí nástroje Histogram v nabídce Analyze. Výsledný histogram obsahuje kromě 

samotného grafického vyjádření četností výskytu jednotlivých průměrů vláken také údaje 

o průměrném průměru vláken, maximálním a minimálním průměru a také informaci 

o směrodatné odchylce. V dialogovém okně Histogram je možné nastavit potlačení 

zahrnutí vyhodnocení pixelů nesoucích určitou informaci. Dialogové okno Histogram je 

zobrazeno na obr. 93(a). V našem případě bylo potlačeno nastavením minimální hodnoty 

x-ové osy (XMin=1) vyhodnocení všech pixelů o intenzitě šedi rovno 0, tyto pixely 

představují pozadí. Výsledný histogram s uvedenými údaji o velikosti průměrů nanovláken 

ve zkoumaném snímku je uveden na obr. 93(b). 

 

  

(a) (b) 

Obr. 93 Dialogové okno Histogram (a), výsledný histogram průměrů nanovláken (b). 

 

Informace o poloměrech vláken jsou uvedeny pomocí úrovně šedi, z tohoto důvodu 

je nutné provést kalibraci vedoucí k transformaci těchto informací do délkových jednotek.  

Kalibrace výsledků musela být provedena ručně vynásobením průměru vláken 
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stanoveného v pixelech kalibračním vztahem uvedeným dříve v tab. 11. Při snaze 

realizovat kalibraci prostřednictvím dříve uvedeného postupu popisujícího vynásobení 

pixelů v obraze konstantou (Process → Math → Multiple), nebyl histogram schopen 

zachytit úrovně šedi pixelů reprezentující průměry vláken, důvodem byla jejich 

zanedbatelná velikost.  

Dle uvedené metody byly stanoveny průměry vláken z monochromatických snímků 

PCL o koncentracích 14% PCL, 16% PCL, 18% PCL a 20% PCL uvedených dříve 

na obr. 77(a)-(d). Výsledky stanovení průměrů vláken z monochromatických snímků 

jednotlivých vrstev na základě uvedené metody aplikované v prostředí programu ImageJ 

jsou uvedeny v tab. 14. Distribuce průměrů nanovláken vyskytujících se v jednotlivých 

nanovlákenných vrstvách je uvedena na obr. 94 (a)-(d). Stručné shrnutí jednotlivých kroků 

aplikovaných v prostředí programu ImageJ je uvedeno v příloze 7. 

 

Tab. 14 Průměr nanovláken v závislosti na koncentraci roztoku PCL  

Koncentrace Průměrná hodnota intenzity 

šedi pixelů 

Převodní 

vztah 

Průměr 

vláken [μm] 

Std [μm] 

14% PCL 8.261 0.0196 0.16 0.09 

16% PCL 10.895 0.0196 0.21 0.13 

18% PCL 8.916 0.0196 0.17 0.14 

20% PCL 28.704 0.0196 0.56 0.41 

 

  

(a) (b) 

  

(c) (d) 

Obr. 94 Distribuce velikosti průměrů nanovláken vyskytujících se v nanovlákenné vrstvě 

o koncentraci 14% PCL (a), 16% PCL (b), 18% PCL (c), 20% PCL (d).  
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Vyhodnocení průměrů nanovláken jednotlivých vrstev v prostředí programu ImageJ 

je snadným automatizovaným způsobem zjišťování tohoto parametru. Navržený postup je 

totožný s algoritmem stanoveným pro určení průměrů vláken, který byl uveden v programu 

MATLAB. Výsledné hodnoty průměrů nanovláken získané v prostředí programu ImageJ 

vycházející ze stanovení Euklidovských vzáleností jsou shodné s výsledky dosaženými 

v programu MATLAB a výsledky zjištěnými manuální metodou aplikovanou v prostředí 

programu ImageJ. Navržená posloupnost kroků aplikovaných v prostředí programu ImageJ 

za účelem detekce průměrů nanovláken je uvedena v příloze 7.  

4.9 Zhodnocení extrakce průměrů nanovláken 

V práci byly demonstrovány dvě metody sloužící k detekci průměrů vláken PCL 

nanovlákenných vrstev. První metoda vychází z nalezení Euklidovských vzdáleností 

objektových pixelů tvořících vlákna s jejich nejbližším nenulovým pixelem 

reprezentujícím pozadí, který se dotýká hrany objektu.  Tato metoda byla aplikována 

v prostředí programu MATLAB a následně v prostředí programu ImageJ. Druhou metodou 

byla manuální metoda měření průměrů nanovláken, tato metoda byla aplikována pouze 

v programu ImageJ, manuální metoda je časově náročná a není objektivní. Na základě 

srovnání výsledných průměrů vláken jednotlivých PCL nanovlákenných vrstev dosažených 

všemi aplikovanými metodami můžeme konstatovat, že jsou výsledky dosažené pomocí 

obou metod aplikovaných ve dvou prostředích totožné. Jako vhodnější způsob se jeví 

metoda založená na stanovení Euklidovských vzdáleností objektových pixelů 

od nejbližších pixelů pozadí, metoda je automatizovaná a je naměřeno velké množství 

hodnot průměrů, které lze dobře interpretovat. 
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5 Závěr 

Cílem této práce bylo navrhnout objektivní algoritmy v prostředí programu MATLAB 

a stanovit posloupnost kroků v prostředí programu ImageJ vedoucích k určení základních 

kvantitativních charakteristik nanovlákenných vrstev. Vytvořené algoritmy byly testovány 

na sadě monochromatických snímků nanovlákenných vrstev získaných prostřednictvím 

skenovací elektronové mikroskopie. Nanovlákenné vrstvy byly vytvořeny elektrostatickým 

zvlákňováním čtyř roztoků polykaprolaktonu o koncentracích 14% PCL, 16% PCL, 

18% PCL a 20% PCL.  Navržené algoritmy pro obě programová prostředí byly zaměřeny 

na stanovení parametrů pórů, charakteristiku defektů vyskytujících se v nanovlákenných 

vrstvách, stanovení orientace a průměrů vláken.  

 

Metodika zaměřená na stanovení základních parametrů mezivlákenných pórů, jakými 

je plocha a obvod pórů, byla v obou programovacích prostředích založena na segmentaci 

pórů z transformovaných vstupních snímků nanovlákenných vrstev na binární. Výsledky 

zjištěných základních parametrů pórů v závislosti na koncentraci zvlákněného roztoku byly 

v obou programových prostředích shodné.  

Detekce základních charakteristik kulovitých defektů vyskytujících se 

v nanovlákenných vstvách byla v obou programových prostředích stanovena na základě 

dvou přístupů. První přístup byl založen na segmentaci vyskytujících se defektů od pozadí, 

kterým je chápána nanovlákenná vrstva, tato metodika nevykazovala přesné výsledky. 

Princip druhého přístupu stanovení základních charakteristik defektů v obou 

programových prostředích spočíval ve vzájemné korelaci vstupního monochromatického 

snímku nanovlákenné vrstvy a vytvořené šablony, která se vyznačuje parametry jako je 

tvar, velikost a intenzita šedi, totožnými s parametry hledaných defektů. Výstupem metody 

je korelovaný obraz, jehož transformací na binární obraz byly získány jednotlivé objekty, 

pro které bylo možné stanovit základní parametry. Na základě obou navržených přístupů 

pro detekci a stanovení základních charakteristik defektů vyskytujících 

se v nanovlákenných vrstvách lze i přes rozdílné výsledky dosažené aplikací metodik 

ve dvou programových prostředích konstatovat, že s rostoucí koncentrací zvlákňovaného 

roztoku klesá výskyt kulovitých defektů v nanovlákenných vrstvách. 

Stanovení orientace nanovláken ve vlákenných vrstvách bylo v obou programových 

prostředích založeno na Fourierově transformaci. V prostředí programu MATLAB byla 

orientace nanovláken stanovena na základě určení směrových vektorů v mnoha podoknech, 
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kterými byl rozdělen vstupní monochromatický obraz. V prostředí programu ImageJ byla 

orientace vláken stanovena na základě použití dvou volně dostupných rozšiřovacích 

modulů. Prvním modulem byl plugin OrientationJ, druhým plugin Directionality. 

Výsledky stanovení orientace nanovláken v jednotlivých vrstvách se u metodik 

aplikovaných v obou programových prostředích shodovali.  

Posledním parametrem, pro jehož extrakci byly v prostředí programu MATLAB 

i prostředí programu ImageJ navrženy objektivní algoritmy byl průměr nanovláken. 

Metodika stanovení průměru vychází v obou programových prostředích z nalezení 

Euklidovských vzdáleností objektových pixelů tj. pixelů reprezentujících vlákna s jejich 

nejbližším pixelem představujícím pozadí. Pro ověření přesnosti této metody byly 

v prostředí programu ImageJ změřeny průměry nanovláken v jednotlivých vrstvách také 

manuální metodou, stanovené výsledky průměrů vláken se shodovaly. 

 

Všechny uvedené metodiky monitorující parametry nanovlákenných vrstev jsou 

efektivní, snadno interpretovatelné a lze jimi objektivně stanovit uvedené základní 

parametry nanovlákenných struktur. Výhodou metodik stanovení základních parametrů 

nanovlákenných struktur v prostředí programu ImageJ je jejich snadná uživatelská 

přístupnost, která není podmíněna znalostí tvorby složitých algoritmů jako je tomu 

v prostředí programu MATLAB a volná dostupnost bez nutnosti zakoupení licence. 

Nevýhodou metodik analyzujících snímky nanovlákenných vrstev v prostředí ImageJ je 

na rozdíl od metodik aplikovaných v programu MATLAB omezená interpretace výsledků 

zjištěných charakteristik.  

Přínos práce je mimo identifikaci základních parametrů nanovlákenných struktur 

i ve snadné interpretaci algoritmů navržených v prostředí programu MATLAB 

prostřednictvím uživatelsky lépe pochopitelného a přístupného programu ImageJ. 

Navržené posloupné kroky v prostředí programu ImageJ mohou být vhodnou předlohou 

pro stanovení datových informací z obrazu bez nutnosti tvorby složitých algoritmů, jako je 

tomu v prostředí programu MATLAB. Navržená posloupnost kroků vedoucích 

ke stanovení parametrů nanovlákenných struktur najde uplatnění nejen v oblasti 

nanovláken, ale i oblasti tkáňového inženýrství, kde může sloužit k identifikaci a popisu 

strukturních parametrů buněk nebo buněčných systémů.   
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Přílohy 

V příloze 1 je uveden seznam a výklad zaimplementovaných funkcí programu 

MATLAB použitých v rámci řešení této diplomové práce. Zdrojové kódy k jednotlivým 

vytvořeným algoritmům vedoucích k monitorování jednotlivých parametrů 

nanovlákenných vrstev jsou uvedeny v příloze 2 až příloze 6. V příloze 7 jsou uvedeny 

navržené posloupné kroky vedoucí k detekci parametrů nanovlákenných pórů v programu 

ImageJ.  

Obrazová sada pořízených snímků nanovlákenných vrstev o různých koncentracích, 

kódy vytvořených skriptů v prostředí programu MATLAB vedoucí k detekci zkoumaných 

parametrů a volně dostupné pluginy použité v prostředí programu ImageJ jsou přiloženy 

na CD.  
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Příloha 1 

Seznam použitých funkcí v programu MATLAB 

im2bw.m  Převádí obraz ve stupních šedi na binární obraz. Ve výstupním 

obraze BW jsou všechny obrazové body vstupního obrazu 

se svítivostí vyšší než úroveň nahrazeny hodnotou 1 (bílá), ostatní 

pixely hodnotou 0 (černá). Specifikujte úroveň v rozsahu 

[0,1]. Tento rozsah je dán na základě úrovně signálů obrazu v jeho 

třídě. Pokud není zadána úroveň, je automaticky počítáno s úrovní 

o hodnotě 0.5, která se nachází uprostřed mezi černou a bílou, bez 

ohledu na třídu.   

imhist.m Funkce zobrazí histogram pro daný snímek uvedený ve stupních 

šedi. Rozsah histogramu je určen typem obrazu. Pokud je vstupní 

obraz ve stupních šedi, je rozsah intervalů na x-ové ose roven 256, 

pokud by byl použit binární obraz, rozsah by byl 2 (bílá a černá). 

imtool.m Funkce zobrazí obraz ve stupních šedi. 

regionprops.m Funkce měří sadu vlastností pro každou označenou oblast 

matice L. Měřené vlastnosti jsou uvedeny v pixelech. 

bwlabel.m Výstupem funkce je matice L, o stejné velikosti jako vstupní 

obraz, která obsahuje popisky připojených objektů vyskytujících 

se ve vstupním obraze. Díky volitelné proměnné, která může mít 

hodnotu 4 nebo 8, je stanoveno buď 4-sousedství nebo 8-

sousedství připojených objektů. Pokud je argument proměnné 

vynechán, použije se automaticky hodnota 8. 

Prvky matice L jsou celočíselné hodnoty větší než nebo rovno 

0. Pixely označené 0 reprezentují pozadí. Obrazové body 

označené indexem 1 tvoří jeden objekt, pixely označené indexem 

2 tvoří druhý objekt, a tak dále. 

medfilt2.m Pomocí této funkce je realizována mediánová filtrace obrazu. 

Jedná se o nelineární operaci často používanou při zpracování 

obrazu pro snížení šumu typu "sůl a pepř". Každý pixel vstupního 

obrazu je nahrazen mediánem ze svého okolí o velikosti např. 3x3 

pixely. 

bwareaopen.m Vyvolání funkce odstraní z binárního obrazu všechny připojené 

komponenty (objekty), které mají méně pixelů, než je minimální 

velikost objektů zadaná v argumentu. Tato operace je známá jako 

otevření oblasti. Připojení objektů lze přesněji definovat pomocí 

sousedství.  
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imclearborder.m Funkce potlačuje struktury, které jsou lehčí než jejich okolí, 

a které jsou připojeny k obrazové hranici. Vstupní obraz může být 

ve stupních šedi nebo binární.  Výchozí konektivita je 8 pro dva 

rozměry, 26 pro tři rozměry. 

imerode.m  Funkce vyvolává erozi obrazu, tzn., narušuje obraz ve stupních 

šedé nebo binární obraz použitím je strukturního elementu. 

Strukturní element je objekt nebo pole prvků strukturovaných 

objektů vrácených  funkcí strel. Funkce provádí binární erozi, 

ale také erozi ve stupních šedi.   

strel.m Funkce vytváří morfologický strukturní prvek – element určitého 

tvaru a velikosti. Element má definovaný střed uprostřed matice 

udávající jeho velikost. Mezi možné tvary, které lze vytvořit paří 

např. diamant, koule a disk. 

imfill.m  Funkce  vyplní díry ve vstupním binárním obraze. Díra je 

označení pro sadu bodů pozadí, díra je vyplněna tím, že dojde 

k vyplnění pozadí od okraje obrazu. 

padarray.m Funkce slouží k doplnění pole, které může být chápáno například 

jako strukturní prvek nulovými pixely. V argumentu funkce je 

zadán vektor nezáporných celých čísel, který určuje, jaké 

množství pixelů přidat a rozměr, po které je přidat.  

imfilter.m Funkce slouží k filtrování vícerozměrných obrazů použitím 

definovaného filtru.  

fspecial.m Funkce slouží k vytvoření dvourozměrného filtru, který je 

vhodnou formou pro použití spolu s imfilter. Mezi typy 

používaných filtrů paří například gaussian, average a Laplacian. 

dftcorr.m Vytvořený m-file provede korelaci obrazu s vyhledávací tabulkou. 

bwmorph.m Prostřednictvím této funkce je možné provést řadu 

morfologických operací v binárním obraze, jako je například 

vyplnění děr, uzavření a otevření obrazu. 

imadjust.m Funkce mapuje hodnoty intenzity obrazu ve stupních 

šedi a nahrazuje je novými hodnotami, 1% dat je nasyceno nízkou 

a vysokou intenzitou vstupního obrazu. Tím se zvyšuje kontrast 

výstupního obrazu. 
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imclose.m Funkce vyvolá morfologické uzavření obrazu, který je buď 

ve stupních šedi, nebo binární. Po morfologické operaci dilatace 

následuje eroze za použití stejného strukturního prvku.  

fft2.m 2D Fourierova Transformace. 

fftshift.m Funkce uspořádá výstupy Fourierovy transformace, nulovou 

frekvenční složka je umístněny do středu pole – spektra. 

bwdist.m Funkce vypočítá Euklidovskou vzdálenost pomocí 

transformovaného vstupního binárního obrazu. Pro každý pixel 

ve vstupním obraze, je přiřazeno číslo, které je vzdáleností mezi 

tímto pixelem a jeho nejbližšího nenulového pixelu. 
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Příloha 2 

Metodika stanovení parametrů pórů  

clc, close, clear all 

 

%% NAČTENÍ OBRAZU %% 

I=imread('NÁZEV SNÍMKU.FORMÁT'); 

I=I(1:512,:); 

figure, imshow(I);  

  

%% REDUKCE ŠUMU %% 

I = medfilt2(I) 

figure, imshow(I);  

  

%% PRAHOVÁNÍ %% 

T1=130 

I=im2bw(I,T1/255); 

  

%% SADA MORFOLOGICKÝCH OPERACÍ %% 

BW = bwareaopen(I,30);  

figure, imshow (BW);  

In=abs(1-BW); 

figure, imshow (In);  

Ic=imclearborder(In);  

figure,imshow(Ic);  

Ik= bwareaopen(Ic,30); 

figure,imshow(Ik); 

  

%% STANOVENÍ PÓROZITY %% 

E=size(Ik) % výpočet počtu řádků a sloupků  

Sc=E(1)*E(2) %celková plocha obrázku 

S=sum(Ik,1); % součet všech černých bitů přes všechny řádky 

SB=sum(S,2) % součet všech černých bitů přes všechny sloupky - plocha vláken 

Ac=S+SB %zjistění plochy pórů 

P=Ac/Sc % stanovení porózity 

  

%% VYTVOŘENÍ MATICE %% 

IL=bwlabel(Ik); 

  

%% VYKRESLENÍ OBVODŮ PÓRŮ DO VSTUPNÍHO OBRAZU %% 

RGB = label2rgb(IL);  

figure, imshow(RGB);  

se=[0 1 0;1 1 1;0 1 0]; 

Ie=imerode(BW,se); 

R=BW-Ie; 

figure,imshow(R);  

[r s]=find(R==1);  

for i=1:length(r) 

    Irgb(r(i),s(i),1)=255;  

    Irgb(r(i),s(i),2)=0;  

    Irgb(r(i),s(i),3)=0;  

end 

figure,imshow(Irgb);  

  

%% STANOVENÍ VLASTNOSTÍ PÓRŮ%% 

A=regionprops(IL,'Area');  

B=[A.Area]*(KALIBRAČNÍ_VZTAH^2); 

Bh=B; 

Bs=sum(B) 

Bb=mean(B) 

b=std(B) 

  

P=regionprops(IL,'Perimeter');  

C=[P.Perimeter]*(KALIBRAČNÍ_VZTAH); 
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Ch=C; 

c=std(C) 

Cb=mean(C) 

Cs=sum(C) 

  

%% VYKRESLENÍ HISTOGRAMŮ %% 

figure, 

hist(Bh,20), 

h = findobj(gca,'Type','patch'); 

set(h,'FaceColor',[120/255 230/255 200/255],'EdgeColor','k') 

title('Histogram plochy pórů','FontSize', 20,'FontWeight','bold' ) 

xlabel('Plocha [µm^2]','FontSize', 18) 

ylabel('Četnost','FontSize', 18)  

  

figure, 

hist(Ch,20), 

h = findobj(gca,'Type','patch'); 

set(h,'FaceColor',[120/255 230/255 200/255],'EdgeColor','k') 

title('Histogram obvodů pórů','FontSize', 20,'FontWeight','bold' ) 

xlabel('Obvod [µm]','FontSize', 18)  

ylabel('Četnost','FontSize', 18) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Fakulta textilní Technické univerzity v Liberci 

Monitorování vnitřní struktury nanovlákenných vrstev pomocí obrazové analýzy  

Příloha 3 

Metodika stanovení parametrů defektů založená na korelaci 

clear,clc,close all 

 

%% NAČTENÍ OBRAZU %% 

D=imread('NÁZEV SNÍMKU.FORMÁT'); 

D=D(1:500,500:1); 

Irgb=D;Irgb(:,:,2)=D;Irgb(:,:,3)=D; 

figure,imshow(D,[]) 

  

%% VYTVOŘENÍ SROVNÁVACÍ ŠABLONY REPREZENTUJÍCÍ HLEDANÉ DEFEKTY %% 

R=6; 

se=strel('disk',R,0); 

se1=struct2cell(se); 

dotaz=se1{1}; 

dotaz=padarray(dotaz, [3 3], 0); 

dotaz=double(dotaz)*170; 

vel=(length(dotaz)-1)/2; 

figure,imshow(dotaz,[0 255]) 

  

%% KORELACE OBRAZU A ŠABLONY %% 

g=dftcorr(D,dotaz); 

g=gscale(g); 

figure,imshow(g,[]) 

  

%% PRAHOVÁNÍ KORELOVANÉHO OBRAZU %% 

P=im2bw(g,0.6); 

figure,imshow(P) 

  

%% SADA MORFOLOGICKÝCH OPERACÍ %% 

P=bwareaopen(P,30); 

figure,imshow(P) 

P=imclearborder(P); 

figure,imshow(P) 

  

%% VYTVOŘENÍ MATICE %% 

IL=bwlabel(P); 

RGB = label2rgb(IL);  

figure, imshow(RGB); 

  

%% VYKRESLENÍ NALEZENÝCH DEFEKTŮ VE VSTUPNÍM OBRAZE %%  

Ig=imerode(P,ones(3)); 

IE=P-Ig; 

figure,imshow(IE) 

[r s]=find(IE==1); 

for i=1:length(r) 

    Irgb(r(i)+vel,s(i)+vel,1)=255; 

    Irgb(r(i)+vel,s(i)+vel,2)=0; 

    Irgb(r(i)+vel,s(i)+vel,3)=0; 

end 

Irgb=Irgb(1:500,1:500,:); 

figure,imshow(Irgb) 

  

%% STANOVENÍ VLASTNOSTÍ DEFEKTŮ%% 

A=regionprops(IL,'Area');  

B=[A.Area]* KALIBRAČNÍ_VZTAH^2; 

Bh=B; 

Bs=sum(B) 

Bb=mean(B) 

b=std(B) 

  

P=regionprops(IL,'Perimeter');  

C=([P.Perimeter]* KALIBRAČNÍ_VZTAH); 
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Ch=C; 

Cs=sum(C) 

Cb=mean(C) 

c=std(C) 

  

%% VYKRESLENÍ HISTOGRAMŮ %% 

figure, 

hist(Bh,10), 

h = findobj(gca,'Type','patch'); 

set(h,'FaceColor',[120/255 230/255 200/255],'EdgeColor','k') 

title('Histogram ploch defektů 16% PCL','FontSize', 20,'FontWeight','bold' ) 

xlabel('Plocha [µm^2]','FontSize', 18)  

ylabel('Četnost','FontSize', 18)  

  

  

figure, 

hist(Ch,10), 

h = findobj(gca,'Type','patch'); 

set(h,'FaceColor',[120/255 230/255 200/255],'EdgeColor','k') 

title('Histogram obvodů defektů 16% PCL','FontSize', 20,'FontWeight','bold' ) 

xlabel('Obvod [µm]','FontSize', 18)  

ylabel('Četnost','FontSize', 18)  
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Příloha 4 

Metodika stanovení parametrů defektů založená na segmentaci  

lear,clc,close all 

 

%% NAČTENÍ OBRAZU %% 

D=imread('NÁZEV SNÍMKU.FORMÁT'); 

D1=D(1:512,:);%oriznuti 

figure,imshow(D1); 

  

D2=D1; 

D2(:,:,2)=D1; 

D2(:,:,3)=D1; 

D3=D2; 

figure,imshow(D3); 

  

%% PRAHOVÁNÍ ZA POUŽITÍ INTERVALU JAKO PRAHU %% 

T1=155; 

T2=185; 

D1=D1>T1 & D1<= T2; 

figure,imshow(D1); 

  

%% SADA MORFOLOGICKÝCH OPERACÍ %% 

D1=bwareaopen(D1,100); 

figure,imshow(D1); 

D1=imclearborder(D1); 

figure,imshow(D1); 

D1=imfill(D1,'holes'); 

IM2=imclose(D1,ones(3)); 

A1=[0 1 0;1 1 1;0 1 0]; 

A2=ones(3); 

IM1=imclose(D1,A1); 

IM1=bwareaopen(IM1,200); 

figure,imshow(IM1); 

  

%% VYTVOŘENÍ MATICE %% 

IL=bwlabel(IM1); 

  

%% VYKRESLENÍ NALEZENÝCH DEFEKTŮ VE VSTUPNÍM OBRAZE %%  

RGB = label2rgb(IL);  

figure, imshow(RGB); 

BW=bwmorph(IM1,'remove'); 

[rrr sss]=find(BW==1); 

for i=1:length(rrr) 

    D3(rrr(i),sss(i),1)=255; 

    D3(rrr(i),sss(i),2)=0; 

    D3(rrr(i),sss(i),3)=0; 

end 

figure,imshow(D3); 

  

%% STANOVENÍ VLASTNOSTÍ DEFEKTŮ%% 

A=regionprops(IL,'Area');  

B=([A.Area]*KALIBRAČNÍ_VZTAH^2); 

Bh=B; 

Bs=sum(B) 

Bm=mean(B) 

  

P=regionprops(IL,'Perimeter');  

C=([P.Perimeter]*KALIBRAČNÍ_VZTAH); 

Ch=C; 

Cs=sum(C) 

Cm=mean(C) 
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%% VYKRESLENÍ HISTOGRAMŮ %% 

figure, 

hist(Bh,10), 

h = findobj(gca,'Type','patch'); 

set(h,'FaceColor',[120/255 230/255 200/255],'EdgeColor','k') 

title('Histogram ploch defeků','FontSize', 20,'FontWeight','bold' ) 

xlabel('Plocha [µm^2]','FontSize', 18)  

axis([0 1400 0 6]) 

  

figure, 

hist(Ch,10), 

h = findobj(gca,'Type','patch'); 

set(h,'FaceColor',[120/255 230/255 200/255],'EdgeColor','k') 

title('Histogram obvodů defektů ','FontSize', 20,'FontWeight','bold' ) 

xlabel('Obvod [µm]','FontSize', 18)  

ylabel('Četnost','FontSize', 18)  

axis([0 260 0 5]) 
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Příloha 5 

Metodika stanovení orientace nanovláken 

clear,clc,close all 

 

%% NAČTENÍ OBRAZU %% 

I=imread('NÁZEV SNÍMKU.FORMÁT'); 

if size(I,3)>1 

    I=rgb2gray(I); 

end 

vyrez=500; 

odr=1;      

dor=odr+vyrez; 

ods=1;       

dos=ods+vyrez; 

I=I(odr:dor,ods:dos); 

I=imadjust(I); 

I1=I; 

figure,imshow(I,[]); 

  

%% STANOVENÍ MINIMÁLNÍHO POMĚRU HLAVNÍ A VEDLEJŠÍ OSY ELIPSY %% 

podil=2; 

  

%% POLÁRNÍ DIAGRAM %% 

podi=1;%podi=1 => vykreslen polarní diagram 

  

%% VELIKOST PODOKNA %% 

okno=20;  

[r s]=size(I); 

pole=[]; 

obr=zeros(size(I)-1); 

obr1=zeros(size(I)-1); 

cit=0; 

for i=1:okno:r-okno 

    for j=1:okno:s-okno 

        

        cit=cit+1; 

        x=i;y=j; 

        I1=I(x:x+okno-1,y:y+okno-1);         

         

        %% FOURIEROVA TRANSFORMACE %% 

        dft = fft2(im2double(I1)); 

        sdft = fftshift(dft); 

        spectrum = abs(sdft); 

        pspectrum = log(1+abs(sdft)); 

        pspectrum=imrotate(pspectrum,90); 

        IBW=pspectrum>(max(pspectrum(:))-max(pspectrum(:))*0.5);         

        IBW1=double(IBW);         

        

        %% STANOVENÍ PARAMETRŮ OS ELIPSY POPISUJÍCÍ TVAR FREKVENČNÍ OBLASTI %% 

        STATS=regionprops(double(IBW),'All'); 

        DC=floor([(size(IBW, 1)+1 )/ 2, (size(IBW, 2)+1) / 2]); 

        cx=DC(1);cy=DC(2); 

        minor=STATS.MinorAxisLength; 

        major=STATS.MajorAxisLength;    

         

     %% VYVOLÁNÍ FUNKCE POLÁRNÍHO DIAGRAMU %% 

        [t rose]=anisotropyFT(I1,1,podi);     

        t=rad2deg(t); 

        pom=find(rose==max(rose)); 

 

 %% VYKRESLENÍ SMĚROVÝCH VEKTORŮ JEDNOTLIVÝCH PODOKEN %% 

        if t(pom(1))>=0 && t(pom(1))<45 

           v=okno/2; 
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           u=round(okno*tan(deg2rad(t(pom(1)))))/2;             

        elseif t(pom(1))==45 

           u=okno/2; 

           v=okno/2; 

        elseif t(pom(1))>45 && t(pom(1))<=90 

           v=round(okno/tan(deg2rad(t(pom(1)))))/2; 

           u=okno/2;  

        elseif t(pom(1))==-45 

           u=-okno/2; 

           v=okno/2; 

        elseif t(pom(1))>-45 && t(pom(1))<0 

           u=round(okno*tan(deg2rad(t(pom(1)))))/2;     

           v=okno/2; 

        elseif t(pom(1))>=-90 && t(pom(1))<-45 

           v=-round(okno/tan(deg2rad(t(pom(1)))))/2; 

           u=-okno/2;   

        end          

         

        if round(STATS.Orientation)>=0 && round(STATS.Orientation)<45 

           v1=okno/2; 

           u1=round(okno*tan(deg2rad(round(STATS.Orientation))))/2;             

        elseif round(STATS.Orientation)==45 

           u1=okno/2; 

           v1=okno/2; 

        elseif round(STATS.Orientation)>45 && round(STATS.Orientation)<=90 

           v1=round(okno/tan(deg2rad(round(STATS.Orientation))))/2; 

           u1=okno/2;  

        elseif round(STATS.Orientation)==-45 

           u1=-okno/2; 

           v1=okno/2; 

        elseif round(STATS.Orientation)>-45 && round(STATS.Orientation)<0 

           u1=round(okno*tan(deg2rad(round(STATS.Orientation))))/2;     

           v1=okno/2; 

        elseif round(STATS.Orientation)>=-90 && round(STATS.Orientation)<-45 

           v1=-round(okno/tan(deg2rad(round(STATS.Orientation))))/2; 

           u1=-okno/2;   

        end 

         

        pole=[pole; cit x y t(pom(1)) max(rose) j+okno/2 i+okno/2 u v 

(STATS.Orientation) u1 v1 (STATS.MajorAxisLength)/(STATS.MinorAxisLength)]; 

        obr(x:x+okno-1,y:y+okno-1)=t(pom(1))*ones(okno);  

        if (STATS.MajorAxisLength)/(STATS.MinorAxisLength)<podil 

            obr1(x:x+okno-1,y:y+okno-1)=zeros(okno);  

        else obr1(x:x+okno-1,y:y+okno-1)=STATS.Orientation; 

        end 

      

    end 

  

end 

  

  

figure,imshow(obr1,[-90 90]) 

hold on 

for k=1:cit 

    if pole(k,13)>=podil 

        quiver(pole(k,6),pole(k,7),pole(k,12),-pole(k,11),'r','LineWidth',2),hold 

on 

        quiver(pole(k,6),pole(k,7),-pole(k,12),pole(k,11),'r','LineWidth',2),hold 

on 

    end 

end 

colorbar('Fontsize',16) 

hold off 

  

%% VYKRESLENÍ SMĚROVÝCH VEKTORŮ VE VSTUPNÍM OBRAZE %% 

I=I(1:end-1,1:end-1); 

figure,imshow(I,[]) 
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hold on 

hh1=[]; 

for k=1:cit 

    if pole(k,13)>=podil 

        quiver(pole(k,6),pole(k,7),pole(k,12),-

pole(k,11),'r','LineWidth',2,'MarkerSize',26),hold on 

        quiver(pole(k,6),pole(k,7),-

pole(k,12),pole(k,11),'r','LineWidth',2,'MarkerSize',26),hold on 

        hh1=[hh1; pole(k,10)]; 

    end 

end 

hold off 

  

%% VYKRESLENÍ HISTOGRAMU A JÁDROVÉHO ODHADU HUSTOTY %% 

fs=16; 

hh=pole(find(pole(:,10)~=0),10); 

figure,[ni c vyska]=histogram(hh,45);axis([-90 90 0 

max(vyska)+0.1*max(vyska)]),title('Histogram a jádrový odhad hustoty distribuce 

směrů','FontSize',fs) 

xlabel('úhel [deg]','FontSize',fs) 

set(gca,'XTick',-80:20:80) 

hold on 

[f,xi] = ksdensity(hh,'npoints',500);  

plot(xi,f,'Color',[240/255 20/255 0],'LineWidth',3) 
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Příloha 6 

Metodika stanovení průměrů nanovláken 

clear,clc,close all 

 

%% NAČTENÍ VSTUPNÍHO OBRAZU %% 

f=imread('NÁZEV SNÍMKU.FORMÁT'); 

figure, imshow(f); 

f=f(1:1024,:); 

figure, imshow(f);  

%% REDUKCE ŠUMU %% 

f=medfilt2(f); 

  

%% PRAHOVÁNÍ %% 

T1=145 

f=im2bw(f,T1/255); 

figure, imshow(f);  

 

%% PŘEVOD NA NEGATIV %% 

I=~f; 

figure,imshow(I); 

  

%% VYPOČTE EUKLIDOVSKÉ VZDÁLENOSTI %% 

[D,L] = bwdist(I); 

figure,imshow(D,[]) 

  

%% MORFOLOGICKÁ OPERACE ZTENČENÍ %% 

S=bwmorph(f,'thin',inf); 

figure,imshow(S) 

  

%% NALEZENÍ A OZNAČENÍ MÍST KŘÍŽENÍ VLÁKEN %% 

p=find_skel_intersection(S); 

for i=1:length(p) 

    rectangle('Position',[p(i,1) p(i,2) 1 1],'FaceColor','r','Edgecolor','r') 

end 

p=fliplr(p); 

  

%% VYKRESLENÍ KRUHU SE STŘEDEM V MÍSTĚ KŘÍŽENÍ VLÁKEN O POLOMĚRU ROVNÉM 

POLOMĚRU VLÁKNA%% 

for j=1:length(p) 

    p(j,3)=ceil(D(p(j,1),p(j,2))); 

end 

for k=1:length(p) 

    warning off 

    c=imcircle((p(k,3)*2)>0); 

    [r s]=size(c); 

    rr=abs(ceil(r)/2)>0; 

    ss=abs(ceil(s)/2)>0; 

    S=double(S); 

    S(p(k,1)-rr:p(k,1)+rr-1,p(k,2)-ss:p(k,2)+ss-1)=S(p(k,1)-rr:p(k,1)+rr-

1,p(k,2)-ss:p(k,2)+ss-1)-c; 

end 

S=S>0; 

figure,imshow(S,[]) 

  

%% STANOVENÍ PRŮMĚRŮ VLÁKEN %% 

[idx]=find(S==1); 

d=D(idx)*2*KALIBRAČNÍ_VZTAH; 

figure,histogram(d,20); 

mean(d) 

std(d) 
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Příloha 7 

Posloupnost kroků stanovení jednotlivých parametrů v programu ImageJ 

 

Metodika navržená ke stanovení parametrů pórů  

Analyze → Set Scale  Proveď kalibraci pixelů na reálné jednotky 

Image → Crop  Vyřež vstupní obraz 

Process → Noise → Despeckle   Odstraň šum mediánovým filtrem 

Image → Adjust → Treshold  Transformuj vstupní obraz na binární prahováním 

Process → Binary →Fill Holes  Vyplň díry morfologickou operací 

Analyze → Set Measurements  Nastav parametry určené k vyhodnocení 

Analyze → Analyze Particles  Analyzuj jednotlivé objekty 

Results → Distribution  Zobraz distribuci naměřených parametrů 

Analyze → Summarize  Stanov výsledky měření použitím statistických operací 

 

Metodika stanovení parametrů defektů korelační metodou 

Image → Crop  Vyřež  vstupní obraz na požadovanou velikost 

Plugins → Create Template  Vytvoř šablonu 

Proveď korelaci mezi vstupním obrazem a šablonou 

Proveď prahování korelované obrazu  

Analyze → Set Scale  Proveď kalibraci pixelů na reálné jednotky 

Analyze → Set Measurements  Nastav parametry určené k vyhodnocení 

Analyze → Analyze Particles  Analyzuj jednotlivé objekty 

Results → Distribution  Zobraz distribuci naměřených parametrů 

Analyze → Summarize  Stanov výsledky měření použitím statistických operací 
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Metodika stanovení parametrů defektů segmentací 

Analyze → Set Scale  Proveď kalibraci  pixelů na reálné jednotky 

Image → Crop  Vyřež  vstupní obraz na požadovanou velikost 

Image → Adjust → Treshold  Transformuj vstupní obraz na binární prahováním 

Process → Binary → Fill Holes Vyplň díry morfologickou operací 

Process → Binary → Open  Otevři obraz 

Analyze → Set Measurements  Nastav parametry určené k vyhodnocení 

Analyze → Analyze Particles  Analyzuj jednotlivé objekty 

Results → Distribution  Zobraz distribuci naměřených parametrů 

Analyze → Summarize  Stanov výsledky měření použitím statistických operací 

 

Metodika stanovení orientace vláken 

Image → Crop  Vyřež vstupní obraz 

Plugins → OrientationJ → Distribution  Automatizované stanovení orientace vláken 

  

Metodika stanovení orientace vláken 

Image → Crop  Vyřež vstupní obraz 

Analyze → Directionality  Automatizované stanovení orientace vláken 

 

Metodika stanovení průměrů vláken 

Process → Filters → Median  Odstraň šum mediánovým filtrem 

Image → Adjust → Treshold  Transformuj vstupní obraz na binární  

Image → Duplicate  Vytvoř kopii binárního obrazu 

Process → Binary → Distance Map  Vytvoř mapu Euklidovských vzdáleností vláken 

Process → Binary → Skeletonize  Vytvoř skeleton (kostru) vláken 

Process → Image Calculator → AND  Získej poloměry vláken prostřednictvím průniku 

dvou obrazů 

Process → Math → Multiple  Vynásob obraz konstantou, získej průměr 

vláken  

Analyze → Histogram Interpretuj výsledky měření histogramem 
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